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Important Information
Except as otherwise expressly stated in the License that accompanies a 
program, Texas Instruments makes no warranty, either express or 
implied, including but not limited to any implied warranties of 
merchantability and fitness for a particular purpose, regarding any 
programs or book materials and makes such materials available solely on 
an "as-is" basis. In no event shall Texas Instruments be liable to anyone 
for special, collateral, incidental, or consequential damages in connection 
with or arising out of the purchase or use of these materials, and the sole 
and exclusive liability of Texas Instruments, regardless of the form of 
action, shall not exceed the amount set forth in the license for the 
program. Moreover, Texas Instruments shall not be liable for any claim of 
any kind whatsoever against the use of these materials by any other 
party.

© 2008 Texas Instruments Incorporated
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their respective owners.
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Introduction

The TI-Nspire™ CAS math and science learning 
handheld
This guidebook provides information about a powerful, advanced 
learning handheld available from Texas Instruments: the TI-Nspire™ CAS 
handheld.

Your learning handheld comes equipped with a variety of pre-installed 
software applications that have features relevant to many different 
subjects and curriculums.

Extend the reach of your TI-Nspire™ CAS handheld with accessories, such 
as the TI-Nspire™ CAS math and science learning software, TI-Nspire™ 
ViewScreen™ Panel, TI-Nspire™ Connections Cradle and TI-Nspire™ 
Computer Link Software.

How to use this guidebook
This guidebook is intended to supplement the printed guidebook that 
accompanied your TI-Nspire™ CAS handheld. 

The chapters in this guidebook include:

Transferring Files- Provides instruction for connecting and transferring 
data and files between two TI-Nspire™ CAS handhelds.

Memory Management - Includes instruction for checking memory on 
your handheld, and freeing memory if you need additional space.

Using the TI-Nspire™ Computer Link Software - Provides instruction 
for transferring documents between handhelds, capturing images from 
your handheld, backing up contents and updating the Operating System 
(OS) on your TI-Nspire™ CAS handheld.

Using Calculator - Provides detailed instruction for using the Calculator 
application.

Using Graphs & Geometry - Provides detailed instruction for using the 
Graphs & Geometry application.

Using Lists & Spreadsheet - Provides detailed instruction for using the 
Lists & Spreadsheet application.

Using Data & Statistics - Provides detailed instruction for using the 
Data & Statistics application.

Using Notes - Provides detailed instruction for using the Notes 
application.
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Libraries - Provides detailed instruction for using TI-Nspire™ libraries of 
variables, functions, and/or programs that have been defined as library 
objects

Programming - Provides detailed instruction for using user-defined 
functions and programs.

Data Collection - Provides detailed steps for collecting experimental 
information from a sensor and automatically display it in a table and/or 
graph for analysis. 

Service and Warranty Information - Includes service and warranty 
information and contact information for technical support.

Where to find more information
Additional product information is available in printed guidebook that 
accompanied your TI-Nspire™ CAS handheld. An electronic version of the 
printed guidebook for using the TI-Nspire™ CAS handheld is included on 
the CD-ROM that came with your learning handheld. This guidebook is 
also available online as a free download at education.ti.com/guides.
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Transferring Files

Connecting two handhelds
This chapter describes how to connect one TI-Nspire™ CAS handheld to 
another, and how to transfer files between them. The TI-Nspire™ CAS 
handheld has a USB port which allows it to communicate with another 
TI-Nspire™ CAS handheld. 

When the TI-Nspire™ CAS handheld is using TI-Nspire™ TI-84 Plus 
keypad, it can connect with another TI-Nspire™ CAS handheld using the 
TI-Nspire™ TI-84 Plus keypad or a TI-84 Plus using the USB port or the I/O 
port.

Using connection cables 
Your TI-Nspire™ CAS handheld comes with connection cables that allow 
you to share files with both a computer and another handheld.

USB cables
You can use USB cables to connect two TI-Nspire CAS handhelds, to 
connect a TI-Nspire CAS handheld to a computer.

Connecting two TI-Nspire™ CAS handhelds with the USB 
unit-to-unit cable 
You can connect two handhelds this way as long as both handhelds are 
using the same keypad. You cannot connect a handheld using the 
TI-Nspire™ TI-84 Plus keypad to a handheld using the native TI-Nspire 
keypad.

 

The TI-Nspire™ CAS handheld USB 
A port is located at the center of 
the top of the TI-Nspire CAS 
handheld.

1. Firmly insert either end of the 
USB unit-to-unit cable into 
the USB A port.

2. Insert the other end of the 
cable into the receiving unit’s 
USB A port.
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Backing up files to a computer
Use the TI-Nspire™ Computer Link Software  software to back up the 
contents of your handheld to a computer. TI-Nspire™ Computer Link 
Software is available on the product CD that came with your handheld. 

Transferring documents

Rules for transferring files
• You can transfer documents and Operating System (OS) files.

• If a document with the same name as the one you are sending 
already exists on the receiving TI-Nspire™ handheld, the document 
will be renamed. The system appends a number to the name to make 
it unique. For example, if Mydata existed on the receiving 
TI-Nspire™ handheld, it would be renamed Mydata(2).

Both the sending and receiving units will display a message that 
shows the new name. 

• There is a 255-character maximum length for a file name, including 
the entire path. If a transmitted file has the same name as an existing 
file on the receiving unit and the file names contain 255 characters, 
then the name of the transmitted file will be truncated to enable the 
software to follow the renaming scheme described in the previous 
bullet.

• All variables associated with the document being transmitted are 
transfered with the document.

• Transmissions will time out after 30 seconds.

Sending a document 
1. Open My Documents. 

Press c7.

2. Press the 5 and 6 keys on the NavPad to highlight the document you 
want to send.

3. Select Send from the My Documents menu. 

Press /c15.

4. The file transfer begins. A progress bar displays to allow you to 
follow the transfer. There is also a cancel button on the Sending... 
dialog to enable you to cancel the transmission while it in progress.
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At the end of a successful transmission, the message 
"<Folder / File name> transferred as <Folder / File name>." displays. 
If the file had to be renamed on the receiving unit, the message will 
display the new file name.

Receiving a document 
No action is required by the user of the receiving TI-Nspire™ CAS 
handheld. Units are automatically powered on when the cable is 
attached. 

At the end of a successful transmission, the message "<Folder / File 
name> received." displays. If the file had to be renamed, the message 
will display the new file name.

Canceling a transfer
1. To cancel a transmission in-progress, press Cancel on the dialog of 

the sending unit. The user of either unit can also press d.

2. A link transmission error message displays.

3. Press d or · to cancel the transmission error message. 

Common error and notification messages

Shown on: Message and Description

Sending unit

This message displays if a cable is not attached to 
the sending unit’s link port. Remove and then 
reinsert the cable and try the document 
transmission again.

Press d or · to cancel the transmission 
message. 

Note: The sending unit may not always display this 
message. Instead, it may remain BUSY until you 
cancel the transmission.

"Transfer failed. Check cable
and try again."

OK
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Sending unit

This message displays when the receiving unit does 
not have enough memory to accept the file being 
transmitted. 

The user of the receiving unit must free space in 
order to obtain the new file. To do this:

• Delete unneeded files.

• Store files on a computer for later retrieval, 
then delete them from the TI-Nspire™ CAS 
handheld.

Sending unit

This message displays at the end of a successful 
transfer when the file had to be renamed because 
a file already exists on the receiving unit with the 
original name. The transmitted file is renamed by 
appending a number to the end of the name. 
Rename numbering always begins with (2) and can 
increment by one, as needed.

Shown on: Message and Description

"Receiver does not have enough 
storage space for file transfer."

OK

"<folder>/<filename> 
transferred as 

<folder>/<filename(#)."
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Sending unit

This message displays when a new folder is created 
on the receiving unit to contain the transmitted 
document.

Receiving unit

This message displays if the receiving unit has a 
document with the same name as the document 
being sent. 

Receiving unit

This message displays when a new folder has been 
created to contain the transmitted document.

Shown on: Message and Description

"<folder>/<filename>

 <folder>/<new filename>."
transferred as

"<folder>/<filename(x)>
received."

"<new folder>/<new filename>
received."
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Receiving unit

This message displays if the cable is not correctly 
attached to the receiving unit’s link port. Remove 
the cable then reattach it and try the transmission 
again.

Press d or · to cancel the transmission 
message. 

Shown on: Message and Description

"Transfer failed. Check cable
and try again."

OK
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Upgrading the Operating System
You can upgrade the OS on your TI-Nspire™ CAS handheld using your 
computer and TI-Nspire™ Computer Link Software. You can also transfer 
the OS from one unit to another.

OS upgrade operations do not delete user documents. If there is not 
enough room on the receiving handheld for the upgrade, the sending 
handheld is notified. The only time documents can be affected by an OS 
installation is if the receiving handheld has a corrupted OS. In this 
situation, documents may be affected by OS restoration. It is a good 
practice to back up your important documents and folders before 
installing an updated operating system.

See the important information concerning batteries before performing 
an OS upgrade.

Important Operating System download information
It is always a good practice to install new batteries before beginning an 
OS download.

When in OS download mode, the Automatic Power DownTM (APD) 
feature does not function. If you leave your handheld in download mode 
for an extended time before you begin the downloading process, your 
batteries may become depleted. You will then need to replace the 
batteries with new batteries before downloading.

Where to get Operating System upgrades
For up-to-date information about available OS upgrades, check the Texas 
Instruments Web site at http://education.ti.com. 

You can download an OS upgrade from the Texas Instruments Web site 
to a computer, and use a USB computer cable to install the OS on your 
TI-Nspire™ CAS handheld.

For complete information, refer to the instructions in the chapter on 
TI-Nspire™ Computer Link Software.

Transferring the Operating System
To transfer the OS from unit to unit:

1. Connect the two units. (For details, see the connection instructions at 
the beginning of this chapter.) Any open documents on the receiving 
unit should be closed before the transfer begins. 

2. On the sending unit, open My Documents. 

Press c7.
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3. From the menu, select Send OS. 

Press b9.

4. On the receiving unit, the message, "You are receiving an OS 
Upgrade. Unsaved changes will be lost. Would you like to continue?" 
displays along with Yes and No response buttons. Select Yes to 
receive the OS upgrade. 

Notes: 

• If Yes is not selected within 30 seconds, the unit automatically 
responds with No, and the transmission is cancelled.

• It is important to save and close all open documents before 
performing an OS Upgrade. Continuing with an OS Upgrade on 
a unit with an open, unsaved document will cause the loss of 
that data. 

5. While the upgrade is in progress, the receiving unit displays, 
"Receiving OS. Do not unplug cable." The sending unit displays, 
"Sending OS. Do not unplug cable." 

6. After the transfer completes, the sending unit receives a completion 
message and can unhook the cable. On the receiving unit, the OS 
must be installed. This happens automatically. During the installation 
process, the receiving unit displays the message, "Installing OS 
<version number>." 

7. When the installation completes, the unit displays the following 
message, "OS <version number> has been installed. Handheld will 
now restart." The restart is initiated. If the sending unit is still 
attached to the cable, the successful transmission message remains 
displayed on that unit’s screen.

Important:
• For each receiving unit, remember to back up information, as 

necessary, and install new batteries.

• Be sure the sending unit is on the Send OS screen. 
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OS Upgrade Messages
This section lists the information and error messages that can be 
displayed on units during an OS Upgrade. 

Shown on: Message and Description

Sending unit

This message displays when the receiving unit does 
not have enough memory available for the new 
OS. The space requirement is shown so you know 
how much memory must be cleared for the new 
operating system. Files can be moved to a 
computer for storage to free the necessary space.

Sending unit

This message displays when the batteries in the 
receiving unit need to be replaced. Send the OS 
Upgrade once the batteries are replaced. 

Sending unit

This message displays when the receiving unit has 
a newer OS version that the one being 
transmitted. You cannot downgrade an OS.

"Receiver does not have 
enough storage space. Make

<xxxK> available."

"Receiver must change
batteries before upgrading
the OS."

"Receiver has a newer OS 
and cannot load this OS."

OK
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Sending unit

This message displays when the receiving unit 
refuses the upgrade. 

Sending unit

This message displays when the tranfer is 
completed and it is safe for the sending unit to 
unplug the cable.

Sending unit

This message, along with a progress bar, displays 
while the OS Upgrade is being transferred. 

Both units

The sending and/or receiving unit is not properly 
connected. Reinsert the cable into each handheld, 
then try the transmission again.

Shown on: Message and Description

"Upgrade not accepted by
receiver."

OK

"OS has been transferred. 
You can now unplug."

OK

"Sending OS. Do not 
unplug cable."

"Transfer failed. Check cable
and try again."

OK



Transferring Files 13

Receiving unit

This message displays when an OS Upgrade is 
about to begin. If you do not select Yes within 30 
seconds, the system automatically responds with 
No.

Receiving unit

This message, along with a progress bar, displays 
while the OS Upgrade is being transferred.

Receiving unit

This message displays once the transfer is 
completed. It is shown to keep you informed of 
the unit’s status.

Receiving unit

This information message displays briefly before 
the unit automatically reboots. 

Shown on: Message and Description

"You are receiving an OS
Upgrade. Unsaved changes
will be lost. Would you like

to continue?"

Yes No

"Receiving OS. Do not 
unplug cable."

"Installing OS."

"OS has been installed.
Handheld will restart."

OK
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Receiving unit

An error occurred during the transmission, and the 
installation was corrupted. The unit will reboot. 
After the reboot, reinstall the OS Upgrade.

Shown on: Message and Description

"Install was corrupted.
Handheld will reboot. You 

will need to retry OS 
upgrade."

OK
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Memory and file management

Checking available memory
The Handheld Status screen shows the amount of memory (in bytes) used 
by all documents and variables on your TI-Nspire™ CAS handheld. The 
Handheld Status screen displays the following information:

• Storage Capacity

• Space Used

• Free Space

• Battery Status

Displaying the Handheld Status screen
Select Handheld Status from the Home menu.

Press c83

The Handheld Status window displays.

Freeing memory
If you have insufficient memory to store documents on your handheld, 
you must free memory to create the space you need. To free memory, 
you must delete documents and/or folders from memory. If you wish to 
keep the documents and folders for use later, you can back them up to 
another handheld or to a computer.

Deleting items from memory
If you have documents stored on your TI-Nspire™ CAS handheld that you 
no longer need, you can delete them from memory to create additional 
space.
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Before you delete documents from memory, consider restoring sufficient 
available memory by copying files to another handheld.

1. Open My Documents.

Press c7.

2. Press £ or ¤ to select the folder or document you want to delete.

3. Select Delete.

Press /c26.

The folder/document is permanently removed from the handheld.

Backing up files to another handheld
To back up files to another TI-Nspire™ CAS handheld, follow the steps 
below. Complete instructions for connecting two handhelds are provided 
in the Connectivity chapter.

1. Connect the two handhelds using the USB-to-USB Connectivity 
Cable.

2. Open My Documents on the sending unit. 

Press c7.

3. Press the 5 and 6 keys to highlight the document you want to send.

4. Select Send from the Document menu.

Press /c15.

5. When the file transfer is complete, a message displays on the 
receiving unit.

Backing up files to a computer
Use the TI-Nspire™ Computer Link software to back up the contents of 
your handheld to a computer. TI-Nspire™ Computer Link software is 
available on the product CD that came with your handheld.

Resetting the memory
The Reset button on the underside of the handheld resets all memory. 
When resetting all memory on the TI-Nspire™ CAS handheld, RAM and 
Flash memory is restored to factory settings. All files will be deleted. All 
system variables are reset to default settings.

Caution: Before you reset all memory, consider restoring sufficient 
available memory by deleting only selected data.

To reset all memory on the handheld, follow these steps.
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1. Use a paper clip or ball point pen to press the reset button on the 
underside of the handheld. 

2. Hold for three seconds and release.

Handheld memory is cleared.

When you clear memory, the contrast sometimes changes. If the screen is 
faded or blank, adjust the contrast by pressing / + or / -.�
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Using Calculator

Getting started with the Calculator application
The Calculator application gives you a place to enter and evaluate math 
expressions. You can also use it to define variables, functions, and 
programs. When you define or edit a variable, function, or program, it 
becomes available to any TI-Nspire™ math and science learning 
technology application—such as Graphs & Geometry—that resides in the 
same problem.

You can also use Calculator to define library objects, such as variables, 
functions, and programs, which are accessible from any problem of any 
document. For information on creating library objects, see the 
“Libraries” section of the documentation.

À Calculator menu – This menu is available anytime you are in the 
Calculator work area. Press b to display the menu. The menu in 
this screen snapshot may not exactly match the menu on your screen.

Á Calculator work area

– You enter a math expression on the entry line and then press 
· to evaluate the expression.

– Expressions display in standard mathematical notation as you 
enter them.

À

Á Â
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– Entered expressions and results show in the Calculator history. 

Â Example of Calculator variables used in another application

The Calculator tool menu
The Calculator tool menu lets you enter and evaluate a variety of math 
expressions.

Menu 
Name

Menu Option Function

 Actions

Define Inserts the Define command.

Recall Definition Lets you view, reuse, or modify 
a function or program that you 
have defined.

Delete Variable Inserts the delVar command.

Clear a-z Deletes all variables with 
single-letter names.

Clear History Deletes all expressions in the 
Calculator history.

Insert Comment Lets you insert text.

Library Lets you refresh all libraries, set 
LibPub or LibPriv access, insert a 
“\” character, or create a library 
shortcut.

 Number

Convert to Decimal Inserts ¢Decimal command.

Factor Inserts factor().

Least Common Multiple Inserts lcm().

Greatest Common Divisor Inserts gcd() function.

Remainder Inserts remain().

Fraction Tools Lets you select propFrac(), 
getNum(), getDenom(), or 
comDenom().
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Number Tools Lets you select round(), iPart(), 
fPart(), sign(), mod(), floor(), 
or ceiling().

Complex Number Tools Lets you select conj(), real(), 
imag(), angle(), ¢Polar, ¢Rect, 
or the absolute value template.

 Algebra

Solve Inserts solve().

Factor Inserts factor().

Expand Inserts expand().

Zeros Inserts zeros().

Numerical Solve Inserts nSolve().

Polynomial Tools Lets you select 
polyRemainder(), 
polyQuotient(), polyGcd(), 
polyCoeffs(), or polyDegree().

Fraction Tools Lets you select propFrac(), 
getNum(), getDenom(), or 
comDenom().

Convert Expression Lets you select ¢cos, ¢sin, or 

¢Exp.

Trigonometry Lets you select tExpand() or 
tCollect().

Complex Lets you select cSolve(), 
cFactor(), or cZeros().

Extract Lets you select left() or right().

Finance Solver Starts the Finance Solver.

 Calculus

Derivative Inserts the Derivative template.

Integral Inserts the Integral template.

Menu 
Name

Menu Option Function
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Limit Inserts the Limit template.

Sum Inserts the Sum template.

Product Inserts the Product template.

Function Minimum Inserts fMin().

Function Maximum Inserts fMax().

Tangent Line Inserts tangentLine().

Normal Line Inserts normalLine().

Arc Length Inserts arcLen().

Series Lets you select taylor(), 
series(), or dominantTerm().

Differential Equation 
Solver

Inserts deSolve().

Implicit Differentiation Inserts impDif().

Numerical Calculations Lets you select nDeriv(), nInt(), 
nfMin(), or nfMax()

 Probability

Factorial (!) Inserts !.

Permutations Inserts nPr().

Combinations Inserts nCr().

Random Lets you select rand(), 
randInt(), randBin(), 
randNorm(), randSamp(), or 
RandSeed.

Distributions Lets you select from several 
distributions, such as Normal 
Pdf, Binomial Cdf, and 
Inverse F.

 Statistics

Menu 
Name

Menu Option Function
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Stat Calculations Lets you select from several 
statistics calculations, such as 
one-variable analysis, two-
variable analysis, and 
regressions.

Stat Results Inserts the stat.results variable.

List Math Lets you select from several list 
calculations, such as minimum, 
maximum, and mean.

List Operations Lets you select from several list 
operations, such as sorting, 
filling, and converting to a 
matrix.

Distributions Lets you select from several 
distributions, such as Normal 
Pdf, Binomial Cdf, and 
Inverse F.

Confidence Intervals Lets you select from several 
confidence intervals, such as 
t interval and z interval.

Stat Tests Lets you select from several 
tests such as ANOVA, t test, z 
test.

 Matrix & Vector

Transpose Inserts T.

Determinant Inserts det().

Row-Echelon Form Inserts ref().

Reduced Row-Echelon 
Form

Inserts rref().

Simultaneous Inserts simult().

Menu 
Name

Menu Option Function
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Create Lets you select from several 
matrix-creation options, such as 
construct matrix, identity, 
diagonal, submatrix, and 
others.

Norms Lets you select norm(), 
rowNorm(), or colNorm().

Dimensions Lets you select dim(), 
rowDim(), or colDim().

Row Operations Lets you select rowSwap(), 
rowAdd(), mRow(), or 
mRowAdd().

Element Operations Inserts “dot” operators such as 
.+ (dot add) and .^ (dot power).

Advanced Inserts trace(), LU, QR, eigVl(), 
eigVc(), or charPoly(), 

Vector Inserts unitV(), crossP(), dotP(), 
8Polar, 8Rect ,8Cylind, or 
8Sphere.

 Functions & Programs

Program Editor Lets you view, open for editing, 
import, or create a new 
program or function.

Func...EndFunc Inserts a template for creating a 
function.

Prgm...EndPrgm Inserts a template for creating a 
program.

Local Inserts the Local command.

Control Lets you select from a list of 
function and program-control 
templates, such as 
If...Then...EndIf, 
While...EndWhile, 
Try...Else...EndTry, and others.

Menu 
Name

Menu Option Function
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Before you begin
Turn on the handheld, and add a Calculator application to a 
document. 

Entering and evaluating math expressions

Options for entering expressions
Calculator lets you enter and edit expressions through several methods.

• By pressing keys on the handheld keypad.

• By selecting items from the Calculator menu.

• By selecting items from the Catalog (k).

Entering simple math expressions

Note: To enter a negative number on the handheld, press v. To enter a 
negative number on a computer keyboard, press the hyphen key (-).

Suppose you want to evaluate  

1. Select the entry line in the Calculator work area.

2. Type 2^8 to begin the expression.

Transfer Inserts transfer commands 
Return, Cycle, Exit, Lbl, Stop, 
or Goto.

Disp Displays intermediate results.

Mode Inserts commands for setting or 
reading modes, such as display 
digits, angle mode, base mode, 
and others. Also lets you get 
the current language 
information.

Add New Line Starts a new line within a 
function or program definition.

Menu 
Name

Menu Option Function
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3. Press ¢ to return the cursor to the baseline, and then type:

r 43p 12.

4. Press · to evaluate the expression.

The expression displays in standard mathematical notation, and the 
result displays on the right side of the Calculator.

Note: If a result does not fit on the same line with the expression, it 
displays on the next line.

Controlling the form of a result
You might expect to see a decimal result instead of 2752/3 in the 
preceding example. A close decimal equivalent is 917.33333..., but that’s 
only an approximation.

By default, Calculator retains the more precise form: 2752/3. Any result 
that is not a whole number displays in a fractional or symbolic form (1/2, 

p, , etc.). This reduces rounding errors that could be introduced by 
intermediate results in chained calculations.

You can force a decimal approximation in a result:

• By pressing /· instead of · to evaluate the expression.

• By including a decimal in the expression (for example, 43. instead of 
43).

2

Pressing /· forces the approximate result.
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• By wrapping the expression in the approx() function.

• By changing the document’s Auto or Approximate mode setting to 
Approximate.

– Press /c1 to display the File menu, and then select 
Document Settings.

Note that this method forces all results in all of the document’s 
problems to approximate.

Inserting items from the Catalog
You can use the Catalog to insert system functions and commands, units, 
symbols, and expression templates into the Calculator entry line.

1. Press k to open the Catalog.

Note: Some functions have a wizard that prompts you for each 
argument. If you prefer to enter the argument values directly on the 
entry line, you may need to disable the wizard.

2. Press the number key for the category of the item. For example, 
press 1 to show the alphabetic list.
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3. Press ¤ and then use ¡, ¢, £, or ¤ as necessary to select the item 
that you want to insert.

Note: To see syntax examples of the selected item, press e, and 

then press · to alternately show or hide the Help. To move back to 

the selected item, press ge.

4. Press · to insert the item into the entry line.

Using an expression template
The Calculator has templates for entering matrices, piecewise functions, 
systems of equations, integrals, derivatives, products, and other math 
expressions.

For example, suppose you want to evaluate 

1. Press /r to open the Template palette.

2. Select  to insert the algebraic sum template.

Contains all commands and functions, in alphabetical 
order.

Contains all math functions.

Provides the values for standard measurement units.

Provides a symbol palette for adding special characters.

Contains math templates for creating two dimensional 
objects, including product, sum, square root and integral.

Shows Public library (LibPub) objects.
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The template appears on the entry line with small blocks 
representing elements that you can enter. A cursor appears next to 
one of the elements to show that you can type a value for that 
element.

3. Use the arrow keys to move the cursor to each element’s position, 
and type a value or expression for each element.

4. Press · to evaluate the expression.

Creating matrices

1. Press /r to open the Template palette.

2. Select .

The Create a Matrix dialog box displays.
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3. Type the Number of rows.

4. Type the Number of columns, and then select OK.

Calculator displays a template with spaces for the rows and columns.

Note: If you create a matrix with a large number of rows and 
columns, it may take a few moments to appear.

5. Type the matrix values into the template, and press · to define the 
matrix.

Inserting a row or column into a matrix

To insert a new row, press @.

To insert a new column, hold down g and press ·.

Inserting expressions using a wizard
You can use a wizard to simplify entering some expressions. The wizard 
contains labeled boxes to help you enter the arguments in the 
expression.

For example, suppose you want to fit a y=mx+b linear regression model 
to the following two lists:

{1,2,3,4,5}
{5,8,11,14,17}

1. Press k to open the Catalog.

2. Press 1 to show the alphabetic list of functions.

3. Press ¤, and then press L to jump to the entries that begin with “L.”

4. Press ¤ as necessary to highlight LinRegMx.

5. If the Use Wizard option is not checked:

a) Press ee to highlight the Use Wizard button.
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b) Press · to change the setting.

c) Press ee to highlight LinRegMx again.

6. Press ·.

A wizard opens, giving you a labeled box to type each argument.

7. Type {1,2,3,4,5} as X List.

8. Press e to move to the Y List box.

9. Type {5,8,11,14,17} as Y List.

10. If you want to store the regression equation in a specific variable, 
press e, and then replace Save RegEqn To with the name of the 
variable.

11. Select OK to close the wizard and insert the expression into the entry 
line.

Calculator inserts the expression and adds a statement to display the 
variable stat.results, which will contain the results.

LinRegMx {1,2,3,4,5},{5,8,11,14,17},1 : stat.results

Calculator then displays the stat.results variables.
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Note: You can copy values from the stat.results variables and paste 
them into the entry line.

Creating a piecewise function
1. Begin the function definition. For example, type the following.

Define f(x,y)=

2. Press /r to open the Template palette.

3. Select .

The Piecewise Function dialog box displays.

4. Type the Number of Function Pieces, and select OK.

Calculator displays a template with spaces for the pieces.

5. Type the expressions into the template, and press · to define the 
function.

6. Enter an expression to evaluate or graph the function. For example, 
enter the expression f(1,2) on the Calculator entry line.

Creating a system of equations
1. Open the Template palette.
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2. Select .

The Create a System of Equations dialog box displays.

3. Type the Number of Equations, and select OK.

Calculator displays a template with spaces for the equations.

4. Type the equations into the template, and press Enter (·) to 
define the system.

Deferring evaluation
You don’t have to complete and evaluate an expression as soon as you 
begin typing it. You can type part of an expression, leave to check some 
work you did on another page, and then come back to complete the 
expression later.

Working with variables
When you first store a value in a variable, you give the variable a name.

• If the variable does not already exist, Calculator creates it.

• If the variable already exists, Calculator updates it.

Variables within a problem are shared by TI-Nspire™ math and science 
learning technology applications. For example, you can create a variable 
in Calculator and then use or modify it in Graphs & Geometry or Lists & 
Spreadsheet within the same problem.

Exception: Variables created with the Local command within a user-
defined function or program are not accessible outside that function or 
program.

Storing a value in a variable
This example creates a variable named num and stores the result of the 

expression 5+83 in that variable.

1. On the Calculator entry line, type the expression 5+8^3.
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2. Press ¢ to expand the cursor to the baseline.

3. Press /h and then type the variable name num.

This means: Calculate 5+83 and store the result as a variable named 
num.

4. Press ·.

Calculator creates the variable num and stores the result there.

Alternative methods for storing a variable

As alternatives to using & (store), you can use “:=” or the Define 
command. All of the following statements are equivalent.

5+83 & num

num := 5+83

Define num=5+83

Checking a variable’s value
You can check the value of an existing variable by entering its name on 
the Calculator entry line.

On the Calculator entry line, type the variable name num and press 
·. 

The value most recently stored in num displays as the result.

Using a variable in a calculation
After storing a value in a variable, you can use the variable name in an 
expression as a substitute for the stored value.
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1. Type 4 r 25 r num^2 on the entry line, and press ·. 

Calculator substitutes 517, the value currently assigned to num, and 
evaluates the expression.

2. Type 4 r 25 r nonum^2 on the entry line, and press ·. 

Because the variable nonum has not been defined, it is treated 
algebraically in the result.

Updating a variable
If you want to update a variable with the result of a calculation, you 
must store the result explicitly.

Types of variables
You can store the following TI-Nspire™ math and science learning 
technology data types as variables:

Entry Result Comment

a := 2 2

a3 8 Result not stored in variable a.

a 2

a := a3 8 Variable a updated with result.

a 8

a2 & a 64 Variable a updated with result.

a 64

Data type Examples

Expression

2.54 1.25E6 2p 2+3i  (xN2)2 

List {2, 4, 6, 8} {1, 1, 2}
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Entering multiple statements on the entry line
To enter several statements on a single line, separate them with a colon 
(“:”). Only the result of the last expression is shown.

Rules for naming variables
Note: In the unlikely event that you create a variable with the same 
name as one used for statistical analysis or by the Finance Solver, an error 
condition could occur. If you begin entering a variable name that is 
already in use in the current problem, the software shows the entry in 
bold to let you know.

• Variable names must be in one of the forms xxx or xxx.yyy. The xxx 
part can have 1 to 16 characters. The yyy part, if used, can have 1 to 
15 characters. If you use the xxx.yyy form, both xxx and yyy are 
required; you cannot start or end a variable name with a period “.”

• Characters can consist of letters, digits, and the underscore character 
(_). Letters can be U.S. or Greek letters (but not Π or p), accented 
letters, and international letters.

• Do not use c or n from the symbol palette to construct a variable 
name such as c1 or n12. These may appear to be letters, but they are 
treated internally as special symbols.

• You can use uppercase or lowercase letters. The names AB22, Ab22, 
aB22, and ab22 all refer to the same variable.

• You cannot use a digit as the first character of xxx or yyy.

• Do not use spaces.

• If you want a variable to be treated as a complex number, use an 
underscore as the last character of the name.

Matrix This can be entered as:  [1,2,3;3,6,9]

Character string “Hello” “xmin/10” “The answer is:”

Function myfunc(arg) ellipse(x, y, r1, r2)

Data type Examples

1 2 3
3 6 9
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• If you want a variable to be treated as a type of unit (such as _m or 
_ft), use an underscore as the first character of the name. You cannot 
use subsequent underscores in the name.

• You cannot use a preassigned variable, function, or command name, 
such as Ans, min, or tan.

Note: For a complete list of TI-Nspire™ functions, refer to the 
Reference Guide.

• Library documents and library objects are subject to additional 
naming restrictions. For details, see the “Libraries” section of the 
documentation.

Here are some examples:

Reusing the last answer
Each instance of Calculator automatically stores the last calculated result 
as a variable named Ans. You can use Ans to create a chain of 
calculations.

Note: Do not link to Ans or any system variable. Doing so could prevent 
the variable from being updated by the system. System variables include 
statistics results (such as Stat.RegEqn, Stat.dfError, and Stat.Resid) and 
Finance Solver variables (such as tvm.n, tvm.pmt, and tvm.fv).

As an example of using Ans, calculate the area of a garden plot that is 1.7 
meters by 4.2 meters. Then use the area to calculate the yield per square 
meter if the plot produces a total of 147 tomatoes.

1. On the Calculator entry line, type 1.7 r 4.2, and press ·.

2. Type 147 p ans, and press · to find the yield.

Variable names Valid?

Myvar, my.var Yes

My var, list 1 No. Contains a space.

a, b, c Yes

Log, Ans No. Preassigned to a system function or variable.

Log1, list1.a, list1.b Yes

3rdTotal, list1.1 No. xxx or yyy starts with a digit.



38 Using Calculator

As a second example, calculate  and then add 2*log(45).

3. Type 3.76 p (v7.9+sqrt(5)), and press ·.

4. Type ans+2 r log(45), and press ·.

Temporarily substituting a value for a variable
Use the “|” (such that) operator to assign a value to a variable for just a 
single execution of the expression.

Creating user-defined functions and programs
You can use the Define command to create your own functions and 
programs. You can create them in the Calculator application or in the 
Program Editor and then use them in other TI-Nspire™ applications.

For information on programming with the Program Editor, see the 
“Programming” and “Libraries” sections of the documentation.

Defining a single-line function
Suppose you want to define a function named cube() that calculates the 
cube of a number or variable.

1. On the Calculator entry line, type Define cube(x)=x^3 and press 
·.
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The message “Done” confirms that the function has been defined.

2. Type cube(2) and press · to test the function.

Defining a multiple-line function using templates
You can define a function consisting of multiple statements entered on 
separate lines. A multiple-line function may be easier to read than one 
with multiple statements separated by colons.

Note: You can create multiple-line functions only by using the Define 
command. You cannot use the := or & operators to create multiple-line 
definitions. The Func...EndFunc template serves as a container for the 
statements.

As an example, define a function named g(x,y) that compares two 
arguments x and y. If argument x > argument y, the function should 
return the value of x. Otherwise, it should return the value of y.

1. On the Calculator entry line, type Define g(x,y)=. Do not press · 
yet.

2. Press b to display the Calculator menu.

3. On the Functions & Programs menu, select Func...EndFunc.

Calculator inserts the template.

4. Press b to display the Calculator menu.

5. On the Functions & Programs menu, select Control, and then select 
If...Then...Else...EndIf.

Calculator inserts the template.
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6. Type the remaining parts of the function, using the arrow keys to 
move the cursor from line to line.

7. Press · to complete the definition.

8. Evaluate g(3,-7) to test the function.

Defining a multiple-line function manually
Note: To start each new line without completing the function definition, 
you press @ instead of pressing ·.

As an example, define a function cum_sum(x) that calculates the 
cumulative sum of integers from 1 through x. You can type the 
underscore symbol by pressing /_.

1. On the Calculator entry line, type Define cum_sum(x)=. Do not press 
· yet.

2. Press b to display the Calculator menu.

3. On the Functions & Programs menu, select Func...EndFunc.

Calculator inserts the template.
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4. Type the following lines, pressing @ at the end of each line.

5. After typing Return tmpsum, press · to complete the definition.

6. Evaluate cum_sum(5) to test the function.

Defining a program
Defining a program is similar to defining a multiple-line function. The 
Prgm...EndPrgm template serves as a container for the program 
statements.

As an example, create a program named g(x,y) that compares two 
arguments. Based on the comparison, the program should display the 
text “x greater than y” or “x not greater than y” (showing the values of x 
and y in the text).

1. On the Calculator entry line, type Define prog1(x,y)=. Do not press 
· yet.

2. Press b to display the Calculator menu.

3. On the Functions & Programs menu, select Prgm...EndPrgm.

Calculator inserts the template.
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4. Press b to display the Calculator menu.

5. On the Functions & Programs menu, select Control, and then select 
If...Then...Else...EndIf.

Calculator inserts the template.

6. Type the remaining parts of the function, using the arrow keys to 
move the cursor from line to line. Use the Symbol Palette to type the 
““ symbol.

7. Press · to complete the definition.

8. Execute prog1(3,-7) to test the program.

• Note: To stop a program or function manually, hold down the w 
key for several seconds.
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Recalling a function or program definition
You might want to reuse or modify a function or program that you have 
defined.

1. Press b to display the Calculator menu.

2. On the Actions menu, select Recall Definition.

A dialog box appears with a list of defined functions and programs.

3. Select the name from the list.

The definition (for example, Define f(x)=1/x+3) is pasted into the 
entry line for editing.

Editing Calculator expressions
Although you cannot edit an expression in the Calculator history, you can 
copy all or part of an expression from the history and paste it to the entry 
line. You can then edit the entry line.

Positioning the cursor in an expression

Press e to cycle through the parameters of a template.

– or –

Press ¡, ¢, £, or ¤ to move the cursor through the expression. The 
cursor moves to the closest valid position in the direction that you 
press.

Note: An expression template may force the cursor to move through its 
parameters, even though some parameters may not be exactly in the 
path of the cursor movement. For example, moving upward from the 
main argument of an integral always moves the cursor to the top limit.

Inserting into an expression in the entry line
1. Position the cursor at the point where you want to insert additional 

elements.

2. Type the elements that you want to insert.

Note: When you insert an open parenthesis, Calculator adds a temporary 
close parenthesis, displayed in gray. You can override the temporary 
parenthesis by typing the same parenthesis manually or by entering 
something past the temporary parenthesis (thereby implicitly validating 
its position in the expression). After you override the temporary gray 
parenthesis, it is replaced with a black parenthesis.
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Selecting part of an expression

1. Press ¡, ¢, £, or ¤ to move the cursor to a starting point.

2. Press and hold g and press ¡, ¢, £, or ¤ to select.

Deleting all or part of an expression on the entry line
1. Select the part of the expression to delete.

2. Press ..

Financial calculations
Several TI-Nspire™ CAS functions provide financial calculations, such as 
time value of money, amortization calculations, and return on 
investment calculations.

The Calculator application also includes a Finance Solver. It lets you 
dynamically solve several types of problems, such as loans and 
investments.

Using the Finance Solver

1. Press b to display the Calculator menu.

2. On the Algebra menu, select Finance Solver.

The solver displays its default values (or previous values, if you have 
already used the solver in the current problem).

3. Enter each known value, using e to cycle through the items.

– The help information at the bottom of the solver describes each 
item.

– You might need to temporarily skip the value that you want to 
calculate.
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– Make sure to set PpY, CpY, and PmtAt to the correct settings (12, 
12, and END in this example).

4. Press e as necessary to select the item that you want to calculate, 

and then press ·.

The solver calculates the value and stores all the values in “tvm.” 
variables, such as tvm.n and tvm.pmt. These variables are accessible to 
all TI-Nspire™ CAS applications within the same problem.

Finance functions included
In addition to the Finance Solver, TI-Nspire™ CAS built-in finance 
functions include:

• TVM functions for calculating future value, present value, number of 
payments, interest rate, and payment amount.

• Amortization information such as amortization tables, balance, sum 
of interest payments, and sum of principal payments.

• Net present value, internal rate of return, and modified rate of 
return.

• Conversions between nominal and effective interest rates, and 
calculation of days between dates.

Notes: 

• Finance functions do not automatically store their argument values or 
results to the TVM variables.

• For a complete list of TI-Nspire™ functions, refer to the Reference 
Guide.
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Working with the Calculator history
As you enter and evaluate expressions in the Calculator application, each 
entry/result pair is saved in the Calculator history. The history gives you a 
way to review your calculations, repeat a set of calculations, and copy 
expressions for reuse in other pages or documents.

Viewing the Calculator history
The history of the expressions you have entered accumulates above the 
entry line, with the most recent expression at the bottom. If the history 
does not fit in the Calculator work area, you can scroll through the 
history.

Note: You may notice a processing slowdown when the history contains 
a large number of entries.

Press £ or ¤.

À Scrollbar buttons

Á Scroll position indicator

Â Current entry/total entries

Reusing a previous expression or result
You can copy an expression, subexpression, or result from the Calculator 
history and paste it into the entry line or into other TI-Nspire™ 
applications.

1. Scroll to the item that you want to copy.

2. Select the item.

À

À

Á

Â
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Note: The float setting for the current document may limit the 
number of decimal places displayed in a result. To capture the result 
in its full precision, select it either by scrolling with the up and down 
arrow keys or by triple-clicking it.

3. Press /C to make the copy.

4. Select the location where you want the copy.

5. Press /V to paste the copy.

Note: If you copy an expression that uses variables into a different 
problem, the values of those variables are not copied. You must define 
the variables in the problem where you paste the expression.

Deleting an expression from the history
When you delete an expression, all variables and functions defined in the 
expression retain their current values.

1. Use the arrow keys to select the expression that you want to delete.

2. Press ..

The expression and its result are removed.

Clearing the Calculator history
When you clear the history, all variables and functions defined in the 
history retain their current values. If you clear the history by mistake, use 
the undo feature.

1. Press b to display the Calculator menu.

2. On the Actions menu, select Clear History.

All expressions and results are removed from the history.



48 Using Calculator



Using Graphs & Geometry 49

Using Graphs & Geometry

Getting started with Graphs & Geometry
The Graphs & Geometry application enables you to:

• Graph and explore functions.

• Create and explore geometric shapes.

• Animate points on objects or graphs and explore their behavior.

• Graph data collected by the Data Collection tool.

• Explore graphical and geometric transformations.

• Explore and investigate concepts of calculus.

• Link to data created by other applications and utilize it in Graphs & 
Geometry.

 

À Problem/Page number counter

Á System Settings indicator

Â Status indicator (with battery status indicator icon)

Ã Graphs & Geometry units indicator (sample display is centimeters)

Ä Sample Graphs & Geometry work area in Graphing View, with 
Analytic Window and tooltip for triangle shown

Å Sample Graphs & Geometry entry line (line for function entry shown)

Getting acquainted with Graphs & Geometry
Turn on the TI-Nspireé handheld, and add the Graphs & Geometry 
application to your page.

À

Ä

Ã

Å

Á Â
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When you add Graphs & Geometry to a page, your work area contains 
the x and y axes for a graph, as well as a function entry line and Graphs & 
Geometry-specific tools. 

The basic components of the Graphs & Geometry application are the:

• Tool menu 

• Work area (which contains the axes)

• Entry line.

The Tool menu 

Press b to open the Actions menu. These menus and tools enable you 
to graph and explore different types of functions, draw and explore 
geometric structures, as well as other capabilities which will be covered 
in this chapter.

The following tables contain a brief summary of what each menu 
contains or tool enables you to do within the Graphs & Geometry work 
area. 

Note: The number that precedes each title is the numeric entry for 
accessing the tool using the handheld keys or the virtual keypad on the 
computer. For example, to draw a circle, you would press b 8 1.

 Menu Option List Overview of Tool Actions

1: Actions Provides tools to access the pointer, hide or 
show various graph features, add text, 
delete all objects in the work area, access 
the calculate tool, and access the attributes 
for an object or function.

2: View Provides tools to manipulate the work area 
features and display.

3: Graph Type Enables you to select the type of graph to 
plot in the work area: function, parametric, 
polar, or scatter plot. The entry line below 
the work area shows the notational 
conventions to use to specify a function for 
the selected graph type.

4: Window Provides different Zoom settings as well as 
the ability to define the x- and y-axis 
minimums and maximums. 
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Action Menu Tools 

5: Trace Creates and activates a trace on the graph. 
Sets the trace increment and enables you to 
create and remove geometric trace.

6: Points & Lines Provides tools for drawing various types of 
points, lines, segments, rays, tangents, 
vectors, and circle arcs.

7: Measurement Provides tools for measuring angles, lengths, 
areas, integrals, and slope. 

8: Shapes Provides tools for drawing circles, triangles, 
rectangles, and polygons.

9: Construction Provides tools to define perpendicular and 
parallel lines, bisectors, midpoints, locus, 
compass, and perform measurement 
transfers. 

A: Transformation Provides tools for symmetry, reflection, 
translation, rotation, and dilation. 

Tool name Tool function

1: Pointer Selects, moves, and manipulates 
objects.

2: Select Enables you to select the objects in 
part of the work area by placing a 
dashed-line box around them. 

3: Hide/Show Enables you to hide or display any 
object, function, or feature on the 
work area. 

4: Attributes Enables you to change the attributes 
of a selected object in the work area. 
Attributes vary depending upon the 
object selected. 

5: Delete All Removes all objects and graphed 
functions from the page.

 Menu Option List Overview of Tool Actions
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View Menu Tools 

6: Text Places user-created alpha-numeric 
values on the page. Numerical values 
can be applied to objects. The tool 
can be used to enter a function and 
graph it. 

7: Coordinates and 
Equations 

Displays the coordinates of a point or 
the equation of a line or circle.

8: Calculate Opens the calculate tool to perform 
calculations using measurements, 
numerical values, or calculation 
results. This tool is different from the 
Calculator application.

9: Redefine Redefines a previously defined point 
to a new location. For example, it can 
define a point in free space to a 
location on an object or from one 
object to another object.

A: Insert Slider Lets you easily modify the value of a 
numeric variable.

Tool name Tool function

1: Graphing View Places the work area in graphing mode. 
When you add Graphs & Geometry to a 
page the Cartesian axes displays in the 
work area with a function entry line 
below.

2: Plane Geometry 
View

Places the work area in geometry mode. 
Geometry scale displays, but no axes, 
grid, or entry line displays until you 
choose Show Analytic Window.

3: Hide (Show) 
Analytic Window

Opens a small graphing window on a 
plane geometry work area. Places the 
Graphs & Geometry work area in 
modeling mode. This tool can be used 
only after Plane Geometry is selected. 

Tool name Tool function
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Graphing Type Menu Tools 

4: Hide (Show) Axes Hides the axes if they are currently 
displayed on the page. Displays the axes 
if none are displayed on the page. 

5: Show (Hide) Grid Turns the grid on or off on the page. 
Objects can be attached to the grid when 
the grid is displayed.

6: Hide (Show) Entry 
Line

Hides or displays the entry line on the 
page.

7: Show (Hide) Scale Toggles between showing and hiding the 
scale legend on the work area. When the 
scale is shown, the value and/or units can 
be changed to desired values/units. This 
applies only to geometric constructions.

Show (Hide) Axes End 
Value

Toggles between showing and hiding the 
lowest value and highest value on the 
horizontal and vertical axes.

8: Add Function Table Launches the Lists & Spreadsheet 
function table. When launched from 
Graphs & Geometry, it is pre-populated 
with all functions defined in the problem 
with the exception of hidden functions. 
More information on using Function 
Tables is available in the Lists & 
Spreadsheet chapter of this document.

Tool name Tool function

1: Function Displays the function mode entry line at 
the bottom of the work area.

2: Parametric Displays the parametric mode entry line 
at the bottom of the work area. This 
display shows the t-min, t-max, and t-step 
values. The defaults are 0-2p for t-min, t-
max, and p/24 for t-step.

Tool name Tool function
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Window Menu Tools 

3: Polar Displays the Polar mode entry line at the 
bottom of the work area. This display 
shows the q-min, q-max, and q-step 
values. The defaults are 0-2p for q-min 
and q-max, and p/24 for q-step.

4: Scatter Plot Displays the Scatter Plot mode entry line 
at the bottom of the work area.

Tool name Tool function

1: Window Settings Lets you specify the minimum and 
maximum values for the x-axis and y-
axis. You can also set the axis scaling 
increment between tics. 

2: Zoom - Box Enables you to define an area that 
you want to enlarge. 

3: Zoom - In Enables you to define the center 
point of the zoom in location. The 
Zoom In factor is approximately 2.

4: Zoom - Out Enables you to define the center 
point of the zoom out location. The 
Zoom Out factor is approximately 2.

5: Zoom - Standard Automatically sets x-min, x-max, y-
min, and y-max to center the origin. 
The x and y scale factors are equal. 
This is the default axes setting when 
Graphs & Geometry is first added to 
a page.

6: Zoom - Quadrant 1 Automatically sets x-min, x-max, y-
min, and y-max to emphasize the 
first quadrant. The x and y scale 
factors are equal.

Tool name Tool function
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Trace Menu Tools 

7: Zoom - User If you have modified any window 
settings (such as x-min), Zoom-User 
saves the present settings. If you 
have not modified any window 
settings since last selecting Zoom-
User, Zoom-User restores those 
settings.

8: Zoom - Trig Automatically sets x-min and x-max 
to integer multiples of p. The x and y 
scale factors are equal.

9: Zoom - Data Redefines the axes so that all 
statistical data points are displayed. 

A: Zoom - Fit Recalculates y-min and y-max to 
include the minimum and maximum 
y values of all functions between the 
current x-min and x-max. Hidden 
functions are not included. 

B: Zoom - Square Recalculates y-min and y-max so that 
the vertical scale is the same as the 
horizontal scale.

Tool name Tool function

1: Graph Trace Activates a trace point on the graph, 
enabling you to trace functions.

2: Trace Setting Enables you to set the increment 
between points touched by Graph Trace 
automatically, or by specifying a 
numeric trace step value. 

3: Geometry Trace Enables you to view the pathway of a 
geometric or analytic object (such as a 
function graph) on the work area. The 
pathway has a delayed fade. As more 
movement occurs on the work area, 
older portions of the pathway fade. If 
you temporarily halt movement, a 
portion of the trace path remains 
displayed. 

Tool name Tool function
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Points and Lines Menu Tools 

4: Erase Geometry Trace Halts geometric trace and erases all 
persistent pathways on the work area.

Tool name Tool function

1: Point Constructs a point defined in free space, 
on an object, or at the intersection of 
two objects.

2: Point On Constructs a point defined on an object. 
When the object is a function graph, the 
coordinates are displayed. 

3: Intersection Point(s) Constructs a point at each intersection of 
two selected objects.

4: Line Constructs an infinite line defined by 
two points or by a point and a direction. 
If you press g while creating the line, 
you limit its orientation, relative to the 
x-axis or the horizontal aspect of the 
screen, by 15- increments. 

5: Segment Constructs a segment, defined by two 
end points, which may be created or 
defined in free space or on a defined 
object. 

6: Ray Constructs a ray, defined by two points 
or by a point and a direction, extending 
infinitely. If you press g while creating 
the ray, you limit its orientation, relative 
to the x-axis or the horizontal aspect of 
the screen, by 15- increments.

 7: Tangent Creates a tangent line.

 8: Vector Constructs a vector with magnitude and 
direction defined by two points. 

9: Circle arc Creates an arc based on three points.

Tool name Tool function
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Measurement Menu Tools 

Shapes Menu Tools 

Tool name Tool function

1: Length Displays the distance between two 
selected points or the length of a 
segment, perimeter, circumference, or 
radius.

2: Area Displays the area of a selected polygon 
or circle.

3: Slope Displays the slope of a selected line or 
segment. A vertical slope is represented 
by %.

4: Angle Displays the measure of an angle or an 
angle defined by three selected points.

5: Integral Calculates and displays the numerical 
value of the integral of a selected 
function, and shades the area between 
the curve and the x-axis from point a to 
point b.

Tool name Tool function

1: Circle Constructs a circle. The center point is 
defined by the first click on the page and 
the radius is determined by the second 
click. 

2: Triangle Constructs a triangle, defined by three 
points (vertices), which may be created or 
defined in free space or on a defined 
object.

3: Rectangle Constructs a rectangle. 

4: Polygon Constructs an n-sided polygon. Each click 
defines a vertex, and the polygon is 
completed by clicking the initial vertex or 
by pressing ·. 

5: Regular Polygon Constructs an n-sided regular polygon. 
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Construction Menu Tools 

Transformation Menu Tools 

Tool name Tool function

1: Perpendicular Constructs a line perpendicular to a 
selected line, segment, ray, vector, axis, 
or side of a polygon, and passing 
through a created or selected point.

2: Parallel Constructs a line parallel to a selected 
line, segment, ray, vector, axis, or side 
of a polygon, and passing through a 
created or selected point.

3: Perpendicular Bisector Constructs a perpendicular line that 
bisects two points, a segment, or side 
of a polygon.

4: Angle Bisector Constructs a line that bisects an angle 
identified by three selected points 
where the second point is the vertex.

5: Midpoint Constructs a midpoint of two selected 
points, a segment, or side of a 
polygon.

6: Locus Constructs the locus of a point or 
object defined by the movement of a 
driver point along a pathway. 
Pathways are geometric shapes and 
function graphs. 

7: Compass Constructs a circle from a center point 
with a radius defined by a selected 
segment or the distance between two 
points.

8: Measurement transfer Transfers an entered or measured 
value to a selected object, axis, or 
function graph. If the original value 
changes, the change is also reflected in 
the transferred measurement.

Tool name Tool function

1: Symmetry Creates the image of an object rotated 
180- around a point.
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Note: When you select a tool to use, that tool’s icon displays in the upper 
left corner of the Graphs & Geometry page. It is there to remind you 
which tool is currently active. 

Using the context menu
The context menu provides the tools most commonly used with the 
selected object, function, or axes. 

To display the context menu for an object:

Move the cursor to the object and then press /b. 

The first two options on the context menu are:

• Recent: lists the 9 most recent tools you used. This is a session-level 
listing. The tools used on any Graphs & Geometry page are shown, 
regardless of the document in which they are used.

• Attributes: enables you to access the attributes appropriate for a 
selected function, object, or work area.

Additional options that are appropriate for your selection also display on 
the menu. For example, the context menu for a triangle also contains the 
Hide/Show, Delete, Length, and Area options. 

The following examples show the context menu for a function and a 
circle.

2: Reflection Creates the image of an object reflected 
across a line, segment, ray, vector, axis, or 
side of a polygon.

3: Translation Creates the image of an object translated 
by a specified vector.

4: Rotation Creates the image of an object rotated 
around a point by a specified angular 
value.

5: Dilation Creates the image of an object dilated 
from a point by a specified factor.

Tool name Tool function



60 Using Graphs & Geometry

The work area 
There are two work area views available:

• Graphing View

• Plane Geometry View

The Graphing view
The Graphing view is the default Graphs & Geometry work area display. It 
contains:

• the default Cartesian axes in the Zoom Standard format (1:1 
scale).

• the entry line from which you can graph up to 100 functions. 

Axes, entry line, and grid can all be displayed or hidden, but in this view, 
no scale for any drawn shapes (e.g. Circle, etc.) can be displayed. All 
objects created in this view are analytic objects. Therefore, their 
displayed size and proportion are affected only by the scale of the axis 
system (the command "Show Scale" has no effect).

Context menu for a function (analytic 
object)

Context menu for a geometric object
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The Plane Geometry view
The plane geometry view removes the axes and entry line from the work 
area to enable you to draw geometric shapes and explore them. In this 
view, you can display and set a scale for your drawings. 

To change to Plane Geometry view:

1. From the View menu, select Plane Geometry View. 

Press b 2 2.

2. The display refreshes to clear the axes and entry line and display a 
default scale. Any graphs or drawings created in graphing view are 
not displayed on the plane geometry area. 

To return to Graphing view:

From the View Menu, select Graphing View. 

Press b 2 1.

The display refreshes to show the axes and entry line. 

Note: Any geometric constructions created while in the plane 
geometry view are retained and displayed along with any previously-
created graphs.
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The analytic window
The analytic (graphing) window is available in the Plane Geometry view. 
It adds an analytic (graphing) window on top of a portion of the plane 
geometry work area. This provides a combination work area that enables 
you to use both work area types without toggling the view between 
them. 

To open the analytic window:

1. Ensure that the work area is in Plane Geometry view.

2. From the View menu, select Show Analytic Window . 

Press b 2 3.

3. A reduced size graphing window opens on the lower left corner of 
the plane geometry space. 
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You can alter the work area, without changing the view, to temporarily:

• Hide the axes. Any graphs or objects remain displayed on the 
work area.

• Show or hide axis end values and show or hide a grid in the 
graphing window.

• Hide the entry line. 

• Hide the scale. 

• Resize the axes using the zoom tools or by dragging tic marks.

To display more of the plane geometry work area, pan the screen.

To remove the analytic window from the work area

1. From the View menu, select Hide Analytic Window . 

Press b 2 3.

Object behavior in different views
When you create an object in the graph area, it is called an analytic 
object, and all points of the object reside on the graph plane. When you 
change the axes scale, you automatically affect the appearance of the 
object. If you calculate a value associated with the object such as the 
area, only generic units are assigned (u for unit). These objects remain 
associated with the coordinate plane until you delete them or redefine 
them to the plane geometry area. When working with a modeling view 
work area, you cannot move an analytic object onto the plane geometry 
area.

Graphing 
area

Plane 
Geometry 
area

Modeling view - shows the previous two views 
and the work done on both.
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When you create an object in the plane geometry area, it is a geometric 
object. These objects can have an assigned scale, such as miles or 
centimeters, instead of u for units. You can lock a point, such as one 
vertex of a triangle, on the work area, but since the object is not tied to a 
coordinate plane, you cannot display coordinates for that vertex. When 
working with a modeling mode work area (Plane Geometry view with 
analytic window), you can move a geometric object into the graphing 
work area. The object remains a geometric object, and is not associated 
with the axes. 

The examples below show a modeling work area and the two types of 
objects: A is an analytic object while B is a geometric object.

While the two circles appear identical, they do not behave in the same 
way. Analytic objects are impacted when the graph area is altered. In the 
next example, the axes were altered. Notice that only Circle A’s 
appearance is affected by the change. 
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If you construct an object while the axis is hidden, the object created will 
be a geometric object. However, if you construct an analytic object and 
later hide the axis, the object remains an analytical one. 

Triangle as it 
appears in 
Graphing 
view. The 
unlabeled 
vertex remains 
a geometric 
point. 
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Summary of differences

Creating and manipulating axes
When you add the Graphs & Geometry application to a page, Cartesian 
axes displays by default. 

You can change the appearance of your axes in the following ways:

1. Adjust the length of the axes: 

• When using Plane Geometry view with Show Analytic Window, 

– Select an axis and retype the domain or range labels.

Feature Graph Area Plane Geometry Area

Aspect Ratio Adjustable; initially 1:1 Always 1:1 (static)

Units of Measure Generic (displayed as u) User-defined (per scale)

Area Graph Type Cartesian (default) or 
Polar

Euclidian

Uses • Define and graph 
functions to:

– Graph 
functions of 
the form f (x)

– Create scatter 
plots

– Graph polar 
equations

– Graph 
parametric 
functions

• Construct analytic 
objects

• Label equations

• Identify 
coordinates for 
discrete points 

• Construct Euclidean 
objects

• Create 
transformations

• Determine 
measurements (for 
example, length, 
angle, or area)

Behavior Analytic constructions 
must remain in the 
analytic area.

Geometric constructions 
can be moved into the 
analytic area but remain 
geometric in nature.



Using Graphs & Geometry 67

– Select an axis and drag to increase or decrease the numbers 
on the scale and tic mark spacing. 

The aspect ratio of the axes is retained. To modify the scale of 
only one axis, press g as you adjust the value or drag the line.

2. Use the Zoom tool options to adjust the view. 

3. Adjust the end style of the axes using the Attributes tool. Display the 
Attributes tool by: 

• selecting it from the menu or 

• pressing / and clicking an axis between two tick marks. 

Press the left and right arrow keys to display the desired end style. 
The attributes list for the axes also enables you to select a Zoom tool.

4. Adjust the axes scale and tic mark spacing manually. 

a) Click and hold one tic mark, and move it on the axis. The 
spacing and number of tic marks increases (or decreases) on 
both axes.

b) To adjust the scale and tic mark spacing on a single axis, 
press and hold g, and then grab and drag a tic mark on 
that axis.

Default range and 
domain

Extended domain
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5. Change axis end values by double-clicking them and typing new 
values.

6. Adjust the location of the axes. To move the existing axes without 
resizing or rescaling them, click in and drag an empty region of the 
screen until the axes are in the desired location. 

7. Use the Window Setting tool  to define the x-max, x-min, y-max, 
y-min, x-scale and y-scale values for the axes. When selected, this tool 
opens a dialog that enables you to enter the values desired. The 
current values are initially displayed. Type over them to enter new 
values.

Window Settings dialog with initial values displayed

Note: The axis values set on the Window Settings dialog can be stored as 
variables that can be accessed outside of Graphs & Geometry. Select the 
axis label at the value to be linked, and then click var to link to the value. 

You can use tools on the View menu to hide and redisplay the axes, the 
scale, and axis end values. 

From the View menu, select Hide/Show Axes .

Press b24. 

• If the axes are shown on the page, selecting this tool hides them.

• If the axes are hidden on the page, selecting this tool redisplays 
them.
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Moving about the work area
Graphs of functions may extend beyond the visible portion of your 
screen. This does not mean they are truncated. You can view them by 
panning the screen. To pan the screen:

1. Click and hold the mouse button in an open area of the page. 

2. Move to display different portions of the screen. 

Turning the grid on or off 
Graphs & Geometry can display a grid in addition to the axes for a 
function. You control the sizing of the grid as well as whether or not it is 
visible. 

To display the grid:

From the View menu, select Show Grid . 

Press�b25. 
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You resize the grid by rescaling the axes. 

To turn the grid off:

From the View menu, select the Hide Grid .

Press b25.

When the tool is selected, the page updates to remove the grid. 

In addition, you can attach a function, graph, or object to the grid while 
the grid is displayed. 

Attaching an object to the grid
1. Display the grid on the page if it is not already present.

2. Draw an object on the grid. Positioning the object so that points 
coincide with grid marks attaches the object to the grid.

For example, if you draw a triangle, then one or more of the vertices 
must coincide with grid marks.

Note: You do not have to attach an object or graph to the grid. When 
you attach an object to the grid, its subsequent relocation is constrained 
to other grid points. Analytic objects are affected by axes changes 
regardless of whether or not they are attached to the grid.

To unattach an object from the grid, select and redefine it so that points 
do not coincide with grid marks. If you hide the grid, objects attached to 
it remain displayed on the page and remain attached to the grid even 
though it is no longer visible.
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The Zoom feature
For screens with many function graphs, it can be difficult to view 
intersections and other areas of interest. To temporarily change your 
view of the screen, use the Zoom feature. 

To use Zoom:
1. Open the Window menu.

Press b4. 

2. Click the Zoom tool you want to use. 

In the following examples, all options except Zoom-Fit started with 

the graph of x2. Zoom-Fit shows a graph of a sine function.

The options are:

• Zoom - Box 

Press b42.

• Zoom - In 

Press b43.

• Zoom - Out 

Press b44.
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• Zoom - Standard

Press b45.

• Zoom - Quadrant 1 

Press b46.

• Zoom - User (appears the same as Zoom - Standard if no new 
configuration is saved) 

Press b47.
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• Zoom - Trig 

Press b48.

• Zoom - Data 

Press b49.

• Zoom - Fit 

Press b4A.
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• Zoom - Square

Press b4B.

3. The graph displays in the selected zoom view. 

If you select Zoom Box, you must click the first and third corners of 
the box. 

If you select either Zoom In or Zoom Out, you must click the center 
point before the graph is redrawn. 

4. To return the graph to its initial state, either select Undo  or select 
Zoom - Standard from the Zoom menu.

The entry line
The Entry line appears at the bottom of the Graphs & Geometry work 
area. When the line is not active, it is grayed out. 

From left to right, the parts of this line are:

À Hide/Show button.

Á Attributes button.

Circles before Zoom - Square Circles after Zoom - Square

À Á Â Ã Ä
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Â f1(x)= is the default notation for a function or inequality.

Ã Blank area into which you enter the function, polar equation, 
inequality, parametric, or scatter plot data to be graphed.

Ä Expand/Contract (History) button. 

Parametric Mode entry line

Scatter Plot Mode entry line

Polar Mode entry line
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Additional Graphs & Geometry features

Keystroke shortcuts
There are keystroke shortcuts that can simplify your work with Graphs & 
Geometry. These are:  

Using the tab and arrow keys
While the pointer allows you to access the many features and tools 
contained in Graphs & Geometry, you can also use the e and arrow 
keys to access these features. Using these keys is easier or more 
convenient than using the pointer.

The e key: 

• First tab stop: places the cursor to the right of the equal sign on the 
function entry line. This allows you to create a new expression.

• Second tab stop: highlights the Expand/Collapse entry line History 
button. 

• Third tab stop: highlights the Hide/Show button on the entry line.

• Fourth tab stop: highlights the Attributes button on the entry line.

• Fifth tab stop: focuses on the Pause/Start button of the animation 
control bar, if present. If the Data Collection control bar is displayed, 
focuses on the Start/Stop button. 

• Sixth tab stop: focuses on the graphing portion of the page and 
commits any editing changes. The pointer is active on the page.

Note: Press ge to move through the steps in reverse order. If 
slider controls are included on the work area, the fifth tab stop 

Keystrokes: Task accomplished:

. Removes a selected object from the work area.

g When used with the Line or Circle tool, constrains 
Circle and some linear objects (Line and Ray) to 
discrete intervals (for example, Circle to integer 
radius values and linear objects to multiples of 15 
degrees).

+ (+) - (-) When a number is under the pointer, the + and - 
keys enable you to change the number of 
displayed digits.

< > When a number is under the pointer, the < and > 
keys decrease or increase a value.
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moves to the slider control. Press Esc to jump to a graph on the work 
area at any time.

The arrow keys: 

• Up and Down - moves up and down among functions in the function 
history list. Moves up and down any tool menu list as well as the 
attributes list. When using the Trace tool, enables you to move to 
and trace a different graph when more than one graph is on the 
page.

• Left and Right - moves along the entry line, one space or one button 
at a time. When using the Trace tool, moves the trace cursor along 
the graph, either left or right. When viewing an attribute list, steps 
through the options for one attribute. 

Using Sliders
Sliders let you easily change the value of a numeric value in the Graphs & 
Geometry and Data & Statistics applications. Inserting a slider lets you 
represent multiple variable values in a continuous range. In the following 
example, the slider represents the numeric variable, b in the graphed 
function. 

To insert a slider, select Insert Slider on the Actions menu. The 
slider displays on the work area. 

À Variable statement that includes the name of a numeric variable in 
an entry field, the assignment operator":=", and the value set for 
the numeric variable in a second entry field

Â

À
Á
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Á Slider that you can move to values on the scale when the control is 
active

Â Track with labels for the minimum and maximum values on the scale 
and scale tic marks between the end values

Basic slider operation
To change the default variable name (v1), click the text box on the left, 
highlight the default name, and type the name of the variable that you 
want the slider to represent. You can move the slider to set the variable 
to a value, or type a number in the text box after the equal sign. Press Esc 
or click another part of the work area to unselect a slider. 

You can use a slider in the following ways:

• Grab the slider and drag it to set the variable to any value within its 
range. 

• Click a point near the slider track to grab the entire control for 
operations such as copying, moving, and deleting. 

• Drag the track ends to change the length of the slider scale.

• Click the text box for the slider variable name and type the name of 
the numeric variable to use. You can use an existing numeric variable 
or use the slider to create a new one.

Context menu and slider settings
To change the settings for a slider, access the slider context menu:

Select Settings to display the Slider Settings dialog:
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Specify the values to use for the slider:

Animating a slider
From the slider context menu, click Animate to step through the 
variable range automatically. To stop the animation, click Stop 
Animate.

Minimizing a slider
From the slider context menu, click Minimize to show a smaller display 
that includes the variable name, the current value of the variable, and up 
and down arrows. 

Variable Sets the name of the numeric variable used with the slider. 
Type the value in the field or click the drop-down arrow to 
select a value from the list.

Initial value Sets the starting value of the variable.

Minimum Sets the lowest value in the range of values used with the 
slider. This value displays at the left end of the scale.

Maximum Sets the highest value in the range of values used with the 
slider. This value displays at the right end of the scale.

Step Size Sets the size of the increment between values. When a 
slider is active, you can use the arrow keys to move the 
slider up or down the scale by this amount.

Style Lets you choose how the slider is displayed in the work 
area. Choose horizontal for a left-to-right scale, or choose 
vertical for a top-to-bottom scale. To display a slider that 
includes the variable name, current value, and direction 
arrows only, choose minimized.

Result Lets you choose the format for the displayed value of a 
slider. Choose Auto to let slider operate in the default 
format, or choose from eight floating point formats.

Show 
variable

Shows or hides the variable.

Show scale Shows or hides the scale on the slider track.

Minimized
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Opening and exporting files
You can open Cabri II Plus™ Figures (.fig) files in Graphs and Geometry 
and open TI-Nspire™ .tns files in Cabri II Plus™. Cabri II Plus™ files that 
you open in Graphs & Geometry convert to a Graphs & Geometry page 
with converted figures and a Notes page with conversion messages. Each 
Graphs & Geometry page converts to a separate Cabri II Plus™ file when 
you open a .tns document in Cabri II Plus™.

Note: On a Macintosh computer, you cannot open a Cabri II Plus™ .fig 
file or a Learning Check .edc file. You also cannot export a TI-Nspire .tns 
document as a .fig file.

Opening a Cabri II Plus™ file
To open a Cabri II Plus™ figures (.fig) file in Graphs & Geometry:

1. Select Open Document on the File menu. 

2. On the Open TI Nspire Document dialog, click Files of Type and 
choose Cabri Plus II Figures (*.fig). 

3. Click the .fig file that you want to open in Graphs & Geometry and 
click Open. 

Converted Cabri II Plus™ figures display on a Graphs and Geometry 
page and conversion messages display on a Notes page. The file is 
saved as a .tns document. 

Exporting a Cabri II Plus™ file
To export Graphs & Geometry pages of a TI-Nspire™ .tns document to 
Cabri II Plus™:

1. Open the .tns file that contains the Graphs & Geometry pages to 
export.

2. Choose Export on the File menu.

3. On the Export to Cabri dialog, click OK to save the .fig files in the 
current folder. 

Each Graphs & Geometry application in the document will be 
converted to a separate Cabri II Plus™ file within that folder.

Attribute settings
The following table lists the attributes available when working with 
objects. The list of available attributes depends upon the object you 

select. To view attributes, select the Attributes tool . 
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When the tool is selected, move the cursor to the work area and select 
the object or function whose attributes you want to change. The column 
of attributes available displays on the work area near the object or 
function. 

Name Icon(s) Options Available for use on

Line Weight

  

Thin, Medium, 
Thick

Line, Tangent, Segment, 
Ray, Vector, Circle, Circle 
arc, Triangle, Polygon, 
Regular Polygon, 
Rectangle, Graphed 
Functions, Integrals, 
Polar Equations, 
Parametric plots

Line Style

  

Solid, Dashed, 
Dotted

Line, Tangent, Segment, 
Ray, Vector, Circle, Circle 
arc, Triangle, Polygon, 
Regular Polygon, 
Rectangle, Graphed 
Functions, Polar 
Equations, Integrals, 
Parametric Plots

Animation

  

Unidirectional 
Animation Speed, 
Alternating 
Animation Speed

Point, Point On

Fill

  

  

  

No fill, White, 
Light Grey, Med 
Grey, Grey, Dark 
Grey, Black

Circle, Triangle, 
Polygon, Regular 
Polygon, Rectangle, 
Integrals

Lock/ 
Unlock  

Point, Point On, 
Intersection Point, 
Length, Perimeter, Area, 
Angle
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Point Style

  

  

  

Small dot, Large 
dot, Hollow circle, 
Solid square, 
Hollow square, x, 
+

Point, Point On, 
Intersection Point 

Activation

 

Point Activated, 
Point Deactivated

Points

Graph 
Appearance   

 

Continuous, 
Discrete, Number 
of Points, Step 
Size

Graphed Functions, 
Polar Equations, 
Parametric Curves

Axes Style

    

Grid, No Grid Axes 

Axes 
Settings

Axes user settings, 
Axes Quadrant 1 
settings, Axes Trig 
settings, Axes Stat 
settings, Axes 
standard settings

Axes

Axes End 
Style   

No Arrow, Positive 
Arrows, All 
Arrows

Axes

Axes Tic 
Labels

Tic labels are 
shown, Tic labels 
are hidden

Axes

Axes End 
Values   

End Values are 
shown, End Values 
are hidden

Axes

Line 
Equation 
Type

  

Cartesian (y=_), 

Canonical (_=0)

Line, Tangent, Segment, 
Ray, Vector

Name Icon(s) Options Available for use on
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Changing the thickness and style of a line/outline
You can control the thickness and appearance of the lines and outlines of 
shapes that you create on the screen. To adjust the thickness of the lines:

1. From the Actions menu, select the Attributes . 

Press b13.

2. Select the object whose line you want to change. 

Use 9 and : to move through the list of attributes. 

3. Highlight the thickness option, and use 7 or 8 to move through the 
thickness options. 

As you move through the options, the thickness immediately 
changes on the screen. 

4. When the desired thickness displays on the screen, press · or click 
to confirm the change. 

The Attributes bar disappears.

Use the same method to change the style of the line, selecting the style 
attribute, instead of the thickness attribute. 

Locking measured values and points
Graphs & Geometry allows you to lock one or many values or points. To 
do this:

1. From the Actions menu, select Attributes . 

Press b13 .

Equation 
Type  

Canonical (...=0),

Cartesian (...=r2)

Circle 

Plot Points

 

Discrete Points, 
Connected Points

Parametrics, Scatter 
Plots, Polar equations

Labels

  

  

 

y=, f( ), f( )=, 
y=f( ), f, 

Graphed Functions 

Name Icon(s) Options Available for use on
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2. Select the value or point that you want to lock. 

3. Use 9 and : to locate the Lock attribute. 

4. Use 7 or 8 to select Lock. 

5. Click or press · to lock the value or point. 

A lock icon appears near the locked value or point. 

An example of when locking measured values is useful is the problem of 
maximizing an area contained within a fixed perimeter. In this case, a 
rectangle is created with the correct perimeter, and both the perimeter 
and area values are displayed. The perimeter value is locked. As you alter 
the sides of the rectangle, the perimeter remains unchanged but the area 
changes. When the optimum area displays, you can measure the sides to 
obtain the necessary dimensions. 

Working with functions
The entry line under the work area lets you specify functions in the 
format supported for each graph type in Graphs & Geometry. 

Using the entry line
The entry line displays at the bottom of the page. The entry line displays 
the form to use to type the function that corresponds to the selected 
graph type. To type details for a function on the entry line:

1. Select the graph type to set the graphing mode. You can specify 
multiple functions for each graph type. The default graph type is 
Function, so the form f1(x)= displays. 

2. Type the data for the type of function you want to graph using the 
function formatting that displays on the entry line:

Initial rectangle with 
locked perimeter

Optimized area with same 
initial perimeter
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– To graph a function, select Function on the Graph Type menu. 
The work area and entry line change to function mode. Enter an 
expression for the function after the equal sign.

Press b31.

– To graph a parametric equation, select Parametric. The work 
area and entry line change to parametric mode. Type 
expressions for xn(t) and yn(t). Specifying alternate values for 
the default t-min, t-max, and t-step displayed is optional.

Press b32.

– To graph a polar equation, select Polar. The work area and entry 
line change to polar mode. Type an expression for rn(q). 
Specifying alternate values for the default q-minimum and q-
maximum, and q-step displayed is optional.

Press b33.

– To graph a scatter plot, select Scatter Plot. The work area and 
entry line change to scatter plot mode. Click the arrows that 
display to choose x and y for sn.

Press b34.

3. Press · or e. 

After your selection is graphed, the entry line changes to enable you to 
specify another graph of the same type. For example, after you graph 
f1(x), the entry line changes to f2(x)= to enable you to enter another 
function. If you select or trace a function, that function displays on the 
entry line.

As you graph multiple functions on one set of axes, Graphs & Geometry 
labels each with its function. You can define and graph a maximum of 99 
functions of each type. For example, you use function mode to specify 
functions (f1(x) - f99(x) ). You can also rename multiple functions that use 
custom names, for example, g1(x). 

Note: If you draw a geometric figure, the entry line may disappear from 

the page. Press /G to select the Show Entry Line tool .

Using the entry line expand button
Click the entry line to display a line-by-line history list of the functions 
entered on the screen. The list displays functions in the order of entry 
(top to bottom), with the most recent entry closest to the entry line. Use 
9 and : to move up and down the list. 
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Use the function history to edit, change the attributes of, delete, or hide 
(or redisplay) a specific function or graph. 

Graphing a family of functions
A family of functions differ by one or more parameters and can be 
specified with a single expression. To graph a family of functions: 

1. Type an expression for a family of functions on the entry line. To 
specify a family of functions:

• Specify the parameters as one expression for multiple functions 
using the format f1(x)={-1,0,1,2}*x+{2,4,6,8} or f1(x)=m*x| 
m={1,2,3}.

• Enclose the lists of numbers or lists of variables in curly brackets. 

For example, four functions are denoted with the expression: 
f1(x)={-1,0,1,2}*x+{2,4,6,8}. The first function to be evaluated is y= -1 
* x + 2 and the second is 0*x + 4.
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2. Press · to graph the family of functions specified. 

Graphs & Geometry creates and displays a separate graph object for 
each member of the family of functions. Each function is labeled 
(f1_1, f1_2) to indicate its sequence in the expression. You can select, 
move, or trace the graphs to explore them.

Note: Editing a single function graph to change it to a family of 
functions is not supported.

Using the Text tool to enter functions
You can graph functions, including functions of the form "y=", by typing 
them into a text box. To graph a function this way:

1. From the Actions menu, select the Text tool . 

Press b15.

2. Click the work area to place the text box. Type the function you want 
to graph. 

3. Drag the text box to the x-axis, and drop it on the axis. 

Graphs & Geometry graphs the function on the axes.
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Regardless of how you enter functions, each function is labeled on 
the graph for identification.

Graphing inequalities
Function mode enables you to define a function that uses a symbol other 
than the equal sign. To change = to a different sign and graph the 
inequality:

1. Position the cursor to the right of the equal sign. 

2. Delete the equal sign:

• Press ..

3. Type the desired sign or use the Symbol Palette to enter the 
appropriate inequality. The possible inequalities are: >, +, {, and |.
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4. Type the rest of the inequality expression. 

Press · to graph it. 

The expression, as typed, displays next to the graph. Shading is 
always present on the graphs of inequalities to show the values that 
satisfy the inequality. If you graph two inequalities that overlap, the 
area of overlap is shaded darker than either of the individual 
inequality graphs.

Renaming f(x)
fn(x) is the default naming convention for functions and inequalities 
entered into Graphs & Geometry. The number, represented by n, 
increases as you enter more functions.

To change fn(x) on the entry line:

1. Place your cursor to the right of the = sign in the entry line.

2. Clear the line:

• Press . until the line is blank.

3. Type the letters/numbers for the system you want to use, and then 
type the function or inequality you want to graph. 

4. Press · to graph the function. 
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Notice that the label shown next to the graph is identical to what 
you entered.

Note: When you use a customized naming convention, you must 
manually rename each function or inequality entered to continue the 
custom naming convention.

Editing functions
You can edit graphed functions, one function at a time. To edit a 
function:

1. Use one of the following methods to access the function:

• Press d and double click the function label on the graph. 

• Use the entry line Expand button or the up arrow to move to the 
function. 

The expression displays in a text box, ready to edit.
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2. Move the cursor to the portion of the function you want to change.

3. If you are adding to the expression, type the new characters into the 
function. 

If you need to delete a portion of the function, remove the 
unneeded characters and type any new characters. 

4. Press · to graph the revised function.

Hiding a function on the work area

1. Click the Expand button or press e until the Expand button has 

focus, and then press · to display the function history list.

2. Use the function history list to locate the function you want to hide 
on the work area.

3. Click the Hide/Show button  to the left of the function. 

The graph of the function as well as its label are hidden on the 
screen. The Hide/Show button appearance changes in the list to 
indicate that the function is hidden. To redisplay the function, repeat 
the steps above. 

Note: You can also hide a function by first selecting Hide/Show on the 
Actions menu, clicking the function on the work area, and pressing Esc 
to exit Hide/Show.
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Deleting a function
To remove a function from your graph:

1. Select the function by clicking on its graph. 

You can also select a function by using the Expand button to list all 
functions on the work area, then selecting the function in the list. 

2. Press .. 

The function is removed from the page and from the list of graphed 
functions. 

Clearing the work area
1. To remove all functions and objects from the work area at one time, 

select Actions > Delete All 

Press b14. 

The system displays a delete confirmation box. 

2. Select Yes, and all objects and functions are deleted. 

The axes remain displayed. 

The Trace tools
Graphs & Geometry provides two trace tools:

• Graph Trace - point-by-point trace of the graph for a function, 
parametric or polar equation, or scatter plot.

• Geometry Trace - trail of functions or objects.
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There is also an Erase Geometry Trace tool. This removes all geometry 
trace echos from the work area.

Using Graph Trace
Graph Trace moves through the points of a graphed function, 
parametric, polar, or scatter plot. To enable the trace tool:

1. Select the Graph Trace tool .

Press b51.

The trace point displays on the graph.

2. Graph trace enables the following operation: 

• Press 7 8 to move along the function’s graph. The coordinates of 
each point display during the trace. 

• Press 9 : to move from one function graph to another or to a 
scatter plot. The point’s coordinates update to reflect the new 
location of the trace. The trace cursor is positioned on the point 
of the new graph or plot with the closest x value to the last 
point identified on the previously traced function or graph. 

• View the points of interest ("Z" for zero, "M" for local 
maximum, and "m" for local minimum) that display as you trace 
a function’s graph.

• Type a number and press · to move the trace cursor to that x 
value on the function’s graph. 

Notes: 

– When you trace beyond the initially visible graph, the screen 
pans to show the area being traced.

– To set the Trace Step increment to use between consecutive 

jumps during the trace, select the Trace Settings tool . 

Click Enter Value and type the increment. Otherwise, the 
increment between the "steps" of the trace is set 
automatically to the increment specified when you defined 
the function. 

– To create a persistent point while in Graph Trace mode, 
press ·.

– To trace several functions simultaneously, press the up or 
down arrow key until the cursor becomes a vertical dashed 
line. The coordinates of the intersection with the dashed 
line display for each function graph. Use the left/right arrow 
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keys to move the cursor. Vertical movement is not 
supported. You cannot trace multiple polar and parametric 
equations simultaneously.

– When you select or trace a function on the work area, that 
function displays on the Edit Line.

– If you select another tool, Graph Trace becomes inactive.

To exit Graph Trace mode, press d. 

Using Geometry Trace

The Geometry Trace tool  enables you to leave a visible trail of an 
object when it is moved on the work area. The movement can be done 
manually or by using the Animation tool. 

Note: The trace trail cannot be selected or manipulated.

To use Geometry Trace:

1. Create an object or function. 

2. From the Trace menu, select the Geometry Trace tool . 

Press b53.

3. Click the object or function. Either:

• manually grab and move the object, or 

• select a point and animate it. 

If you use animation, the point must be selected for geometry 
trace as well as animation. 

The amount of trace track displayed on the work area depends upon the 
amount of movement. 

 Trace point on a sine graph
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• If the object moves very little, then the entire track remains 
displayed until you erase it. 

• If the object moves a lot, the track can obscure a significant 
portion of the work area. In this case, the older portions of the 
track fade out to prevent the work area from becoming 
obscured by the track. 

In the following example, a line segment was drawn and selected for 
geometry trace. Movement of the segment was done manually. 

Using Erase Geometry Trace
The easiest way to remove the trace tracks from the work area without 
deleting any objects or functions is to select the Erase Geometry Trace 

tool .

Press b54.

When selected, this tool removes immediately all trace tracks from the 
work area. 
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Manually manipulating functions

When you have graphed a function, you can use the Pointer tool  to 
translate, stretch and/or rotate it by grabbing its graph. As you maneuver 
the graph, its symbolic representation also changes. 

Press b11.

You can manipulate the following types of functions:

• Linear function; y=b

• Linear function; y=ax+b

• Quadratic function; y=a(x-b)2+c

• Exponential function; y=exp(ax+b)+c

• Exponential function; y=b†exp(ax)+c

• Exponential function; y=d†exp(ax+b)+c

• Logarithmic function; y=a†ln(cx+b)+d

• Sinusoidal function; y=a†sin(cx+b)+d

• Cosinusoidal function; y=a†cos(cx+b)+d

Erase Geometry Trace 
tool being selected.

Work area after 
trace track erased.
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Manipulating a linear function 

 

Manipulating a quadratic function 

Initial function graph Function translated along the x-axis. 
(Notice the revised function label) To 
translate, “grab” near the middle of 
the graph then drag.

Manually rotated function. To rotate, “grab” 
near the ends of the graph then drag.

Original quadratic function Manually rotated function. To 
stretch, “grab” away from the 
vertex of the graph then drag.
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Manipulating a sine or cosine function 

 

Function translated on the x-axis Function translated on the y-axis

To translate, “grab” near the vertex of the graph then drag.

Original sine function Rotation manipulation of the sine 
function. To stretch, “grab” away from 
the axis of vertical symmetry of the 
graph then drag.

Translation manipulation along the 
y-axis.

Translation manipulation along the 
x-axis.

To translate, “grab” near the axis of vertical symmetry of the graph then drag.
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Working with multiple objects at one time
You can select multiple objects and perform the same actions on them.

Selecting multiple objects

There are two ways to select multiple objects. To select using the pointer:

1. Click the first object you want to select. A label indicates the type or 
name of the object selected and the outline of the shape blinks to 
indicate selection.

2. Move to the second object and click it. 

3. Continue selecting objects in this way until you have clicked each 
item you want to select. 

As each object is selected, its shape outline blinks. 

To select using a selection box: 

1. Click the Select tool and click one corner of the region you want 
to select.

As you move the cursor, a box outline appears on the screen.

2. Move the cursor around the screen until all or a part of all the 
objects you want to select are contained in the box. 

3. Click a second time to complete the selection box. The selected 
objects and the axes flash to indicate that multiple items have been 
selected.

To cancel selection of objects:

1. To cancel selection for one object, click the object a second time. 
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2. To cancel selection all selected objects, click on a space without any 
objects.

Note: If you need to cancel selection for an individual object in a 
group of objects, use a selection box to activate the group. After the 
objects begin to blink, either position the cursor on the object and 
press · or press e to reach the object and press ·.

To cancel the selection box selections:

1. To cancel the selection box before it is completed, press d or .. 

2. To cancel the selection box after it is completed, click on a clear space 
in the work area without any objects or press d.

Deleting multiple selections

To delete multiple selected objects, press .. 

Note: The origin and the axes cannot be deleted even if they are 
selected for deletion.

Moving multiple selections
1. To move all selected objects, move the cursor to one of the objects. 

The cursor changes to indicate that the object can be grabbed. 

2. “Grab” the object and move it to the new location. 

All other selected objects will move along with the object moved by 
the cursor. 

Note: If any non-moveable object is selected with moveable objects, 
then all objects must be moved individually. Examples of objects that 
cannot be moved in a multiple selection are objects attached to an axis, 
locked objects, and objects defined by one or more objects with a locked 
point or value. 

Drawing and working with points and lines
In addition to graphing functions, you can also use the axes to draw 
points and lines. The types of points and lines you can create are:

• Points: Point, Point on, Intersection point(s)

• Labeling and naming a point

• Redefining a point

• Lines

• Rays
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• Segments

• Segment with defined midpoint

• Parallel line

• Perpendicular line

• Vectors

• Tangent

Points
There are three tools for creating points:

• Point

• Point On

• Intersection Point

Creating a point
You can create an independent, moveable point using the Point tool. 

1. From the Points & Lines menu, select the Point tool . 

Press b61.

2. Move to the work area, and click to create a point. 

You can move the point about the graph using the Pointer . 

Press b11.

Note: Although two points define a line, you do not create lines with the 
Point tool. 

Creating a point on a specific object 

1. From the Points & Lines menu, select the Point On tool .
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Press b62. 

2. Click on an object to create a specific point on the object. 

You can move the point about or along the object using the Pointer 

. 

Press b11.

Defining an intersection point(s)
Note: To use this tool, two drawn objects must have one or more 
intersection points. 

1. From the Points & Lines menu, select the Intersection Point tool . 

Press b63. 

2. Click on one object near its intersection with a second object. 

The exact intersection point between the two objects is drawn. If the 
two objects intersect in more than one place, all intersection points 
are drawn.
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Labeling (identifying) a point
You can identify the coordinates of any Analytic point (which you 
construct in the Graphing view, or within the Analytic Window of the 

Plane Geometry view) using the Coordinates and Equations tool . To 
label a point:

1. In the Graphing view, create a point if it does not exist. 

You can also select a point on an object using the Point On tool .

2. From the Actions menu, select the Coordinates and Equations tool 

. 

Press b16. 

Move the cursor toward the point’s location, and the coordinates 
blink. 

3. To add the coordinates to the work area, click to select the point and 
then press ·, or click the point to anchor the coordinates on the 
work area. 

The coordinates stop blinking and are displayed in parentheses. The 
format used is based upon the Locale you selected. 

If you move the point to a different location, the new coordinates 
are updated to the new position. 
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Naming a point 
You might not need to label a point but instead, you want to name it for 
easy reference. You can name points and vertices, regardless of the 
Graphs & Geometry work area view. Since they are not tied to a specific 
coordinate, names remain unchanged if you alter the location of any 
portion of an object. There are two methods for creating names. 

1. One method is to use the Text tool  after you create an object. 

Press b15.

2. A second method is to name them as you create them. To add a 
name as you create an point, type a letter or name immediately after 
you define the point. 

For example, when creating a triangle, typing the letter “x” after 
creating the first vertex names that vertex “x”. The two remaining 
vertices can be named “y” and “z” in the same way when they are 
created.

Redefining a point
You can redefine a point from an open area to an object, from one 
object to another, or from the analytic to the geometric zone (or vice 
versa.) To redefine a point: 

1. Create a point. 

(Note that in the examples, the point coordinates are labeled.) 
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2. From the Actions menu, select the Redefine tool . 

Press b18. 

3. Select the point to be redefined, then select the object.

The point moves to the object. 

 

Note: A point can be redefined from one object to another. The 
procedure is the same as described above. 

In these examples, the point is redefined from the circle to the segment.

Linear objects
The linear objects you can create and explore are located on the Points & 
Lines menu. Graphs & Geometry creates “smart” lines and rays. This 
means that the meaningful portion of the line or ray is displayed rather 
than having the object project to infinity. This feature reduces clutter on 
the work area. 
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Creating a line

1. From the Points & Lines menu, select the Line tool . 

Press b64. 

2. Click a location to start your line. 

This click defines one point on the line. 

3. Move and click again to define the direction of the line. 

Graphs & Geometry draws the line.

Note: If you press and hold gwhile creating the line, you limit its 
orientation (relative to the x-axis or the horizontal aspect of the 
screen), by 15- increments. 

Creating a ray

1. From the Points & Lines menu, select the Ray tool . 

Press b66. 

2. Click to define the endpoint of the ray. 

3. Move the cursor and click again to define the direction of the ray.

Graphs & Geometry draws the ray. 
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You can create a ray anywhere in the work area, regardless of the axes’ 
location.

Note: If you hold down the g key while creating the ray, you limit its 
orientation, relative to the x-axis or the horizontal aspect of the screen, 
by 15- increments.

Creating a line segment

1. From the Points & Lines menu, select the Segment tool .

Press b65. 

2. Click to define the first endpoint of the segment. 

3. Move the cursor and click again to define the second endpoint of the 
segment. 

Graphs & Geometry draws the segment on the page.

 

Creating a line segment with defined midpoint

With the Midpoint tool , you can define a midpoint:

• on an existing line segment, 
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• between two specified points on a line, 

• between two points on a page as you create the points. The 
midpoint is located and identified between the points. When the 
second point is selected, the midpoint is also created on the page.

1. From the Construction menu, select the Midpoint tool .

Press b95. 

2. Click at the location to start the segment. 

As you move the cursor on the work area, a second end point 
appears. In between the starting point and this end point, you will 
see the midpoint. 

3. You can move the segment in any direction until you click on the 
work area a second time. 

With the second click, the segment is anchored and the midpoint 
remains identified. 

4. If you are defining the midpoint of a segment or a segment on a 
line, click at the first endpoint of the segment. 

5. As you move the cursor along the segment or line, a second 
endpoint and the midpoint appears. 

6. Click at the second endpoint to define the segment and anchor the 
midpoint.

Midpoint defined 
between two points.
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Repositioning segments with midpoints
1. To reposition the segment after placing it on the work area, click the 

Pointer tool .

Press b11.

2. Select the segment and drag it to a new location without changing 
its orientation or length, or select one endpoint and drag it to a new 
location. 

If just an endpoint is moved and if the length of the segment 
changes, then the midpoint is repositioned to remain at the middle 
of the segment.

Creating a parallel line
You can create a parallel line with respect to any existing line on the 
work area including the axes, and the side of any triangle, square, 
rectangle and polygon. 

1. From the Construction menu, select the Parallel tool .

Press b92.

2. On the work area, click once on an existing line, segment, or axis.

This click identifies the reference line for the new parallel line you 
are creating.

3. Move the cursor away from the reference line, axis, or segment.

Notice that a dotted line displays, representing the parallel line.

4. When the dotted line is in the desired position, click again to anchor 
it on the work area. 

 

Midpoint defined for 
an existing segment.
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Note: You can also click first on the work area and then select the 
reference line to create the parallel line.

Creating a perpendicular line
You can create a perpendicular line with respect to any existing line or 
segment in the work area including the axes, and the side of any 
triangle, square, rectangle or polygon. 

1. From the Construction menu, select the Perpendicular tool .

Press b91.

2. Move the cursor onto the work area and click a point through which 
the perpendicular line should run. A dotted line shows the position 
for the perpendicular line. 

Parallel line following cursor

Anchored parallel line

Perpendicular line 
before anchoring to 
page
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3. Click again to anchor the perpendicular line. The dotted line changes 
to a solid line.

Note: Alternatively, you can double-click the line or segment to 
create at the point where you want the perpendicular line to 
intersect.

4. To move the perpendicular line to a different location on the 

reference line, select the Pointer tool . 

Press b11.

5. Click the intersection point and drag the point and perpendicular 
line to the new location. 

Creating a vector

1. From the Points & Lines menu, select the Vector tool .

Press b68. 

2. On the work area, click the spot from which the vector originates.

3. Move the cursor in the direction of the vector. 

A dotted line follows the cursor as you move about the area.

Anchored 
perpendicular line

 

Vector following cursor 
after identification of 
endpoint
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4. When the vector is in the correct position, click to anchor the vector 
on the work area. 

The dotted line changes to a solid line. 

Moving a vector 

1. Select the Pointer tool .

Press b11. 

2. Click on any point other than the endpoint and drag the vector to 
the desired location. 

Resizing a vector
Select the end point and drag it to the new location. 

Note: If the endpoint is located on an axis, you can only move the 
endpoint of the vector along the axis. 

Creating a tangent
You can create a tangent by identifying a specific point on an existing 
object or function. To create a tangent line:

1. From the Points & Lines menu, select the Tangent tool .

Press b67. 

2. On the work area, select the point at which you want the tangent 
drawn. 

A dotted tangent line blinks on the work area.

3. Click or press · to anchor the tangent on the work area.

Vector anchored to 
page
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Creating and working with objects (shapes)
With Graphs & Geometry, you can draw:

• Circles

• Triangles

• Rectangles

• Polygons

• Regular Polygons

Creating a circle

1. From the Shapes menu, select the Circle tool . 

Press b81. 

2. On the work area, click once to establish the center of the circle.

Move the cursor away from this point. 

You will see a circle with a dotted circumference line emerge as you 
move the cursor.

Tangent of a graph

Tangent of an object
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3. When the circle has the radius you desire, click again. 

The dotted circumference changes to a solid circumference in the 
work area. 

This second click does not define a point on the circumference; 
instead, it completes the circle construction. 

Note: If you hold down the g key when creating the circle, the radius 
is limited in length to integers.

Moving a circle
You can move the circle to a different location without resizing it, 

1. Select the Pointer tool .

Press b11. 

2. Select the circle’s center point. 

3. Drag the circle to the new location. 

Resizing a circle 
1. Select a point on the circumference. 
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The circle blinks. 

2. Drag the circle inward or outward to increase or decrease the 
circumference. 

3. Release the mouse button to anchor the circle in the work area. 

Creating a circle with the Compass tool

You can also create a circle with the Compass tool. 

1. From the Construction menu, select the Compass tool .

Press b97. 

2. Move the cursor to the page and 

• select the segment to use as the circle’s radius or 

• define two points. 

The distance between these points will become the radius 
length for the circle. 

3. When you select the segment, a circle displays with the center point 
positioned under the cursor. 

4. Move the circle to the desired location. 

5. Click to change the circumference from a dotted line to a solid line 
and anchor the circle on the page.

Segment selected 
for circle’s radius.
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You can use a measured length for the radius of a circle. 

1. Select a segment or the side of a triangle or rectangle. 

2. Measure the length, and display the length value on the page. 

3. Select the Compass tool . 

Press b97.

4. Click the length value. 

A circle with the radius of the selected length automatically appears. 

 

Circle created with 
Compass tool and 
anchored on page.
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Note: To use an expression or stored variable as the radius of a circle, use 
the Text tool on the Actions menu. For example, create a text box, type 
2+3, press ·. Select the Compass tool, click on the text box. A circle 
with radius 5 is displayed. 

5. Move to the desired location for the circle (it will follow as you 
move), and click to anchor it on the page. 

The circumference line changes from dotted to solid.

Creating a triangle

1. From the Shapes menu, select the Triangle tool . 

Press b82. 

2. On the work area, click once to establish the first vertex of the 
triangle. 

3. Move the cursor to the location for the second vertex and click 
again. 

Notice that the side of the triangle is shown as a dotted line.

4. Move the cursor to the location of the last vertex. 

As you move the cursor, all sides of the triangle are shown as dotted 
lines. 

5. Click again to create the final vertex and anchor the triangle on the 
work area. 

The sides are defined by solid lines.
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Moving a triangle
You can move the triangle to a different location without resizing it.

1. Select the Pointer tool . 

Press b11.

2. Select one side of the triangle. 

3. Drag it to the new location. 

Reshaping a triangle
1. Click one of the three vertices.

2. Move the selected point until the triangle is the correct size. 

Creating a rectangle

1. From the Shapes menu, select the Rectangle tool . 

Press b83. 

2. Click once to establish the first corner of the rectangle. 

3. Move the cursor to the location for the second corner, and click 
again. 

One side of the rectangle is defined.
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4. Move the cursor away perpendicularly from the side to the line. 

The outline of the rectangle appears on the screen. 

5. When the rectangle is of the correct size, click again to anchor the 
rectangle to the work area.
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Creating a polygon
You can create a polygon by defining three or more connected points. 

While you can create a triangle using the Polygon tool , using the 

Triangle tool  reduces keystrokes. To construct a polygon:

1. From the Shapes menu, select the Polygon tool . 

Press b84. 

2. On the work area, click once to establish the first point of the 
polygon. 

3. Move the cursor to the location for the second point and click again.

Notice that the side of the polygon is shown as a dotted line.

4. Move the cursor to the location of the next point. 

As you move the cursor, the polygon’s sides display as dotted lines.

Continue to move the cursor and click to create as many sides as 
needed. 

5. To complete the polygon and anchor it on the work area, do one of 
the following: 
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– double click the final point,

– click on the initial point, or 

– press ·. 

The sides are defined by solid lines.

Note: If you create a polygon with all defined points colinear, then the 
construction is defined as a segment.

Moving a polygon

1. Select the Pointer tool . 

2. Select one side of the polygon. 

3. Drag it to the new location. 

Reshaping a polygon
1. Select one of the vertices. 

2. Drag it to a new location. 

3. Click to re-anchor it on the work area. 

Creating a regular polygon

1. From the Shapes menu, select the Regular Polygon tool .

Press b85. 

2. Click once on the work area to establish the center point of the 
regular polygon.

3. Move the cursor away from the center point and click on the work 
area again to establish the first vertex and radius. 

A 16-sided regular polygon is formed. The number of sides displays 
near the center point in brackets; e.g., {16}. 
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– To reduce the number of sides, select a vertex and move the 
pointer in a clockwise motion around the perimeter of the 
polygon.

– To increase the number, select a vertex and move the pointer in 
a counter-clockwise motion. 

Note: The number of sides of the polygon displays as you move the 
pointer. 

4. When the desired number of sides displays, click to anchor the 
polygon on the work area. 

Creating a circle arc
You can create a circle arc by defining three points on the arc.

Anchored regular polygon
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1. From the Points & Lines menu, select the Circle arc tool .

Press b86. 

2. Click once on the work area to establish the first point of the arc.

3. Move in the direction you want the arc to take and click on the work 
area again to establish the second point. 

4. Move away from the second point to establish the length of the 
circle arc and click on the work area a third time.

An arc is formed. 
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Transferring Measurements
You can duplicate (transfer) a specific length to a new object using the 

Measurement Transfer tool . 

Press b98. 

The objects you can transfer a length to are:

• a circle - the length transferred becomes the radius of the circle. You 
can also transfer a measurement onto a circle to define an arc.

• a ray - the length transferred starts at the endpoint and defines a 
second point on the ray. 

• a vector - the length transferred starts at the endpoint and defines a 
second point on the vector. 

You can also transfer a numeric text value to an axis. 

Transferring a measurement
1. Measure and display the length or area that you want to transfer. 

If you want to transfer the measurement to a ray or vector, create 
these objects if they do not already exist on the work area.

2. From the Construction menu, select the Measurement Transfer tool 

. 

Press b98. 

3. On the work area, select the measurement value you want to 
transfer to a new object. 

4. To create a circle, select the Circle tool  

Press b81.

a) When you move to the work area, the circle immediately 
appears. Its radius is the transferred measurement. 



Using Graphs & Geometry 125

b) Click to anchor the circle on the work area. 

5. If you are transferring a measurement to a line, ray or vector, click on 
the object. 

The distance between the two defined points is the transferred 
measurement. 

 

Note: If you adjust the length of the initial measurement, all objects you 
create with that measurement are adjusted automatically to reflect the 
change.

Transferring a numerical text entry to an axis

1. Using the Text tool , create the number on the work area.

Press b15.

2. From the Construction menu, select the Measurement Transfer tool 

. 

Press b98. 

3. Select the created number, then click on the desired axis.

The value is marked by the addition of a point on the axis. In the 
example below, this point is labeled to show its value. 

Ray created from the 
transferred measurement
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Transferring a measurement onto a circle

1. Either enter a value using the Text tool , or display a 
measurement on the work area. 

Press b15.

Create a circle using the Circle tool if one does not already exist on 
the work area. 

2. Select the Measurement Transfer tool .

Press b98.

3. Select the value and the circle. 

4. Click on the circle a second time to define the starting point for the 
transferred measurement. 

The measurement is transferred in a counter-clockwise direction, and 
the starting and ending points of the value are marked by points. 
The arc defined on the circle has the same measure as the 
transferred value. 

Note: If you measure the distance between the two points on the 
circle, the value will be less than the transferred measurement. The 
straight line between the points is measured, not the arc formed 
between the two points. The arc’s length is the transferred 
measurement. 

The segment length was 
transferred onto the circle. The 
two points on the circle define 
this length. The hand cursor 
shows the starting point for the 
transfer.
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Measuring graphs and objects 
You can obtain various measurements from the functions you graph and 
the objects you draw. These measurements include finding areas, 
perimeters, lengths, angles, and slopes. The metric system is the default 
for units of measurement. 

Note: Document settings are available under the File menu.

Identifying equations for circles and lines
You can display the equation of any Analytic object (constructed in the 
Graphing View, or within the Analytic Window of the Plane Geometry 
View) and label it on the screen. To do this:

1. On the work area in Graphing view, create a circle or line.

2. From the Actions menu, select the Coordinates and Equations tool 

. 

Press b16. 

3. Click or press · to select the circle or line. 

The equation for the circle or line displays and the object blinks on 
the screen. 

4. Click or press · to anchor the equation on the screen.

Note: If you approach a defined point on the line or the center point of 
a circle, the coordinates for that point display instead of the equation. 
Move the cursor away from the defined point to obtain the equation of 
the object.
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Measuring length
You can use the Length tool to measure the length of a segment, circle 
arc, or vector. The length tool can also measure the distance between 
two points, the distance from a point to a line, ray, segment, or vector, 
and the distance from a point to a circle. 

Note: Measurements made on Graphing view objects and lines have 
generic units, u. Measurements made on Plane Geometry view objects 
and lines have the unit value you create. The default unit value is 
centimeters (cm).

1. From the Measurement menu, select the Length tool .

Press b71. 

2. To measure a segment, circle arc, or vector:

a) Click or press · to select the object. 

The target segment, circle arc, or vector blinks. 

b) Click or press · to anchor the measurement on the work 
area. 

Note that a line segment can be part of a triangle, 
rectangle, or polygon.

3. To measure the distance between two points, between a point and a 
line, or between a point and a circle: 

a) Select the first point. 

b) Select the second point or a point on the line or circle. 

The selected length blinks. 

c) Click or press · to anchor the value on the work area.
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4. To measure the length of one side of a triangle, rectangle, or 
polygon: 

a) Select each endpoint of the segment. 

b) Click or press · to anchor the value on the work area. 

Note: The value that displays when you initially approach the 
object (before selecting the endpoints of the side) is the 
perimeter of the object, not the length of the one side.

The measurement remains visible and close to the measured objects even 
if you move one or both of the objects or measurement points. If you 
move an object or point, the measurement updates to reflect the new 
distance. 

Finding the area of a circle, polygon, rectangle or triangle

1. From the Measurement menu, select the Area tool .

Press b72. 

2. On the work area, click or press · to select the object. 

3. To anchor the value on the work area, click or press ·. 

In this example, 
length is measured 
from the center of the 
circle to the upper left 
vertex of the polygon.

Polygon moved on 
work area. Note 
the distance value 
reflects new 
distance.
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The measurement remains visible and close to the object even if you 
change the size of the object. If you alter an object, the measurement 
updates to reflect the new area value. 

Finding the perimeter of a circle, polygon, rectangle or 
triangle

1. From the Measurement menu, select the Length tool .

Press b71. 

2. On the work area, click or press · to select the object. 

3. To anchor the perimeter value on the work area, click or press ·. 

The measurement remains visible and close to the object even if you 
change the size of the object. If you alter an object, the measurement 
updates to reflect the new perimeter value. 

Finding the measure of an angle

1. From the Measurement menu, select the Angle tool .

Press b74.

2. Click on a point on one side of the angle to be measured.

The area of the circle and 
the polygon are shown in 
this example.

The measurements in the 
example are the 
perimeters of the circle 
and polygon.
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3. Click on the vertex of the angle you want to measure. 

When you move the cursor away, the measure of the angle displays 
near the second point clicked. 

4. Click on a point on the second side of the angle to be measured to 
anchor the value on the work area.

Defining an angle with three points
You can define and measure an angle by selecting three points on the 
work area.

1. From the Measurement menu, select the Angle tool .

Press b74.

2. Click once on the work area. The first click represents one side of the 
angle. As you move to the next point, a dotted line shows the path 
used for angle measurement.

3. Click a second time on the work area. The second click represents the 
vertex. As you move to the next point, Graphs & Geometry calculates 
the measurement of the angle and displays it on the work area. 

If you are defining an angle with a specific measurement, you can 
change the path to adjust the angle size.

4. Click a third time on the work area or press ·. The third click 
represents the second side of the angle and anchors the three points 
as defined. 
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The measurement remains visible and close to the angle even if you 
change the size of the angle. If you alter the angle, the measurement 
updates to reflect the new value. 

Notes:

• The value of any angle will always be between 0- and 180- in degree 
mode or between 0- and p in radian mode.

• The default angle measure is in radians. To change it to degrees or 
gradians, change the document settings. 

• You can increase the precision of the angle measurement by placing 
the pointer on top of the measurement and then pressing + or - to 
increase or decrease the number of displayed digits.

Repositioning a measured value

1. Select the Pointer tool . 

Press b11.

2. Select and drag the measurement to the desired location.

Finding the slope of a line, ray, segment or vector

1. From the Measurement menu, select the Slope tool .

Press b73.

2. On the work area, click or press · to select the object. 

3. Click or press · to anchor the value on the work area. 



Using Graphs & Geometry 133

The slope remains visible and close to the object even if you alter the 
slope. Note that the value changes as the object is moved. 

Note: If the object is vertical, the slope value is -% or +%. If the object is 
horizontal, the slope value is 0.

Adding text to the work area
You may want to add your own text to a page or enter a numerical value 
to use on the work space. Graphs & Geometry enables you to do this 

using the Text tool . 

1. From the Actions menu, select the Text tool . 

Press b15. 

2. On the work area, select the location for adding text, and click . 

A blinking cursor appears at the spot you selected. 

3. Type the text. 

You are limited to typing the text that will display on the page.
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If you use the Text tool  to enter numerical values, these are 
interpreted as numbers by Graphs & Geometry and can be used for 
computing or specifying measurements.

4. Click again or press · to anchor the text on the work area.

To exit this mode, select another tool or save your work.

Moving text

1. Select the text with the Pointer tool . 

2. Drag it to the new location. 

3. Click the text to anchor it in the new position.

Using the Calculate tool

The Calculate tool  enables you to perform arithmetic calculations 
using measured and entered values. An example best shows how this 
tool is used.

1. Create an object and display measurements for it. In this example, a 
triangle is constructed and its angles are measured. 

2. Use the Text tool  to write the desired formula. Here, the angle 
measurements are added. 

Press b15.

3. Select the Calculate tool . 
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Press b17. 

Select the formula just created, then select each angle measurement. 

4. When all variables in the formula have values, the answer displays on 
the work area. 

5. Click to anchor the value. 

Exploring functions, graphs, and objects
Once you create graphs and objects, you can use other tools to explore 
various relationships among and between them. 
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Finding points of interest: zeroes, minima, maxima

When you create a graph, you can use the Point On tool  (press 
b62) to locate the zeros, minima, and maxima if these are 
applicable for objects on the work area. (They may not display if their 
location on the graph not visible on your screen.) Both local and global 
points of interest display. You can also use the Graph Trace tool to display 
the local points of interest automatically as you trace.

Note: Global points of interest display only when they are also local. For 
example, inverse sine reaches its (global) maximum at x=1, but the tool 
tip 'M' does not display there. This is because x=1 is not a local maximum.

To find them, just move the point along the object or graphed line, and 
when you are near a point of interest, the coordinates display along with 
one of the following identifiers:

• Zeroes: z (Coordinates)

• Minimum: m (Coordinates)

• Maximum: M (Coordinates)

Finding the min and max of a function
To find the minimum or maximum of a function or object on the graph:

1. From the Points & Lines menu, select the Point On tool .

Press b62. 

2. Select the function graph or object.

3. From the Actions menu, select the Pointer tool . 

Press b11.

4. Select the point created in Step 2 and drag it along the function 
graph or object. 

As you approach a point of interest, the one-character identifier 
along with the point’s coordinates display. The example below shows 
the m (minimum) identifier along with the value of the minimum for 
the function graphed on the axes.
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5. As you move away from the point of interest, the identifier no 
longer displays on the page. 

Finding the definite integral of a function
1. Select the function.

2. From the Measurement menu, select the Integral tool .

Press b75. 

3. Define the range for the integral, both the upper and lower limit. Do 
this by clicking on the function to display a limit boundary line. 

4. When the boundary line is in the desired location, click to anchor it 
on the page. 

5. Move the cursor to display the second limit boundary line. 

6. When it is correctly located on the page, click to anchor it. 
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Notice that the integral between the bounds and with respect to the 
x-axis is shaded on the page. 

Tips:

• To stop the boundary line at a tic mark on the x-axis, select the 
tic mark. 

• For precise integral boundaries, type a numerical value instead 
of graphically placing either or both lower and upper boundary 
lines. 

Finding the derivative of a function at a point (the slope)
1. Graph a function. 

2. Select a point on the graph. 

3. From the Points & Lines menu, select the Tangent tool . 

Press b67.

4. Construct the tangent at this point. 
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5. From the Measurement menu, select the Slope tool .

Press b73. 

6. Determine the slope at the tangent. 

This is the value of the derived function for the selected value of x.

7. Click to anchor the value on the page.

Transformations
You can apply transformations to drawn objects, and some can be 
applied to functions. When working with functions, the axes are most 
frequently involved and may be required. Object transformations can 
occur without the use of axes as a reference point. 

The transformations supported by Graphs & Geometry are:

• Symmetry with respect to any point, including the origin

Tangent line created for 
the function. The point of 
tangency is labeled.
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• Reflections with respect to any straight line, including the axes

• Translations along any vector, including vectors on the axes

• Rotations about any point, including the origin, and any angle

• Dilations from any point, including the origin, with any factor

The first step in any transformation is to create an object or the graph of 
a function.

Exploring symmetry
1. Create an object or graph a function. 

2. Create a point of symmetry using the Point tool . 

Press b61.

3. From the Transformation menu, select the Symmetry tool . 

Press bA1.

4. Select the object, then select the point.

5. The symmetrical image displays. 

Exploring reflection
1. Create an object.

2. Create a line or segment about which the object will be reflected.
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3. From the Transformation menu, select the Reflection tool .

Press bA2. 

4. On the work area, select the reflection line or segment. 

5. Select the object.

The object reflection displays on the page. 

6. To anchor the reflection, click on the page or press ·.

Exploring translation
1. Create an object to translate (duplicate).

2. You can define the distance and direction of translation by 

• creating a vector, or

• selecting two points “on the fly”. 
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To use a vector, define it before performing the translation. The 
examples use two points to define translation distance and direction.

3. From the Transformation menu, select the Translate tool .

Press bA3. 

4. Select:

• the vector or click on the page to define the translation 
direction and distance 

• the translation object. 

The translated object displays.

Exploring rotation
1. Create an object or graph a function.

2. Create a point about which the object will be rotated. 
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3. Create three points whose angle defines the angle of rotation, or 

using the Text tool , type a numeric angle value. 

Press b15.

4. Press · to anchor the value on the work area.

5. From the Transformation menu, select the Rotation tool .

Press bA4.

6. Move to the work area and select 

a) the point about which the object will be rotated, and

b) the object to rotate, and

c) the three points that define the angle of rotation or the 
numeric angle value.

The object is recreated in the rotated position as defined by the 
rotation point and angle of rotation. 

Exploring dilation
1. Create an object.

Triangle ready for 
rotation. The rotation 
point is labeled with 
coordinates. The three 
angle of rotation points 
appear above the 
triangle.
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2. Create a point that is the center of the dilation. 

3. Create a number using the Text tool or measure an existing 
length. 

Press b15 and press · to anchor the value on the work 
area. 

Note: If you type a large number, the dilated object will not display 
on the work area without panning.

 

4. From the Transformation menu, select the Dilation tool .

Press bA5. 

5. Select the value measured or created, the dilation point, and then 
move toward the object. 

The dilation appears on the work area. 

 

Polygon, dilation point, 
and measurement on 
page. 
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In the following example, the polygon from the previous example 
was retained, but a negative number was entered using the Text tool 

.

Press b15.

Other investigations
You can investigate graphs by 

• Bisecting segments

• Bisecting angles

• Finding the Locus

Bisecting a segment defined on a line
1. From the Construction menu, select the Perpendicular Bisector tool 

.

Press b93. 

2. Click on the line to select one end point for this segment. 

3. Move to another point on the line and select it. 

The segment is now defined, and the perpendicular bisector is 
drawn. 
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Bisecting a segment 
1. From the Construction menu, select the Perpendicular Bisector tool 

.

Press b93.

2. Click the segment. 

The perpendicular bisector displays. 

3. Click once more to anchor the bisector on the work area.

Note: A segment can be one side of a triangle, rectangle, or a 
polygon. 

Creating the second point on a line.

Perpendicular bisector anchored on 
segment between two defined points.
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Bisecting an implied segment 
1. From the Construction menu, select the Perpendicular Bisector tool 

.

Press b93. 

You imply a segment by defining two points. 

2. Click once to define one end of the implied segment.

As you move away from this point, a segment and the bisector 
appear.

Bisecting an existing 
segment (bisector not 
anchored on page).

Bisecting the side of a 
polygon (bisector not 
anchored on page.)
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3. Click a second time to define the other end of the implied segment 
and anchor the segment and bisector. 

Bisecting an angle

1. From the Construction menu, select the Angle Bisector tool .

Press b94.

2. If a triangle or other angle already exists on the work area, click once 
on one side of the desired angle. 

3. Click once on the vertex. 

4. Click once on the second side of the angle. 

The bisector is anchored on the work area. 
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Bisecting an implied angle

1. From the Construction menu, select the Angle Bisector tool .

Press b94.

If no angle is present on the work area, you can create one by 
selecting three different points. 

2. Click to define the first side of the angle. 

3. Click to define the vertex of the angle. 

4. Click to define the second side of the angle. 

The bisector line appears and is anchored on the work area when 
you select the third point. 

Creating the angle bisector at the 
vertex of a triangle.

Anchoring the angle bisector on 
the page.
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Note: If you select the Pointer tool  and move one point of the 
created angle, the angle bisector moves so that it always bisects the 
angle.

Press b11.

Creating a locus

The Locus tool  enables you to explore the range of motion of one 
object with respect to another object as constrained by a shared point. 

To create a locus:

1. Create a segment, line, or circle. 

2. Create a point on the segment, line or circle. 

3. Create another object that uses the defined point created in the 
previous step. 

 

Creating an angle bisector by 
defining three points. The second 
point represents the vertex of the 
angle.

Angle bisector created by 
defining three points on the 
page.

Point defined on the 
line segment.
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4. From the Construction menu, select the Locus tool .

Press b96.

5. On the work area, select the last object. 

6. Select the defined point used by both objects. 

The continuous locus picture is displayed. 

7. Move the point on the first construction. 

The second construction deforms to follow the locus point. 

Circle created to use the defined 
point on the segment.

Two examples of the radius change of the circle as the locus 
moves along the line segment. The radius is labeled to better 
show the change.
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You can create and explore a large number of designs using the Locus 
tool and your imagination. The following are examples of a few 
structures that you can create. 

Animating objects
You can animate a point on a line, ray, axis, vector, graph, segment or 
circle. In addition, you can also animate points on multiple objects in the 
work area at one time. 

Animating one point on an object 

1. From the Points & Lines menu, select the Point On tool .

Press b62. 

Click on the object to identify the point that you want to animate. 

Locus created using a point 
and a segment. 

Locus created from two 
overlapping circles.
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2. From the Actions menu, select the Attributes tool . 

Press b13. 

When the attribute bar displays, select the animation attribute .

3. The default speed is 0. You can type a number from 1 - 9 to set speed 
or you can use < or > to select a speed from -12 to 12. 

The higher the number you type, the faster the animation speed. 

4. Select → for one-way animation or ↔ for oscillating animation. 

5. Animation begins automatically when you select the speed and 
direction. 

Press + and - to increase/decrease the speed of animation 
incrementally once it is set.

The animation control panel 
Once a point is animated, a floating control panel displays on the page. 
You can move this panel by dragging it to a new location.

When animation is active, the panel contains a Reset  and a Pause  
button. When either button is pressed and animation is reset or paused, 
the Pause button changes to a Start  button. These controls affect all 
animated points on a page.
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Changing the animation of a point in motion
To change the speed of a point’s movement or the direction of 
animation:

1. Reset or pause the animation. 

a) Select the Attributes tool . 

b) Select the point you want to change. 

c) When the attribute bar displays, select the animation 

attribute ( ).

2. To change the speed, type a new velocity number. 

3. To change the direction of animation, press 78 to select the desired 
direction.

4. Press the Start  button. 

The point moves at the new speed and/or in the new direction you 
selected.

Pausing and resuming animation

To pause the animation on a page, select the Pause  button. 

To restart animation, select the Start  button.

Resetting animation

Selecting the Reset  button not only pauses animation but also returns 
the animated point to its initial coordinate position on the object when 
animation was first started. If multiple points are animated on the page, 
all are returned to their original locations when you select Reset.

Stopping animation
To stop the animation of an object:

1. Select the Pause  or Reset  button on the control bar. 

2. Display the Animation attribute for the point. 

Panel when animation is 
active

Panel with animation 
paused/reset
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3. Change the speed to 0 (zero). 

4. Click an empty area of the screen to apply the change, or press ·. 

5. Select Start  to resume animation if other animated points were 
temporarily stopped. 

If no other animated points are on the page, the animation control 
box does not reappear when the velocity is set to 0.

Note: If you have multiple points in motion on one page and want 
to permanently stop the animation of all objects, when motion is 
paused or stopped, display the attributes bar for each point and 
change the velocity to 0. 

Plotting collected data
In addition to using Graphs & Geometry by itself, you can use it to 
explore the data collected from scientific instruments or stored in lists. 
Using data to create plots can be more helpful in understanding and 
interpreting data than just examining the raw values. 

Creating a scatter plot
If you do not have an existing set of data points available for plotting, 
create them on the same page using the Lists & Spreadsheet application. 

1. To create the data lists and scatter plot on the same page, select a 
page configuration with two work areas. 
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2. Create the data lists on the Lists & Spreadsheet portion of the page. 

 

3. Select the Scatter Plot tool . 

Press b34.

 

4. Select the lists to plot from the drop down list for each axis. 

When both entry fields have a data list specified, the scatter plot 
displays on the Graphs & Geometry work area. 
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5. To label the points on the scatter plot, select the Point On tool  
from the Points & Lines menu. 

Press b62.

a) Select the first point. 

The coordinates display. 

b) Click to anchor the values on the work area.
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c) To label the remaining points, select them one at a time.

Click each one to anchor the coordinates on the work area. 

6. Label the axes and significant points, if desired. 

Note: If you have plotted more than one set of data, notice that each 
plot has a different point style. 

You can use Graphs & Geometry to examine the differences between 
points in one data set or between two or more sets by determining the 
slope between points, comparing min and max points, and/or calculating 
overall change over elapsed time.
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Using Lists & Spreadsheet

Getting started with tables
The Lists & Spreadsheet application gives you a place to work with 
tabular data. You can use Lists & Spreadsheet to:

• Store numeric data, text, or math expressions.

• Define a table cell in terms of the contents of other cells.

• Define an entire column in terms of another column.

• Share columns of data as list variables with other TI-Nspire™ math 
and science learning technology applications. Also share individual 
cells as variables.

• Work with variables created in the Graphs & Geometry and 
Calculator applications.

• Collect tables of real-world data from sensors.

• Generate columns of data based on other columns or sequences that 
you define.

• Plot table data using the Data & Statistics application.

• Generate function tables from functions defined in Calculator or 
Graphs & Geometry.

• Perform statistical analysis on lists of data.
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À Lists & Spreadsheet menu (available when a Lists & Spreadsheet work 
area is active) Press b to display the menu.

Á Sample Lists & Spreadsheet work area

Â Lists & Spreadsheet data shared with another TI-Nspire™ application

The Lists & Spreadsheet tool menu
The Lists & Spreadsheet tool menu lets you modify your display and enter 
and evaluate a variety of math expressions.

Menu 
Name

Menu Option Function

 Actions

Move Column Lets you reposition the current 
column.

Resize For a selected column, lets you 
set the width to maximum, 
minimum, or a custom width.

For a selected row, lets you set 
a custom row height.

À

Á Â
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Select Selects an entire row or 
column, or helps you insert a 
range of cells into a cell 
formula.

Go To Jumps to the specified cell, such 
as d16 or g20.

Recalculate Recalculates results of all cell 
formulas and generates new 
results for random functions 
such as rand(), randInt(), and 
randSamp().

Sort Lets you sort the selected 
columns of the spreadsheet 
based on the contents of a 
single column.

 Insert

Insert Cell Inserts a cell.

Insert Row Inserts a row above the current 
row.

Insert Column Inserts a column before the 
current column.

 Data

Generate Sequence Displays a dialog box for 
creating a sequence.

Data Capture Allows manual or automatic 
capture of variable data from 
Graphs & Geometry, Calculator, 
Data & Statistics, or within Lists 
& Spreadsheets. Use the 
following key sequence to 
trigger each manual capture:

/^

Menu 
Name

Menu Option Function
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Fill Down Lets you duplicate the contents 
of a selected cell or group of 
cells within a column.

Clear Data Removes data from the 
selected column or columns. 
Does not clear list names or 
column formulas. After the 
data has been cleared, column 
formulas are recalculated in the 
selected columns.

Quick Graph Uses the Data & Statistics 
application to graph one or 
two selected columns of data as 
a dot plot, dot chart, or scatter 
plot.

 Statistics

Stat Calculations Lets you select from several 
statistics calculations, such as 
one-variable analysis, two-
variable analysis, and 
regressions.

Distributions Lets you calculate and plot 
several distributions, such as 
Normal Pdf, Binomial Cdf, and 
Inverse F.

Confidence Intervals Lets you calculate several 
confidence intervals, such as 
t interval and z interval.

Stat Tests Lets you perform and plot 
several hypothesis tests such as 
t test, z test, and ANOVA.

 Function Table

Switch to Function Table Toggles the function table 
view.

Menu 
Name

Menu Option Function
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Before you begin
Turn on the TI-Nspire™ handheld, and add a Lists & Spreadsheet 
application to a document. 

Navigating in a spreadsheet
You can select any cell to view or edit its contents. When a spreadsheet is 
larger than the Lists & Spreadsheet work area, you can view different 
parts of the spreadsheet by:

• Pressing ¡, ¢, £, and ¤ to move through the spreadsheet. This 
moves the selection from cell to cell and scrolls as necessary to keep 
the selected cell in view. You can also use the Page up (/9), 

Page Dn (/3), Home (/7), and End (/1) keys.

• Using the Go To command on the Actions menu to select a specific 
cell. Type the cell’s column letter and row number (such as G16).

A column letter appears at the top of each column, and a row number 
appears in the left cell of each row. The top two rows and the left column 
of the spreadsheet remain in place as you scroll so you can more easily 
determine your location.

Select Function Lets you select a different 
function for the current 
column.

Edit Function Table 
Settings

Lets you change the viewing 
parameters for the table.

Delete Column Removes the current column.

Edit Function Expression Lets you change a function 
definition without leaving the 
function table.

Menu 
Name

Menu Option Function



164 Using Lists & Spreadsheet

À Column reference letter

Á Header or formula row

Â Row reference number

Ã Column/list name

Ä Cells

Å Entry line

Æ Result tooltip for large result

Inserting a cell range into a formula
The Select Range feature lets you insert a cell range (such as a1:b3) into a 
formula by selecting the range instead of typing cell addresses into an 
argument.

Suppose you want to calculate the mean of a range of cells.

1. Type “=mean(“ in the cell that will contain the result.

Ä

À

Â

Á

Ã

Å Æ
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2. Press b to display the Lists & Spreadsheet menu.

3. On the Actions menu, choose Select, and then choose Select Range.

A dotted selection rectangle appears around the cell that contains 
the formula. 

4. Move to the first cell in the range, and use the arrow keys along with 
g to select the range of values whose mean you want to calculate. 
The dotted selection rectangle moves to enclose the cells you specify 
for the range.

The formula is updated as you select.
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5. Press · twice to complete the formula and evaluate the formula 
and display the result.

Methods of entering data
The method you use to enter spreadsheet data depends on the type of 
data and your personal preferences. You can use different methods in 
combination.

• For simple math expressions and formulas such as =a3¦length2, press 
the corresponding keys on the handheld keypad. In this example, 
press =A3rLENGTHq.

• For text or categorical data, type the opening quote (press ") to 
distinguish a string of character data. The closing quote is added 
automatically.
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• For more complex math expressions such as  press k to 

display the Catalog of all system functions, commands, symbols, and 
expression templates.

• To display only the list of templates, press /r.

• To display only the list of symbols, press /k.

Entering a math expression, text, or spreadsheet formula
1. Select the cell in which you want to enter data. Double-click the cell 

or press · to put the cell in edit mode.

2. Use the handheld keypad, the Lists & Spreadsheet tool menu, or the 
catalog to enter the data. You will see the text or formula in the cell 
and on the entry line simultaneously. 

3. Press · to complete the entry and move down to the next cell.

– or –

Press e to complete the entry and move right to the next cell.

Lists & Spreadsheet automatically recalculates any cells that are 
dependent on the cell you entered. If you have shared the cell, and 
other TI-Nspire™ math and science learning technology applications 
are linked to the cell, the other applications are also updated.

For details on entering math expressions, refer to the Calculator section.

Working with individual cells

Creating absolute and relative cell references
Cell references let you enter formulas that refer to spreadsheet data 
instead of having to duplicate it and remember to update it. When you 
change the contents of a referenced cell, all references to the data are 
updated automatically in the spreadsheet.

Anytime you want to update all references and formula results in the 
spreadsheet, you can select Recalculate from the Actions menu.

Note: Using Recalculate from the Actions menu is also handy for 
getting new random numbers from the rand function.

1
n
---

n 1=

5

∑
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Cell formulas begin with the = symbol. You refer to a cell by using its 
column letter and row number. Entering =3*C4 as a formula, for 
example, creates an expression that is 3 * the contents of the cell at 
column C, row 4.

À Formula containing a cell reference entered in cell D4

Á Result of formula (3*12=36)

You can refer to a rectangular block of cells in a formula by entering the 
location of the upper-left cell and the lower-right cell, separated by a 
colon.

For example, =mean(B1:C5)*1. creates a result that is the mean of all cells 
in the block bounded by columns B through C and rows 1 through 5. (To 
force the results of an expression to a decimal approximation, you 
multiply by “1.” )

ÁÀ
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À Formula that refers to a rectangular block of cells

Á Result of formula

References such as C4 and C4:E11 are relative references. These 
references describe where a cell is in relation to other cells of the 
spreadsheet. Lists & Spreadsheet keeps track of relative cell references. It 
adjusts each reference automatically when you copy or move the cell 
containing the reference to another location in the spreadsheet.

If you need a reference that always refers to a cell in a specific location in 
the spreadsheet, use an absolute reference. To create an absolute cell 
reference, type a $ symbol before the column letter and row number. The 
$ symbol is available in the Symbol Palette (/k).

For example, type $C$4 to create an absolute reference to the cell in 
column C, row 4. Lists & Spreadsheet does not adjust absolute references 
in a formula when you copy or move the cell containing the reference.

Inserting items from the Catalog
You can use the Catalog to insert system functions and commands, units, 
symbols, and expression templates into a cell formula.

1. Select the cell and type “=“ to begin the formula.

2. Press k to open the Catalog.

ÁÀ
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Note: Some functions have a wizard that prompts you for each 
argument. If you prefer to enter the argument values directly in the 
cell, you may need to disable the wizard.

3. Press the number key for the category of the item. For example, 
press 1 to show the alphabetic list.

4. Press ¤ and then use ¡, ¢, £, or ¤ as necessary to select the item 
that you want to insert.

Note: To see syntax examples of the selected item, press e, and 

then press · to alternately show or hide the Help. To move back to 

the selected item, press ge.

contains all commands and functions, in alphabetical 
order

contains all math functions

provides the values for standard measurement units.

provides a symbol palette for adding special characters.

contains math templates for creating two dimensional
objects, including product, sum, square root and integral.

shows Public library (LibPub) objects.



Using Lists & Spreadsheet 171

5. Press · to insert the item into the entry line.

Deleting the contents of a cell or block of cells

1. Press ¡, ¢, £, or ¤ to select the cell. (You can also hold down the g 

key and then press ¡, ¢, £, or ¤ to select a rectangular block of 
cells.)

2. Press ..

The selected cell contents are deleted.

Note: If other cells contain formulas that refer to the cell’s previous 
contents, those cells show an error.
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Copying a cell or block of cells
When you copy cells, the formulas (if any) in the original cells are copied 
to the destination cells, replacing the previous contents of those cells.

1. Press ¡, ¢, £, or ¤ to select the cell. (You can also hold down the g 

key and then press ¡, ¢, £, or ¤ to select a rectangular block of 
cells.)

2. Press /C.

The selected cell contents are copied to the Clipboard.

3. Select the cell where you want to duplicate the copied cell. If you are 
copying a block of data, select the cell that will become the upper 
left corner of the copied block.

4. Press /V.
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Note: Paste copied data into a cell that is in the same mode as the cell 
from which the data was originally copied. Otherwise, a formula could 
paste as a string enclosed in quotes instead of a formula.

Filling adjacent cells
You can repeat a cell’s formula or value throughout adjacent cells. This 
gives you a quick way to fill cells with the same value or create a series of 
cells that contain the same formula. You can fill down within a column.

1. Select the cell whose value or formula you want to repeat.

2. Press b to display the Lists & Spreadsheet menu.

3. On the Data menu, select Fill Down.

4. Press ¤ repeatedly to move down, selecting the range of cells that 
will hold the repetitions.

5. Press ·.

The selected cell is duplicated throughout the selected range.

Notes

• In step 1, you can select more than one cell to be repeated. If you do, 
make sure that you select enough destination cells to hold the 
repeated copies.

• If you select multiple cells in step 1 and the cells contain a simple 
sequence (such as 1,2,3 or 5,10,15,20), the sequence is continued in 
the filled area.
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Sharing a cell value as a variable
You can share the value of a cell with other TI-Nspire™ applications by 
storing it as a variable. When you define or refer to a shared cell in Lists & 
Spreadsheet, the name is preceded with an apostrophe (‘).

1. Select the cell that you want to share.

2. Press /h (or press h and select Store Var).

A formula is inserted into the cell with var as a placeholder for a 
variable name.

3. Replace the letters “var” with a name for the variable, and press 
·.

The value is now available as a variable to other TI-Nspire™ math 
and science learning technology applications.

Note: If a variable with the name you specified already exists in the 
current problem, Lists & Spreadsheet displays an error message.

Linking a cell to a variable
When you link a cell to a variable, Lists & Spreadsheet keeps the cell 
value updated to reflect the current value of the variable. The variable 
can be any variable in the current problem and can be defined in Graphs 
& Geometry, Calculator, Data & Statistics, or any instance of Lists & 
Spreadsheet.

Note: Use caution if you link to a system variable. Linking could prevent 
the variable from being updated by the system. System variables include 
statistics results (such as Stat.RegEqn, Stat.dfError, and Stat.Resid) and 
finance-solver variables (such as tvm.n, tvm.pmt, and tvm.fv).

1. Select the cell that you want to link to the variable.

2. Press h.

The VarLink menu displays.

3. Under Link To, press £, and ¤ to scroll to the name of the variable.

4. Press ·.

The cell shows the value of the variable.
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Preventing name conflicts
Short TI-Nspire™ variable names can conflict with the names of 
spreadsheet cells, such as A1, or column letters, such as A. If you enter a 
name that could conflict into a spreadsheet formula, Lists & Spreadsheet 
asks for clarification.

You can use several methods to prevent conflicts in your spreadsheet 
formulas:

• Avoid creating variable names that are similar in format to cell and 
column names (such as A and A1). One method is to use variable 
names that have two or more letters, such as AC2.

• When referring to a variable whose name could conflict with the 
name of a cell (such as A1), precede the variable name with an 
apostrophe (‘A1).

• When referring to a column (such as A), follow the column letter 
with a pair of brackets (A[]) to prevent a conflict with the single-
letter variable name A. To enter the brackets, press /( and 

then press ¢.
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Examples

Note:  In certain examples, Lists & Spreadsheet may not display the 
Conflict Detected dialog box to notify you of a possible variable-name 
conflict. Also, the dialog box may appear even when you have used the 
apostrophe or brackets to prevent a conflict.

Working with rows and columns of data

Selecting a row or column

Move to the top of the column, and then press £. 
– or –
Move to the leftmost cell of the row, and then press ¡.

Resizing a row or column
1. Select the row or column that you want to resize.

2. Press b to display the Lists & Spreadsheet menu.

3. Select Actions > Resize, and then select an option:

• For a column, you can maximize, minimize, or resize the width 
manually.

• For a row, you can resize the height manually.

4. If you have chosen to resize manually, use ¡ and ¢ to resize the 

column, or use £ and ¤ to resize the row, and then press ·.

Inserting an empty row or column
1. Select the column or row where you want to insert the new data.

To refer to:
Use this 
syntax: Remarks

The shared variable 
A1.

‘A1 The apostrophe avoids a possible 
conflict with spreadsheet cell A1.

The spreadsheet cell at 
column A, row 1.

A[1] This syntax always refers to a 
spreadsheet cell, avoiding a 
possible conflict with variable A1.

Column A of the 
current spreadsheet.

A[] Brackets avoid a possible conflict 
with variable A.

The shared variable 
myvar.

myvar No special syntax needed, because 
this name does not conflict with a 
cell or column reference.
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2. Press b to display the Lists & Spreadsheet menu.

3. On the Insert menu, select either Row or Column.

– If you are inserting a row, the remaining rows shift down to 
create space for the new row.

– If you are inserting a column, the remaining columns shift right 
to create space.

Note: If other cells contain formulas with relative references to a 
displaced row or column, those references adjust accordingly.

Deleting entire rows or columns
You can delete a row, column, group of rows, or group of columns. When 
you delete a row or column, the remaining rows or columns move up or 
left to fill the gap.

1. Select the column or row that you want to delete.

2. If you are deleting more than one row or column, hold down g, 

and press ¡ and ¢ to select additional columns or press £ and ¤ to 
select additional rows.

3. Press ..

The selected rows or columns are deleted.
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Note: If other cells contain formulas that refer to the deleted row or 
column, those cells show an error. Relative references to cells whose 
positions have changed because of a deletion adjust accordingly.

Copying rows or columns
1. Select the column or row that you want to copy.

2. If you are copying more than one row or column’ press g, and 

then press £, ¤, ¡, or ¢ to select an additional item.

3. Press /C to copy the selected items.

The selected rows or columns are copied to the Clipboard.

4. Move to any cell in the row or column where you want to place the 
copied items.

5. Press /V to paste the selection.

The copied row or column is pasted in place, replacing the previous 
contents.

Note: If you copy a named column, it is pasted with the name 
removed to prevent a variable conflict.

Moving a column
1. Select the column that you want to move.
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2. Press b to display the Lists & Spreadsheet menu.

3. On the Actions menu, select Move Column. An insertion bar 
appears.

4. Press ¡ or ¢ to place the insertion bar at the column’s new position, 

and then press ·.

Note: Relative references to any cell whose position is affected by 
the move adjust accordingly.

Clearing column data
The Clear Data command lets you remove the data from selected 
columns. Clear Data does not delete the column, and it does not clear a 
column’s list name or column formula.
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After clearing the data, Lists & Spreadsheet recalculates column formulas 
for the selected columns. This makes Clear Data useful for capturing a 
fresh set of data from another application or selectively generating a 
fresh column of random numbers.

1. Select the column or columns that you want to clear.

In this example, columns A through E have been selected.

2. Press b to display the Lists & Spreadsheet menu.

3. On the Data menu, select Clear Data.
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Note: If a recalculated formula produces the same data as before, as 
in column D of this example, it may appear that the Clear Data 
command has failed.

Sorting data
You can sort a selected area of the spreadsheet in ascending or 
descending order. You select which column in the selected area will be 
used as the key for the sort. When the sort moves data up or down in the 
key column, the corresponding data in the other selected columns is also 
moved up or down. This preserves the integrity of each row.

Note: Sorting is based on numeric values. If you select a key column that 
contains text, you could get unexpected results.

Sorting a range of cells in a column
1. Select the range of cells.
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2. Press b to display the Lists & Spreadsheet menu.

3. On the Actions menu, select Sort.

4. Select Descending as the sort method for this example, and then 
select OK.
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Sorting a rectangular region
1. Select the region of cells.

2. Press b to display the Lists & Spreadsheet menu.

3. On the Actions menu, select Sort to display the Sort dialog box.

4. Select column a as the column on which the sort will be based for 
this example. You can select from columns within the selected region 
only.



184 Using Lists & Spreadsheet

5. Select Descending as the sort method for this example, and then 
select OK.

Sorting entire columns
1. Select the range of columns to sort.
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2. Press b to display the Lists & Spreadsheet menu.

3. On the Actions menu, select Sort.

4. Select column a as the column on which the sort will be based for 
this example.

5. Select Descending as the sort method for this example, and then 
select OK.

Generating columns of data
You can create a column of values based on another column. You can 
also create a column based on any of several types of sequential data.
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Entering a formula in the header row of the column tells the Lists & 
Spreadsheet application that you want to apply the formula to all the 
cells in the column, not just to a single cell.

À Column formula based on a variable

Á Column formula based on another column

Â Column formula that generates a sequence

Notes

• If you generate data in a column that already contains one or more 
cell values, Lists & Spreadsheet asks for confirmation before replacing 
the existing values. Proceeding removes all of the existing values in 
the column.

• If you edit a cell manually in a column of generated data, Lists & 
Spreadsheet asks for confirmation before replacing the generated 
data. Proceeding removes the generated data for the entire column.

Creating column values based on another column
1. Select the header cell (second cell from the top) of the column where 

you want to enter a column formula.

2. Type = (press =) followed by the expression, and then press ·. Use 
brackets ([]) after any column letter you include in the formula. For 
example, type =A[]^2 (press =A/(¢l2) to create a 
column of values in which each cell is the square of the 
corresponding cell of column A.

À Á Â
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Lists & Spreadsheet shows the formula in the header cell and fills the 
column with the results.

Generating a list of random numbers
1. Select the header of the column in which you want to generate the 

list of random numbers.

2. Press = and then type the expression for generating the random 
numbers. You can use the catalog to insert an expression instead of 
typing characters.

RandInt(1,6,20)

This example places 20 random integers in the column. 

3. Generate (Recalculate) a new set of random numbers:

• Press /R.

Generating a numerical sequence
1. Select any cell in the column in which you want to generate the 

sequence.

2. Press b to display the Lists & Spreadsheet menu.

3. On the Data menu, select Generate Sequence.

Lists & Spreadsheet displays a dialog for defining the sequence.

4. Type the formula that will be applied to the column values to 
generate the sequence. Type any starting numbers required by the 
sequence. u0 is the first number in the sequence, u1 is the second, 
and u2 is the third.
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5. Type a maximum value for the sequence, if you want to specify a 
maximum.

6. Type a maximum number of values to be generated, if you want to 
specify a maximum.

7. Select OK.

Lists & Spreadsheet shows the formula in the header cell and fills the 
column with the results.

Note: If you prefer, you can enter a formula for the sequence directly 
into the header cell of the column.

For example, enter =seqn(u(n-1)+u(n-2),{2,5},7,100) to generate a 
Fibonacci series that uses 2 and 5 as the first two numbers. This sequence 
stops at a maximum value of 100 or a maximum of 7 values, whichever 
occurs first.
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8. Type the formula in the header cell, and then press ·. For example, 
enter =seqn(u(n-1)+u(n-2){2,5}) to use 2 and 5 as the first two 
numbers.

Creating and sharing spreadsheet data as lists
You can define a column as a named list of elements of the same type of 
data. After defining a list, you can link to it from Graphs & Geometry, 
Calculator, Data & Statistics, and other instances of Lists & Spreadsheet 
within the current problem.

Note: Lists & Spreadsheet can display a maximum of 2500 elements in a 
list.

Sharing a spreadsheet column as a list variable
You share a column of data by naming it as a list variable. 

Note: Avoid defining variables that use the same names as those used 
for statistical analysis. In some cases, an error condition could occur.

Variable names used for statistical analysis are listed in the TI-Nspire 
Reference Guide, under the stat.results entry.

Method 1

1. Press £ as necessary to select the name cell (the white cell at the top) 
of the column that you want to share.
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2. Type a name for the shared list. for example, type width.

3. Press ·.

Method 2

1. Press £ as necessary to select the header cell (the second cell from 
the top) of the column that you want to share.

2. Press h, and select Store Var.

An expression is inserted into the formula cell with var as a 
placeholder for the list name.
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3. Replace the letters “var” with a name for the shared list. For 
example, type width. 

The header cell now contains an expression similar to width:=.

4. Add the formula at the end of the expression. For example, 
width:=E[]*3.

5. Press ·.

The column is now available as a list variable to other TI-Nspire™ 
applications.

Notes:

• If a variable with the name you specified already exists in the current 
problem, Lists & Spreadsheet displays an error message.
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• Because a list cannot contain empty elements, any empty cells are 
automatically given a value of zero.

You can refer to a specific element in a named list from the Calculator 
application. Use the list name and the element’s position within the list. 
In a list named Heights, for example, refer to the first element as 
Heights[1]. The expression Heights[2] refers to the second element, and 
so on.

Linking to an existing list variable
Linking a Lists & Spreadsheet column to an existing list variable lets you 
easily view and edit the values in the list. The list can be any shared list in 
the current problem and can be defined in Graphs & Geometry, 
Calculator, or any instance of Lists & Spreadsheet.

After you link a column to a list, Lists & Spreadsheet automatically shows 
any changes that you make to the list with other TI-Nspire™ CAS 
applications.

1. Press £ as necessary to select the header cell (the second cell from 
the top) of the column that you want to link to the variable.

2. Press h, and select Store Var.

3. Type = followed by an apostrophe and the name of the list. 
For example, type =’width.

Note: Use caution if you link to a system variable. Doing so could prevent 
the variable from being updated by the system. System variables include 
ans and statistics results (such as stat.results, stat.RegEqn, and stat.Resid).

4. Press ·.

The column shows the list elements.

Inserting an element in a list
When you insert an element in a list, the remaining elements shift 
downward to create space. For example, if you insert an element at 
position L1[2], the element that was previously L1[2] shifts down to 
become L1[3], and so on to the end of the list.

The downward shift affects only the column defined as a list. No other 
columns are affected.

1. Press b to display the Lists & Spreadsheet menu.

2. On the Insert menu, select Insert Cell.
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Deleting an element from a list
When you delete an element, the remaining list elements shift upward to 
close the gap. For Example, if you delete element L1[3], the element that 
was previously L1[4] shifts up to become L1[3], and so forth to the end of 
the list.

The upward shift affects only the selected column.

1. Select the cell that you want to delete.

2. Display the context menu for the cell:

• Press /b.

3. Select Delete Cell.

Note: If you press . to clear the contents of the cell instead of 
deleting the list element, the element is assigned a value of 0 (zero). The 
remaining list elements do not shift.

Graphing spreadsheet data
You can easily create a dot plot of the data in one column or a scatter 
plot of two adjacent columns by using the Quick Graph feature. This 
feature displays the graphed data using the Data & Statistics application.

To create a scatter plot:

1. Name both of the two columns to declare them as lists.

2. Select both columns.
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3. Press b to display the Lists & Spreadsheet menu.

4. On the Data menu, select Quick Graph.

A Data & Statistics work space is added to the page and shows the 
plotted data. The leftmost of the two lists is plotted on the x axis, 
and the other list is plotted on the y axis.

5. (Optional) Use the Data & Statistics features to analyze or visually 
enhance the graph.

Note: Refer to Using Data and Statistics for information about 
analyzing and exploring graphs.
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Capturing data from Graphs & Geometry
You can use Lists & Spreadsheet to capture information about objects 
from Graphs & Geometry. For example, you might want to track changes 
in the area of a triangle as you change the length of a side.

You can select manual or automatic capture:

• With manual capture, you trigger the capture of each data element 
by pressing the following key combination.

/^

• With automatic capture, the capture of each data value is triggered 
automatically when you move or animate the target in Graphs & 
Geometry.

Capturing data manually
1. Select any cell in the column in which you want to capture the 

values.

Note: Captured values will replace values in the column.

2. Press b to display the Lists & Spreadsheet menu.

3. On the Data menu, select Data Capture, and then select Manual 
Data Capture.

A capture expression is inserted into the header cell with var as a 
placeholder for the name of the variable you are capturing.
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4. Replace the letters “var” with the name of the variable to capture 
from Graphs & Geometry. For example, type area.

The header cell now contains an expression similar to 
=capture(area,0).

Note: The argument “0” tells Lists & Spreadsheet that you want to 
trigger each capture manually.

5. Press ·.

6. Using Graphs & Geometry, change the object whose attribute (area 
in this example) you are capturing.

7. Each time you are ready to capture the current value of area:

• Press /^.
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The current area value is added to the end of the list as a list 
element.

Capturing data automatically
1. Select any cell in the column in which you want to capture the 

values.

Note: Captured values will replace values in the column.

2. Press b to display the Lists & Spreadsheet menu.

3. On the Data menu, select Data Capture, and then select Automated 
Data Capture.

A capture expression is inserted into the header cell with var as a 
placeholder for the name of the variable you are capturing.

4. Replace the letters “var” with the name of the variable to capture. 
For example, type objpathX. Alternatively, you can select the variable 
name from the Variables menu.

The header cell now contains an expression similar to 
=capture(‘objpathX,1).
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Note: The argument “1” tells Lists & Spreadsheet that you want the 
captures to be triggered by the variable change.

5. Press ·.

6. When you are ready to begin capturing the values of objpathX,begin 
moving the object or start the animation that affects it in Graphs & 
Geometry.

Each captured value is added to the end of the list in Lists & 
Spreadsheet as a list element.

Creating function tables
The Lists & Spreadsheet application lets you create a table of function 
values for any defined function in the current problem. You can set the 
parameters for the table and even edit a function definition without 
leaving Lists & Spreadsheet.
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Showing and Hiding function tables
Anytime Lists & Spreadsheet is the active application, you can alternate 
between the standard Lists & Spreadsheet view and the function table 
view.

Press /T to toggle the view.
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À Lists & Spreadsheet view

Á Function table view

Generating a function table
1. Make sure you have defined at least one function in Graphs & 

Geometry, Calculator, or Data & Statistics. Refer to Using Graphs & 
Geometry for more information.

2. Toggle to the function table view:

• In Lists & Spreadsheet, press /T.

The function table view appears with a small box listing available 
functions.

Á

À
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Note: If a previous function is displayed, press ¢ to move to an 
empty column.

3. Select the function for which you want to create a table.

By default, the table is generated using a start value of 0, a step 
value of 1, and the automatic setting for the independent and 
dependent variables.

Adding a function table from Graphs & Geometry
Adding a function table from Graphs & Geometry automatically creates 
an instance of Lists & Spreadsheet if none already exists on the current 
page. It also shows the function table view and automatically generates a 
table for the active Graphs & Geometry functions.

1. In Graphs & Geometry, select the functions for which you want to 
create a table.
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2. Press b to display the Graphs & Geometry menu.

3. On the View menu, select Add Function Table.

Viewing values in a function table

Press £ or ¤ to view the values in the table.

As you move through the table, Lists & Spreadsheet generates the 
function values based on the independent variable (shown in the 
leftmost column). Scrolling upward from 0 displays negative values 
of the independent variable.
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Editing a function
Besides using the other applications, such as Calculator and Graphs & 
Geometry, you can edit a function definition in the function table. 
Changes that you make are reflected in the other applications 
automatically.

1. Press e as necessary to highlight the top area of the function 

tables, press ·, use ¡, ¢, £, and ¤ to highlight the function’s 

expression, and then press ·.

2. A cursor appears in the expression.

3. Edit the expression, and then press ·.

4. The table for the function is updated, and the Graphs & Geometry 
graph of the function is also updated.

Changing the settings for a function table
Each function table uses initial settings that make it easy to scroll 
through values. If you prefer, you can set the Table Start and Table Step 
values manually, and you can choose to enter values manually for the 
independent and/or dependent variable.

1. Press b to display the Graphs & Geometry menu.

2. On the Function Table menu, select Edit Function Table Settings.

3. Press e to move among the settings, and either type a value or 

press £ or ¤ to change a setting.

If you select Ask instead of Auto for a variable, you can enter a value 
manually when you select a cell. Auto populates the table starting at 
table start and displays an independent and dependent value for 
each step.
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Deleting a column in the function table

1. Press e as necessary to highlight the top area of the function 

tables, press ·, use ¡ and ¢ to highlight the top cell of the column.

2. Press ..

Using table data for statistical analysis
Lists & Spreadsheet uses wizards to help you perform statistical analyses 
on data in table columns. You specify the location of the data, and Lists & 
Spreadsheet stores the results in two columns: one for the result names, 
and one for the corresponding values.

Plotting statistical data
Some of the statistics wizards display a Draw check box. By default, the 
box is not checked. Checking the box creates a Data & Statistics work 
area on the page and plots the results in that work area.

Note: The check box is displayed only if you select a header cell (second 
cell from the top) before beginning the analysis. 

Draw check box in the Normal 
PDF wizard.
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Statistical calculations

Performing a statistical calculation
Suppose you want to fit a y=mx+b linear regression model to the 
following two lists:
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1. Select the header/formula cell (second cell from the top) in column 
A.

2. Press b to display the Lists & Spreadsheet menu.

3. On the Statistics menu, select Stat Calculation, and select Linear 
Regression (mx+b) to choose the regression model.

A wizard opens, giving you a labeled box to type each argument. 
Because you selected a cell in advance, the column for X List is 
already filled in.

4. Press e to move to the Y List box, or click the drop-down arrow to 
select a named list.

5. Type b[] to specify the values in column B as Y List.

6. If you want to store the regression equation in a specified variable, 
press e, and then replace Save RegEqn To with the name of the 
variable.

7. Press e as necessary to move to the 1st Result box.

8. Type c[] as the column letter for the first result column.
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9. Select OK.

Lists & Spreadsheet inserts two columns: one containing the names 
of the results, and one containing the corresponding values.

Note: The results are linked to the source data. For example, you can 
change a value in column A, and the regression equation is updated 
automatically.

When a system variable is used for statistical results, Lists & Spreadsheet 
uses a standard statistical variable name that it automatically increments 
for each calculation. You can access statistical analysis results stored in 
variables from other TI-Nspire™ applications by using the Var menu. 
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Lists & Spreadsheet stores statistical results using a variable-group name 
with the format stat.nnn, where nnn is the result name (for example, 
stat.RegEqn and stat.Resid). The use of standard names for variables 
makes it easier to identify and use the statistical variables later. You can 
edit the formula in the header cell if you want to use a custom variable 
group instead of the standard name.

You could use the following formula to store the results in the variable 
group MystatsB.

=LinRegMx(a[],b[],1 ): CopyVar Stat., MystatsB.

Later, you could view the results by entering the following expression 
in the Calculator application or in another column of the 
Lists & Spreadsheet application:

MystatsB.results

Note: If you specify a custom variable name, be sure to make a note of it. 
This prevents unexpected operation when you need to refer to the name 
later.

Supported Statistical Calculations
The Stat Calculations menu lets you select from the calculations 
described below. For a complete description of inputs and outputs, refer 
to the TI-Nspire Reference Guide details for the function name that is in 
parentheses.

One-Variable Statistics (OneVar)
The One-Variable Statistics calculation analyzes data with one measured 
variable. The statistical data returned for a data set using this analysis 
technique are:

• sample mean, 

• sum of the data, 

• sum of the squared data, 

• sample standard deviation, s

• population standard deviation, s

• sample size, n

• X-min

• first quartile, Q1

• median

x

Σx

Σx2

x

x
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• third quartile, Q3

• X-max

• sum of squared deviations, SSx = 

Each element in freqlist is the frequency of occurrence for each 
corresponding data point in Xlistname. freqlist elements must be 
integers > 0.

Two-Variable Statistics (TwoVar)
The Two-Variable Statistics calculation analyzes paired data. List 1 is the 
independent variable. List 2 is the dependent variable. The statistical 
data returned for the data sets using this analysis technique are:

For each list:

• sample mean,  or 

• sum of the data,  or 

• sum of the squared data,  or 

• sample standard deviation, sx = sn-1x or sy = sn-1y

• population standard deviation, sx = snx or sy = sny

• X-min or Y-min

• first quartile, Q1X or Q1Y

• median

• third quartile, Q3X or Q3Y

• X-max or Y-max

• sum of squared deviations, SSx =  or SSy = 

Additional data:

• sample size for each data set, n

•

• correlation coefficient, r

Each element in freqlist is the frequency of occurrence for each data pair 
(List1,List2).

Linear Regression (mx+b) (LinRegMx)
The Linear Regression (mx+b) fits the model equation y=ax+b to the data 
using a least-squares fit. It displays values for m (slope) and b (y-intercept).

Σ x x–( )2

x y

Σx Σy

Σx2 Σy2

Σ x x–( )2 Σ y y–( )2

Σxy
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Linear Regression (a+bx) (LinRegBx)
The Linear Regression (a+bx) fits the model equation y=a+bx to the data 

using a least-squares fit. It displays values for a (y-intercept), b (slope), r2, 
and r.

Median-Median Line Regression (MedMed)
The Median-Median Line regression fits the model equation y=ax+b to 
the data using the median-median line (resistant line) technique, 
calculating the summary points x1, y1, x2, y2, x3, and y3. Median-Median 
Line displays values for a (slope) and b (y-intercept).

Quadratic Regression (QuadReg)
The QuadReg (quadratic regression) fits the second-degree polynomial 

y=ax2+bx+c to the data. It displays values for a, b, c, and R2. For three 
data points, the equation is a polynomial fit; for four or more, it is a 
polynomial regression. At least three data points are required.

Cubic Regression (CubicReg)
The CubicRegregression fits the third-degree polynomial 

y=ax3+bx2+cx+d to the data. It displays values for a, b, c, d, and R2. For 
four points, the equation is a polynomial fit; for five or more, it is a 
polynomial regression. At least four points are required.

Quartic Regression (QuartReg)
The Quartic Regression fits the fourth-degree polynomial 

y=ax4+bx3+cx2+dx+e to the data. It displays values for a, b, c, d, e, and 

R2. For five points, the equation is a polynomial fit; for six or more, it is a 
polynomial regression. At least five points are required.

Power Regression (PwrReg)

The Power Regression fits the model equation y=axb to the data using a 
least-squares fit and transformed values ln(x) and ln(y). It displays values 

for a, b, r2, and r.

Exponential Regression (ExpReg)

The Exponential Regression fits the model equation y=abx to the data 
using a least-squares fit and transformed values x and ln(y). It displays 

values for a, b, r2, and r.

Logarithmic Regression (LogReg)
The Logarithmic Regression fits the model equation y=a+b ln(x) to the 
data using a least-squares fit and transformed values ln(x) and y. It 

displays values for a, b, r2, and r. 
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Sinusoidal Regression (SinReg)
The Sinusoidal Regression fits the model equation y=a sin(bx+c)+d to 
the data using an iterative least-squares fit. It displays values for a, b, c, 
and d. At least four data points are required. At least two data points per 
cycle are required in order to avoid aliased frequency estimates.

Note: The output of SinReg is always in radians, regardless of the 
Radian/Degree mode setting. 

Logistic Regression (d=0) (Logistic)

The Logistic Regression (d=0) fits the model equation y=c/(1+a…eLbx) to 
the data using an iterative least-squares fit. It displays values for a, b, and c.

Logistic Regression (dƒ0) (LogisticD)

The Logistic (dƒ0) regression fits the model equation y=c/(1+a…e(Lbx))+d 
to the data using an iterative least-squares fit. It displays values for a, b, c 
and d.

Multiple Linear Regression (MultReg)
The Multiple Linear Regression calculates multiple linear regression of 
list Y on lists X1, X2, …, X10.

Note: There is no draw option for multiple linear regression.
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Distributions
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Calculating distributions
Suppose you want to fit the Normal Pdf distribution model to the 
following two lists: 

1. Select the header/formula cell (second cell from the top) in column 
A. 

2. On the Statistics menu, select Distributions, and select Normal Pdf 
to choose the Distribution model. 

A wizard opens, giving you a labeled box to type each argument. 
You can type values, or select them from the drop down selection 
list. 

3. Press e as necessary to complete each argument. 
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4. Click the Draw check box to see the distribution plotted in Data & 
Statistics. 

Note: The Draw option is not available for all distributions.

5. Select OK. 

Lists & Spreadsheet inserts two columns: one containing the names 
of the results, and one containing the corresponding values. The 
results are plotted in Data & Statistics. 

Note: The results are linked to the source data. For example, you can 
change a value in Column A, and the equation updates automatically. 

Supported Distribution functions
You can include distribution functions in cells using the same method for 
entering characters, or include a distribution in a formula cell. When you 
specify a distribution function in a formula cell, you are required to 
specify a list (column) that contains the x-values. For each x-value in the 
list, the distribution returns a corresponding result. 

Note: For distribution functions that support the draw option (normPDF, 

t PDF, cccc2 Pdf, and Ü Pdf), the option is available only if you enter the 
distribution function in a formula cell.
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The following distributions are available from the Lists & Spreadsheet 
application. For complete information regarding these functions, refer to 
the TI-Nspire Reference Guide details for the function name that is in 
parentheses.

Normal Pdf (normPdf)
Normal Pdf computes the probability density function (pdf) for the 
normal distribution at a specified x value. The defaults are mean m=0 and 
standard deviation s=1. The probability density function (pdf) is:

This distribution is used to determine the probability of the occurrence of 
a certain value in a normal distribution. The draw option is available 
when Normal PDF is invoked from a formula cell.

When you access distributions from the formula cell, you must select a 
valid list from the pull-down to avoid unexpected results. If accessed 
from a formula cell, you must specify a number for the x-value. The 
distribution returns the probability that the value you specify will occur.

Normal Cdf (normCdf)
Normal Cdf computes the normal distribution probability between 
lowBound and upBound for the specified mean, m (default=0) and the 
standard deviation, s (default=1).

This distribution is useful in determining the probability of an occurrence 
of any value between the lower and upper bounds in the normal 
distribution. It is equivalent to finding the area under the specified 
normal curve between the bounds.

Inverse Normal (invNorm)
Inverse Normal computes the inverse cumulative normal distribution 
function for a given area under the normal distribution curve specified by 
mean, m, and standard deviation, s. 

This distribution is useful in determining the x-value of data in the area 
from 0 to x<1 when the percentile is known.

t Pdf() (tPdf())
t Pdf computes the probability density function (pdf) for the 
t-distribution at a specified x value. df (degrees of freedom) must be > 0. 
The probability density function (pdf) is:

f x( ) 1
2πσ
--------------e

x μ–( )2

2σ2
-------------------–

–

σ 0>,=
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This distribution is useful in determining the probability of the 
occurrence of a value when the population standard deviation is not 
known and the sample size is small. The draw option is available when t 
Pdf is invoked from a formula cell.

t Cdf (tCdf())
t Cdf computes the Student-t distribution probability between lowBound 
and upBound for the specified df (degrees of freedom).

This distribution is useful in determining the probability of the 
occurrence of a value within an interval defined by the lower and upper 
bound for a normally distributed population when the population 
standard deviation is not known.

Inverse t (invt())
Inverse t computes the inverse cumulative t-distribution probability 
function specified by Degrees of Freedom, df, for a given area under the 
curve.

This distribution is useful in determining the probability of an occurrence 
of data in the area from 0 to x<1. This function is used when the 
population mean and/or population standard deviation is not known.

c2 Pdf 

c2 Pdf computes the probability density function (pdf) for the c2 
(chi-square) distribution at a specified x value. df (degrees of freedom) 
must be an integer > 0. The probability density function (pdf) is:

This distribution is useful in determining the probability of the 

occurrence of a given value from a population with a c2 distribution. The 

draw option is available when c2 Pdf is invoked from a formula cell.

c2 Cdf 

c2 Cdf computes the c2 (chi-square) distribution probability between 
lowBound and upBound for the specified df (degrees of freedom).

This distribution is useful in determining the probability of the 

occurrence of value within given boundaries of a population with a c2 

distribution.

f x( ) Γ df 1+( )/2[ ]
Γ df 2⁄( )

---------------------------------= 1 x2/df+( )
df 1+( )/2–

πdf
----------------------------------------------

f x( ) 1
Γ df 2⁄( )
-------------------- 1/2( )df/2xdf 2 1–⁄ e x/2– x 0≥,=
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Û Pdf 
Ü Pdf computes the probability density function (pdf) for the Ü 
distribution at a specified x value. numerator df (degrees of freedom) and 
denominator df must be integers > 0. The probability density function 
(pdf) is:

This distribution is useful in determining the probability that two 
samples have the same variance. Ü Pdf The draw option is available when 
Ü Pdf is invoked from a formula cell.

Û Cdf 
Ü Cdf computes the Ü distribution probability between lowBound and 
upBound for the specified dfnumer (degrees of freedom) and dfDenom.

This distribution is useful in determining the probability that a single 
observation falls within the range between the lower bound and upper 
bound.

Binomial Pdf (binomPdf())
Binomial Pdf computes a probability at x for the discrete binomial 
distribution with the specified numtrials and probability of success (p) on 
each trial. x can be an integer or a list of integers. 0p1 must be true. 
numtrials must be an integer > 0. If you do not specify x, a list of 
probabilities from 0 to numtrials is returned. The probability density 
function (pdf) is:

where n = numtrials

This distribution is useful in determining the probability of success in a 
success/failure trial, at trial n. For example, you could use this distribution 
to predict the probability of getting heads in a coin toss on the 5th toss.

Binomial Cdf (binomCdf())
Binomial Cdf computes a cumulative probability for the discrete 
binomial distribution with n number of trials and probability p of success 
on each trial.

where n = numerator degrees of freedom
d = denominator degrees of freedom

f x( ) Γ n d+( )/2[ ]
Γ n/2( )Γ d/2( )
---------------------------------- n

d
---⎝ ⎠
⎛ ⎞ n/2

xn/2 1– 1 nx/d+( ) n d+( )/2– x 0≥,=

f x( ) n
x⎝ ⎠
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This distribution is useful in determining the probability of a success on 
one trial before all trials are completed. For example, if heads is a 
successful coin toss and you plan to toss the coin 10 times, this 
distribution would predict the chance of obtaining heads at least once in 
the 10 tosses.

Poisson Pdf (poissPdf())
Poisson Pdf computes a probability at x for the discrete Poisson 
distribution with the specified mean, m, which must be a real number > 0. 
x can be an integer or a list of integers. The probability density function 
(pdf) is: 

This distribution is useful in determining the probability of obtaining a 
certain number of successes before a trial begins. For example, you could 
use this calculation to predict the number of heads that would occur in 
eight tosses of a coin.

poissoncdf (poissCdf())
poissoncdf computes a cumulative probability for the discrete Poisson 
distribution with specified mean, l.

This distribution is useful in determining the probability that a certain 
number of successes occur between the upper and lower bounds of a 
trial. For example, you could use this calculation to predict the number of 
heads displayed between coin toss #3 and toss #8.

geometpdf (geomPdf())
geometpdf (computes a probability at x, the number of the trial on 
which the first success occurs, for the discrete geometric distribution with 
the specified probability of success p. 0p1 must be true. x can be an 
integer or a list of integers. The probability density function (pdf) is:

This distribution is useful in determining the likeliest number of trials 
before a success is obtained. For example, you could use this calculation 
to predict the number of coin tosses that would be made before a heads 
resulted.

geometcdf (geomCdf())
geometcdf computes a cumulative geometric probability from 
lowBound to upBound with the specified probability of success, p.

f x( ) e μ– μx x!⁄ x, 0,1,2,...= =

f x( ) p 1 p–( )x 1– x, 1,2,...= =
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This distribution is useful in determining the probability associated with 
the first success occurring during trials 1 through n. For example, you 
could use this calculation to determine the probability that heads display 
on toss #1, #2, #3, ..., #n.
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Confidence Intervals

Supported Confidence Intervals
The following confidence intervals are available from the Lists & 
Spreadsheets application. For complete information regarding these 
functions, refer to the TI-Nspire Reference Guide details for the function 
name that is in parentheses.

z Interval (zInterval)
z Interval (one-sample z confidence interval) computes a confidence 
interval for an unknown population mean, m, when the population 
standard deviation, s, is known. The computed confidence interval 
depends on the user-specified confidence level.

This test is useful in determining how far from a population mean a 
sample mean can get before indicating a significant deviation.

t Interval (tInterval)
t Interval (one-sample t confidence interval) computes a confidence 
interval for an unknown population mean, m, when the population 
standard deviation, s, is unknown. The computed confidence interval 
depends on the user-specified confidence level.
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This test is useful in examining whether the confidence interval 
associated with a confidence level contains the value assumed in the 
hypothesis. Like the z Interval, this test helps you determine how far 
from a population mean a sample mean can get before indicating a 
significant deviation when the population mean is unknown.

2-Sample z Interval (zInterval_2Samp)
2-Sample z Interval (two-sample z confidence interval) computes a 
confidence interval for the difference between two population means 
(m1Nm2) when both population standard deviations (s1 and s2) are 
known. The computed confidence interval depends on the user-specified 
confidence level.

This test is useful in determining if there is statistical significance 
between the means of two samples from the same population. For 
example, this test could determine whether there is significance between 
the mean SAT score of female students and the mean of SAT score of 
male students at the same school.

2-Sample t Interval (tInterval_2Samp)
2-Sample t Interval (two-sample t confidence interval) computes a 
confidence interval for the difference between two population means 
(m1Nm2) when both population standard deviations (s1 and s2) are 
unknown. The computed confidence interval depends on the user-
specified confidence level.

This test useful in determining if there is statistical significance between 
the means of two samples from the same population. It is used instead of 
the 2-sample z confidence interval in situations where the population is 
too large to measure in order to determine the standard deviation.

1-Prop z Interval (zInterval_1Prop)
1-Prop z Interval (one-proportion z confidence interval) computes a 
confidence interval for an unknown proportion of successes. It takes as 
input the count of successes in the sample x and the count of 
observations in the sample n. The computed confidence interval depends 
on the user-specified confidence level.

This test is useful in determining the probability of a given number of 
successes that can be expected for a given number of trials. For instance, 
casino examiners would use this test to determine if observed payouts for 
one slot machine demonstrate a consistent pay out rate.
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2-Prop z Interval (zInterval_2Prop)
2-Prop z Interval (two-proportion z confidence interval) computes a 
confidence interval for the difference between the proportion of 
successes in two populations (p1-p2). It takes as input the count of 
successes in each sample (x1 and x2) and the count of observations in each 
sample (n1 and n2). The computed confidence interval depends on the 
user-specified confidence level.

This test is useful in determining if two rates of success differ because of 
something other than sampling error and standard deviation. For 
example, a bettor could use this test to determine if there is an 
advantage in the long run by playing one game or machine versus 
playing another game or machine.

Linear Reg t Intervals (LinRegtIntervals)
Linear Reg t Intervals computes a linear regression t confidence interval 
for the slope coefficient b. If the confidence interval contains 0, this is 
insufficient evidence to indicate that the data exhibits a linear 
relationship.

Multiple Reg Intervals (MultRegIntervals)
Computes multiple regression prediction confidence interval for the 
calculated y and a confidence for y.
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Stat tests

Supported Statistical tests
The following hypothesis tests are available from the Lists & 
Spreadsheets application. For complete information regarding these 
functions, refer to the TI-Nspire Reference Guide details for the function 
name that is in parentheses.

Some of the wizards for Stat Tests display a Draw check box. By default, 
the box is not checked. Checking the box creates a Data & Statistics work 
area on the page and plots the results in that work area.

Z-test (zTest)
Z-Test (one-sample z test) performs a hypothesis test for a single 
unknown population mean, m, when the population standard 
deviation, s, is known. It tests the null hypothesis H0: m=m0 against one of 
the alternatives below.

• Ha: mƒm0 (m:ƒm0)

• Ha: m<m0 (m:<m0)
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• Ha: m>m0 (m:>m0)

This test is used for large populations that are normally distributed. The 
standard deviation must be known. 

This test is useful in determining if the difference between a sample 
mean and a population mean is statistically significant when you know 
the true deviation for a population.

t-test (tTest)
t-Test (one-sample t test) performs a hypothesis test for a single unknown 
population mean, m, when the population standard deviation, s, is 
unknown. It tests the null hypothesis H0: m=m0 against one of the 
alternatives below.

• Ha: mƒm0 (m:ƒm0)

• Ha: m<m0 (m:<m0)

• Ha: m>m0 (m:>m0)

This test is similar to a z-test, but is used when the population is small and 
normally distributed. This test is used more frequently than is the z-test 
because small sample populations are more frequently encountered in 
statistics than are large populations. 

This test is useful in determining if two normally distributed populations 
have equal means, or when you need to determine if a sample mean 
differs from a population mean significantly and the population 
standard deviation is unknown.

2-SampZTest (zTest_2Samp)
2-SampZTest (two-sample z test) tests the equality of the means of two 
populations (m1 and m2) based on independent samples when both 
population standard deviations (s1 and s2) are known. The null 
hypothesis H0: m1=m2 is tested against one of the alternatives below.

• Ha: m1ƒm2 (m1:ƒm2)

• Ha: m1<m2 (m1:<m2)

• Ha: m1>m2 (m1:>m2)

2-SamptTest (tTest_2Samp)
2-SamptTest (two-sample t test) tests the equality of the means of two 
populations (m1 and m2) based on independent samples when neither 
population standard deviation (s1 or s2) is known. The null hypothesis 
H0: m1=m2 is tested against one of the alternatives below.
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• Ha: m1ƒm2 (m1:ƒm2)

• Ha: m1<m2 (m1:<m2)

• Ha: m1>m2 (m1:>m2)

1-PropZTest (zTest_1Prop)
1-PropZTest (one-proportion z test) computes a test for an unknown 
proportion of successes (prop). It takes as input the count of successes in 
the sample x and the count of observations in the sample n. 1-PropZTest 
tests the null hypothesis H0: prop=p0 against one of the alternatives 
below.

• Ha: propƒp0 (prop:ƒp0)

• Ha: prop<p0 (prop:<p0)

• Ha: prop>p0 (prop:>p0)

This test is useful in determining if the probability of the success seen in a 
sample is significantly different from the probability of the population or 
if it is due to sampling error, deviation, or other factors.

2-PropZTest (zTest_2Prop)
2-PropZTest (two-proportion z test) computes a test to compare the 
proportion of successes (p1 and p2) from two populations. It takes as 
input the count of successes in each sample (x1 and x2) and the count of 
observations in each sample (n1 and n2). 2-PropZTest tests the null 
hypothesis H0: p1=p2 (using the pooled sample proportion Ç) against one 
of the alternatives below.

• Ha: p1ƒp2 (p1:ƒp2)

• Ha: p1<p2 (p1:<p2)

• Ha: p1>p2 (p1:>p2)

This test is useful in determining if the probability of success seen in two 
samples is equal.

c2GOF-Test 

c2GOF-Test (Chi Square Goodness of Fit) performs a test to confirm that 
sample data is from a population that conforms to a specified 

distribution. For example, c2 GOF can confirm that the sample data came 
from a normal distribution.
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c2-Test

c2-Test (chi-square test) computes a chi-square test for association on the 
two-way table of counts in the specified Observed matrix. The null 
hypothesis H0 for a two-way table is: no association exists between row 

variables and column variables. The alternative hypothesis is: the 
variables are related.

2-SampÛTest
2-SampÜTest (two-sample Ü-test) computes an Ü-test to compare two 
normal population standard deviations (s1 and s2). The population 
means and standard deviations are all unknown. 2-SampÜTest, which 

uses the ratio of sample variances Sx12/Sx22, tests the null hypothesis 
H0: s1=s2 against one of the alternatives below.

• Ha: s1ƒs2 (s1:ƒs2)

• Ha: s1<s2 (s1:<s2)

• Ha: s1>s2 (s1:>s2)

Below is the definition for the 2-SampÜTest.

2-SampÜTest for the alternative hypothesis .

Sx1, Sx2 = Sample standard deviations having  

and  degrees of freedom df, 
respectively.

F = F-statistic  =  

df(x, , ) = Fpdf( ) with degrees of freedom df, , 

and 

p = reported p value
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2-SampÜTest for the alternative hypothesis .

2-SampÜTest for the alternative hypothesis s1 ƒ s2. Limits must satisfy 
the following:

where: [Lbnd,Ubnd] = lower and upper limits

The Ü-statistic is used as the bound producing the smallest integral. The 
remaining bound is selected to achieve the preceding integral’s equality 
relationship.

LinRegTTest

LinRegTTest (linear regression t test) computes a linear regression on the 
given data and a t test on the value of slope b and the correlation 
coefficient r for the equation y=a+bx. It tests the null hypothesis H0: b=0 
(equivalently, r=0) against one of the alternatives below.

• Ha: bƒ0 and rƒ0 (b & r:Äƒ0)

• Ha: b<0 and r<0 (b & r:<0)

• Ha: b>0 and r>0 (b & r:>0)

Multiple Reg Tests (MultRegTest)
Multiple linear regression t test computes a linear regression on the 
given data, and provides the F test statistic for linearity. 

Refer to the TI-Nspire Reference Guide for information about 
MultRegTests.

ANOVA
ANOVA (one-way ANalysis Of VAriance) computes a one-way analysis of 
variance for comparing the means of two to 20 populations. The ANOVA 
procedure for comparing these means involves analysis of the variation 
in the sample data. The null hypothesis H0: m1=m2=...=mk is tested against 
the alternative Ha: not all m1...mk are equal.

The ANOVA test is a method of determining if there is a significant 
difference between the groups as compared to the difference occurring 
within each group. 
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This test is useful in determining if the variation of data from sample-to-
sample shows a statistically significant influence of some factor other 
than the variation within the data sets themselves. For example, a box 
buyer for a shipping firm wants to evaluate three different box 
manufacturers. He obtains sample boxes from all three suppliers. ANOVA 
can help him determine if the differences between each sample group 
are significant as compared to the differences within each sample group.

ANOVA 2-way (ANOVA2way)
ANOVA 2-way computes a two-way analysis of variance for comparing 
the means of two to 20 populations. A summary of results is stored in the 
stat.results variable.

The two-way ANOVA analysis of variance examines the effects of two 
independent variables and helps to determine if these interact with 
respect to the dependent variable. (In other words, if the two 
independent variables do interact, their combined effect can be greater 
than or less than the impact of either independent variable additively.) 

This test is useful in evaluating differences similar to the ANOVA analysis 
but with the addition of another potential influence. To continue with 
the ANOVA box example, the two-way ANOVA might examine the 
influence of box material on the differences seen.

Selecting an Alternative Hypothesis (Äƒ < >)
Most of the inferential stat editors for the hypothesis tests prompt you to 
select one of three alternative hypotheses.

• The first is a ƒ alternative hypothesis, such as mƒm0 for the Z-Test.

• The second is a < alternative hypothesis, such as m1<m2 for the 
2-SampTTest.

• The third is a > alternative hypothesis, such as p1>p2 for the 
2-PropZTest.

To select an alternative hypothesis, move the cursor to the appropriate 
alternative, and then press ·.

Draw Option
Draw determines whether the test results are graphed. If you enable the 
check box, the page is split and the test curve and shading are graphed.

Selecting the Pooled Option
Pooled (2-SampTTest and 2-SampTInt only) specifies whether the 
variances are to be pooled for the calculation.

• Select No if you do not want the variances pooled. Population 
variances can be unequal.
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• Select Yes if you want the variances pooled. Population variances are 
assumed to be equal.

To select the Pooled option, select Yes from the drop down box.
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Statistics Input Descriptions
The following table describes the different inputs used in List & 
Spreadsheet wizards.

Input Description

m0 Hypothesized value of the population mean that 
you are testing.

s The known population standard deviation; must be 
a real number > 0.

List The name of the list containing the data you are 
testing.

Frequency List The name of the list containing the frequency 
values for the data in List. Default=1. All elements 
must be integers | 0. The frequency values can also 
be typed as a list, in the format {1, 1, 3, 2}.

v, Sx, n Summary statistics (mean, standard deviation, and 
sample size) for the one-sample tests and intervals.

s1 The known population standard deviation from the 
first population for the two-sample tests and 
intervals. Must be a real number > 0.

s2 The known population standard deviation from the 
second population for the two-sample tests and 
intervals. Must be a real number > 0.

List 1, List 2 The names of the lists containing the data you are 
testing for the two-sample tests and intervals. 

Frequency 1 
Frequency 2

The names of the lists containing the frequencies 
for the data in List 1 and List 2 for the two-sample 
tests and intervals. Defaults=1. All elements must be 
integers | 0.

v1, Sx1, n1, v2, 
Sx2, n2

Summary statistics (mean, standard deviation, and 
sample size) for sample one and sample two in two-
sample tests and intervals.

Pooled Specifies whether variances are to be pooled for 
2-SampTTest and 2-SampTInt. No instructs the 
TI-Nspire not to pool the variances. Yes instructs the 
TI-Nspire to pool the variances.

p0 The expected sample proportion for 1-PropZTest. 
Must be a real number, such that 0 < p0 < 1.
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x The count of successes in the sample for the 
1-PropZTest and 1-PropZInt. Must be an integer | 0. 

n The count of observations in the sample for the 
1-PropZTest and 1-PropZInt. Must be an 
integer > 0.

x1 The count of successes from sample one for the 
2-PropZTest and 2-PropZInt. Must be an integer | 0. 

x2 The count of successes from sample two for the 
2-PropZTest and 2-PropZInt. Must be an integer | 0.

n1 The count of observations in sample one for the 
2-PropZTest and 2-PropZInt. Must be an integer > 0.

n2 The count of observations in sample two for the 
2-PropZTest and 2-PropZInt. Must be an integer > 0.

C-Level The confidence level for the interval instructions. 
Must be ‚ 0 and < 100. If it is ‚ 1, it is assumed to be 
given as a percent and is divided by 100. 
Default=0.95. 

df df (degrees of freedom) represents (number of 
sample categories) - (number of estimated 
parameters for the selected distribution + 1).

RegEQ The prompt for the name of the function where the 
calculated regression equation is to be stored. 

Input Description
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Using Data & Statistics

The Data & Statistics application provides tools to:

• Visualize sets of data in different types of plots.

• Directly manipulate variables to explore and visualize data 
relationships. Data changes in one application are dynamically 
applied to all linked applications.

• Explore central tendency and other statistical summary techniques.

• Fit functions to data.

• Create regression lines for scatter plots.

• Graph hypothesis tests and results (z- and t-tests) based on summary 
statistics definitions or data.

Data & Statistics plots numeric and string (categorical) data from 
variables. You can create these variables (also called lists) in a Lists & 
Spreadsheet or Calculator application. When a problem includes lists, a 
default caption and case plot display on the Data & Statistics work area. 
You can use the defaults to explore grouping the data. Click the caption 
to see variable names used to label data, click and hold a single point to 
see the summary information, or drag a point to see how the points 
group.

Adding a variable to an axis makes the dots in the case plot move into 
position based on the values in the selected list. In their final position, 
the dots display in the default plot type for the types of data.
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À Lists & Spreadsheet application (list contains data for variables)

Á Problem/Page number counter

Â Add variable regions on x-axis and y-axis

Ã Case plot summary (shows information from a spreadsheet row)

Ä Caption shows the label of the first categorical list, by default; click 
to change this variable.

Å Sample Data & Statistics work area (case plot for the variable named 
in the caption displays by default)

The Tool menu 

Press b to open the Tools menu. These menus and tools enable you to 
graph and explore data, modify data presentations by using different 
plots, as well as perform and plot statistical analyses.

The following tables describe what each tool does in the Data & Statistics 
work area. 

Tool Menus

 Menu Overview of Tool Actions

1: Plot type Provides access to the different plot types 
available in the Data & Statistics application.

Å

Ä

Á

Â

À

Ã
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Plot Types Menu Tools  

2: Plot 
Properties

Allows you to specify how the plot displays.

3: Actions Lets you remove objects, hide or insert text, 
insert a slider, and select all points in the work 
area. 

4: Analyze Lets you analyze data by fitting lines and 
functions, and by examining regressions, 
summary statistics, and residuals. You can also 
use the Plot Value, Show Normal PDF, and 
Graph Trace tools from the Analyze menu.

5: Window
Zoom

Lets you specify a zoom factor for the window, 
or determine min and max values for the 
horizontal and vertical axes.

Tool name Tool function

1: Dot Plot Depicts data in a dot plot. This is the 
default plot type for a single numeric 
variable.

2: Box Plot Displays data in a box plot.

3: Histogram Displays data in a histogram. 

4: Normal Probability 
Plot

Displays data in a normal probability 
plot. Data is grouped against the z-value 
that corresponds to its quartile/normal 
score. This plot type is useful for 
checking for normality and determining 
the appropriateness of a normal model.

5: Scatter Plot Displays data in scatter plot form. This is 
the default plot type for two numeric 
variables.

6: X-Y Line Plot Displays data as an x-y line plot.

7: Dot Chart Displays data in a dot chart. This is the 
default plot type for categorical data.

 Menu Overview of Tool Actions
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Plot Properties Menu Tools 

8: Bar Chart Displays vertical or horizontal bars to 
represent cases in categories of data. 

9: Pie Chart Displays a circle with segments to 
represent the cases in each category of 
data. 

Tool name Tool function

1: Connect Data Points Draws a line between each point on a 
scatter plot. Lines are connected in 
the order in which the data appears 
for the variable on the horizontal 
axis. This is the same as the X-Y Line 
plot type.

2: Histogram Properties Determines how histogram data 
displays in the work area. 

Count Displays data in the histogram by 
occurrence in the data set.

Percent Displays data in the histogram by 
each bin’s percent value of the whole 
data set.

Density Displays data in the histogram by 
data density.

Bins Displays a dialog for setting the 
histogram values for bin width and 
alignment.

3: Extend Box Plot 
Whiskers/ Show Box Plot 
Outliers

Extend Box Plot Whiskers extends the 
whiskers to the min and max of the 
data.

Show Box Plot Outliers stops the 
whiskers at 1.5 * Interquartile Range 
and shows outliers as individual dots. 

Note: If there are no points outside 
of 1.5 * Interquartile Range, there 
may appear to be no whisker change.

4: Add X Variable Adds a variable to the horizontal axis 
when no variable is assigned.

Tool name Tool function
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5: Remove X Variable Removes the display of the variable 
assigned to the horizontal axis 
without changing the vertical axis.

6: Add Y Variable Adds a variable to the vertical axis to 
support the plotting of multiple 
variables.

7: Remove Y Variable Removes the display of the variable 
assigned to the vertical axis without 
changing the horizontal axis.

8: Force Numeric X Treats the variable on the x-axis as 
numeric although the default is 
categorical (list of strings). The 
categorical data label is replaced by 
an axis with numbers. Note: Forcing a 
numeric variable is supported only 
when there are numbers in the list.

9:Force Numeric Y Treats the variable on the y-axis as a 
numeric variable although the 
default is categorical (list of strings). 
The categorical data label is replaced 
by an axis with numbers. 
Note: Forcing a numeric variable is 
supported only when there are 
numbers in the list.

8: Force Categorical X Treats the variable on the x-axis as a 
categorical variable (list of strings). 
The numeric axis is replaced by labels 
for categorical data. 

9: Force Categorical Y Makes Data & Statistics treat a 
numeric variable assigned to the 
y-axis as a categorical variable (list of 
strings). The numeric is replaced by 
labels for categorical data.

A: Clear All Removes the variable assignments 
from the axes. This enables you to 
start your work again.

Tool name Tool function
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Actions Tool menu 

Analyze Menu Tools 

Tool name Tool function

1: Remove Removes selected items from the work 
area.

2: Hide/Show Text Hides or shows selected text.

3: Insert Text Adds a text box with multiple lines for 
typing notes in the work area. You can 
edit, move, resize, remove, and hide text 
boxes. Note: To go to the next line in a 
text box, press @@@@.

4: Insert Slider Inserts a slider control for dynamically 
changing the value of a numeric variable. 

5: Select all Points Selects all points in the work area.

Tool name Tool function

1: Remove Removes a selected Movable Line, 
Regression, Plotted Value, or Plotted 
Function.

2: Add Movable Line Adds a line you can position and 
reposition in the work area. This can 
be used for manual fit.

3: Lock Intercept at 
Zero/Unlock Movable Line 
Intercept

Locks the intercept of a movable line 
at zero. Note: This tool is only 
available when a movable line is 
present in the work area.

4: Plot Function Lets you graph a function in the 
work area. 

5: Shade Under Function Lets you select and shade a region 
under a function or distribution 
curve.
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6: Regression The regression tools perform the 
selected regression calculation and 
then plot the regression model. 
Regression is only available on 
Scatter plots or X-Y line plots.

Show/Hide Linear 
(mx+b)

Calculates and displays the linear 
regression line in the format, mx+b, 
for the plotted data.

Show/Hide Linear 
(a+bx)

Calculates and displays the linear 
regression line in the format, a+bx, 
for the plotted data.

Show/Hide Median-
Median

Calculates and displays the Median-
Median regression line for the 
plotted data. 

Show/Hide Quadratic Calculates and displays the 
Quadratic regression model for the 
plotted data.

Show/Hide Cubic Calculates and displays the Cubic 
regression model for the plotted 
data.

Show/Hide Quartic Calculates and displays the Quartic 
regression model for the plotted 
data.

Show/Hide Power Calculates and displays the Power 
regression model for the plotted 
data.

Show/Hide 
Exponential

Calculates and displays the 
Exponential regression model for 
the plotted data.

Show/Hide 
Logarithmic 

Calculates and displays the 
Logarithmic regression model for 
the plotted data.

Show/Hide Sinusoidal Calculates and displays the 
Sinusoidal regression model for the 
plotted data.

Tool name Tool function
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Show/Hide Logistic 
(d=0)

Calculates and displays the Logistic 
regression model where D=0, for the 
plotted data.

Show/Hide Logistic 
(dƒ0)

Calculates and displays the Logistic 
regression model where Dƒ0, for the 
plotted data.

7: Residuals The residuals tools display 
information about the residuals of 
the selected model. 

Show/Hide Residual 
Squares

Displays the squares of residuals. 
Note: This tool is available when a 
regression line or movable line is 
present in the work area.

Show/Hide Residual 
Plot

Plots the residuals against the 
explanatory variable. The residual is 
the difference between the 
observed value (data) and the value 
calculated by a regression or 
function. Note: This tool is available 
when a scatter plot and one or more 
lines, regressions, or plotted 
functions are on the work area.

8: Plot Value Lets you graph a statistical value on 
the axis. Examples of values that can 
be plotted are mean, median, 
standard deviation.

9: Show Normal PDF Overlays the normal probability 
density function using the mean and 
the standard deviation of the data 
in the histogram. Note: This tool is 
available when a histogram is 
present.

A: Graph Trace Lets you trace the graph from Plot 
Function, Show Normal PDF, 
distribution curves, or regressions.

Tool name Tool function
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Window/Zoom Menu Tools 

Tool name Tool function

1: Window Settings Displays a Window Settings dialog that 
enables you to enter values that define 
the work area window. Values you can 
set include the x-min, x-max, y-min, and 
y-max values for the axes.

2: Zoom - Data Adjusts the zoom factor so that all 
plotted data appears in the work area.

3: Zoom In Enables you to zoom in on a plot based 
upon the selection of a center point. The 
Zoom In factor is approximately 2.

4: Zoom Out Enables you to zoom out on a plot based 
upon the selection of a center point. The 
Zoom Out factor is approximately 2.
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Getting started with Data & Statistics 

The Data & Statistics application is a place to explore and visualize data 
and graph inferential statistics. It is, therefore, best used in conjunction 
with a numerical application like Calculator or Lists & Spreadsheet. You 
can plot data from Lists & Spreadsheet using the Quick Graph tool, or by 
adding a new Data & Statistics page to the problem and plotting 
variables on the axes.

Creating plots from spreadsheet data
The Quick Graph tool of Lists and Spreadsheet is the easiest way to plot 
data using the columns in a spreadsheet.

Plotting data using the Quick Graph tool
1. Open a problem that includes a Lists & Spreadsheet page, or create 

data to be plotted in Lists & Spreadsheet. You can plot one or two 
columns of data.

The following example shows two columns (lists), height and age. 

Important: You must type a name for each column of data in Lists & 
Spreadsheet in order to plot the data in Data & Statistics.

2. To highlight a single column, move to the top of the column and 
click £. . To select two columns, press g and use the NavPad 
arrows to include the next column in the selection.
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3. From the Lists & Spreadsheet Data menu , select the Quick 
Graph tool. 

Press b35.

The Quick Graph tool adds a Data & Statistics page, plots the first 
column on the horizontal axis, and plots the second column on the 
vertical axis. The name for the column in Lists & Spreadsheet is the 
label for the axis it plots on. The following example shows the 
scatter plot for the two columns of data. 
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The data plot functions as follows:

– To create a dot plot on the horizontal axis, select only one 
column of data when using the Quick Graph tool. The column 
name appears as the horizontal axis label.

– To add a new work area with Data & Statistics active when using 
Quick Graph, confirm that fewer than four work areas are on 
the page. If four work areas are already on the page, Quick 
Graph adds a new page with Data & Statistics active on it.

– Click a point to select it. Clicking and holding the point displays 
the spreadsheet row information.

– Move to the add variable region of an axis. Click  
to display a list of other variables in the problem. Click any 
variable in the list to replace the current variable with your 
selection.

Note: If a list is defined with a formula in Lists & Spreadsheet, the 
points in Data & Statistics may not move because of the formula’s 
restrictions. The dots in Data & Statistics only move in directions 
allowed by their definition. Dots that are defined by data in the cell 
move freely. Points that represent a calculation move as defined by 
the calculation. For example, a dot that represents the result of y=x 
will move along a line.



Using Data & Statistics 245

Plotting data on a new Data & Statistics page
1. Open a problem that includes lists defined in a Lists & Spreadsheet or 

Calculator application. 

2. Press / + c and select Page on the Tools menu to add a page 
to the problem. 

A blank page is added to the problem.

3. If necessary, click b to see the list of applications. Click the tool tip 
in the center of the blank page to add a Data & Statistics application. 
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A Data & Statistics work area is added to the page.

By default, a caption at the top of the work area identifies an 
available variable in the problem and shows data points. You can 
click the add variable region on the caption to see data points for a 
different variable (that is, a named column in a list from any Lists & 
Spreadsheet page in the problem).

All variables from any Lists & Spreadsheet page in the problem 
display on the context menu for the horizontal axis. 

When no variable is specified for an axis, the case plot provides the 
following details:

– Clicking and holding a dot in the plot displays the data for the 
corresponding case. A case corresponds to a row in Lists & 
Spreadsheet. In the following example, an annual income and a 
coverage amount comprise a case.

– Grabbing and dragging a dot in the plot causes all of the dots in 
the plot to shift appropriately based on the caption. 

– Moving to an axis and clicking  lets you see a list 
of all variables in the problem. Click on the name of any list to 
replace the variable on the axis with the variable in the selected 
list.

4. Click income to add the variable with that name to the horizontal 
axis. 
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The following changes occur in the work area:

• The variable name, income, is added as the label for the 
horizontal axis. 

• Data points for the numeric value from each cell in the income 
column move into place on the x-axis. 

5. Click the add variable region on the vertical axis to add a list from 
any page in the problem. 

6. Click coverage to add the variable with that name to the vertical 
axis. 
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The dots move into place to show the coverage amount associated 
with each income. The variable name, coverage, is added as the 
label for the vertical axis. 

Note: The context menu for each axis includes the option to Force 
Categorical X or Force Categorical Y. Forcing categorical 
treatment on an axis with a numeric variable replaces the numbers 
on the axis scale with the values from the cells for the spreadsheet 
column. A data point indicates each instance of a value.

Numeric plot types
Plots let you visualize your variable in a variety of ways. Visualizing the 
data points allows you to observe the shape and spread of the data, and 
can help you determine the best method of statistically evaluating data. 
Use Data & Statistics to create the following types of numeric plots:

• Dot Plot

• Box Plot

• Histogram

• Normal Probability

• Scatter Plot

• X-Y Line 

Dot plots
Dot plots, also known as dot-frequency plots, represent one variable 
data. Dot plots are the default plot type for numeric data.
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When one variable is plotted, the value of each cell is represented as one 
dot, and the dots are stacked at the point on the axis that corresponds to 
the cell value. By default, the horizontal axis is selected. The column 
name is used as the axis label.

Creating a dot plot
1. Create and name a list of data in a column in Lists & Spreadsheet or 

Calculator.

2. To create a dot plot, do one of the following:

• Select the column of data in Lists & Spreadsheet by clicking the 
column letter near the header cell. You can click with the 
Navpad to move to the top of the current column. Click with the 
Navpad again to select the column.

In the Lists & Spreadsheet work area, select Quick Graph from 
the Data tool menu to automatically graph the selected data.

Press b35.

Or

• Click in the horizontal axis label in the Data & Statistics work 
area, click and select the name of the variable containing the 
data you want to see represented on the horizontal axis.

3. The data graphs in the Data & Statistics work area.



250 Using Data & Statistics

Click on any dot to display its value, or click and drag to change its 
value. To deselect, click any area of the plot that does not include a 
dot.

Box plots

The default box plot created by the Box Plot Tool  is a modified box 
plot. It plots one-variable data. "Whiskers" extend from each end of the 
box, either 1.5 times the interquartile range or to the end of the data, 
whichever comes first. Points that are 1.5 * Interquartile Range beyond 
the quartiles are plotted individually beyond the whisker. (The 
Interquartile Range is defined as the difference between the third 
quartile, Q3, and the first quartile, Q1.) These points are called potential 
outliers.

When no outliers exist, x-min and x-max are the prompts for the end of 
each whisker (the prompts will be y-min and y-max if you choose to 
create a vertical box plot). Q1, Med (median), and Q3 define the box.

Box plots are useful in comparing two or more sets of data. Note that 
these must use the same scale. If a dataset is large, a box plot can also be 
useful in exploring data distribution. 

Creating a box plot
1. Using a problem that includes Lists & Spreadsheets data and a Data & 

Statistics work area, plot a variable on the horizontal axis.

Note: If two variables are plotted in the work area, select Remove Y 

Variable  from the Plot Properties menu . 

2. From the Plot Types menu , select the Box Plot tool . 

Press b12.

The default data points move into a modified box plot on the Data & 
Statistics work area.

For a work area with no variable plotted, the caption and default 
data points move. A modified box plot displays on the Data & 
Statistics work area.
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3. Hover on a box or whisker to display the details for the portion of 
the plot that interests you. 

The label for the quartile that corresponds to your selection displays 
on the work area.

Initial box plot display - modified box plot

Box plot with label for Quartile 3
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Creating a standard box plot 
You can create a standard box plot by modifying the whiskers of the 
default (modified) box plot. In a standard box plot, the whiskers are 
plotted using the minimum and maximum points in the variable. No 
attempt is made to identify outliers. 

The whiskers on the plot extend from the minimum data point in the set 
(x-min) to the first quartile (Q1) and from the third quartile (Q3) to the 
maximum point (x-max). The box is defined by Q1, Med (median), and 
Q3. 

To change the box plot from modified to standard:

1. Create a box plot for one variable by selecting the Box Plot tool  

from the Plot Types menu .

2. Display the context menu for the box plot:

• Move the cursor to the box plot and then press /b. 

3. Select Extend Box Plot Whiskers.

Press b23

The box plot is redrawn to display the whiskers you selected.

4. To return the box plot to its original display, display the context 
menu and select Show Box Plot Outliers.

Press b23.
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Extending Box Plot Whiskers
You can select Extend Box Plot Whiskers from the Plot Properties menu 

 to extend the whiskers to the min and max of the data. You can also 
select Extend Box Plot Whiskers from the context menu, as shown in the 
example below.

The whiskers extend to the min and max of the data.



254 Using Data & Statistics

Showing Box Plot Outliers

Select Show Box Plot Outliers from the Plot Properties menu  to 
stop whiskers at 1.5 * Interquartile Range and show outliers as individual 
dots. You can also select Show Box Plot Outliers from the context menu.
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Points beyond 1.5 * Interquartile Range display in the work area as 
outliers.
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Note: If there are no points outside of 1.5 * Interquartile Range, there 
may appear to be no change in the whisker display.

Multiple box plots
When you have a numeric list with a corresponding categorical list, you 
can create a box plot split by category. Adding the categorical list splits 
the box plot by category. A split box plot is useful for comparing the 
spread of various populations.

In the following example, the text that describes a toddler age range is 
used to sort the heights in the box plots:

Note: Histograms and dot charts can also be split by category by adding 
the corresponding categorical variable to a plot of the numeric variable.

Histograms
A histogram plots one-variable data. Histograms depict the distribution 
of data. 

The number of bins displayed depends upon the number of data points 
and the distribution of these points. You can adjust the bins’ width and 
number by dragging the side of one bin in the work area. 

A value that occurs on the edge of a bin is counted in the bin to the right. 

Creating a histogram
1. Select the data you want to plot as a histogram. 
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2. From the Plot Types menu , select the Histogram tool . 

Press b13.
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In this example, the data from the box plot separates into points and 
moves to form the bins of a histogram.

The histogram plots on the Data & Statistics work area. 

3. Click on any bin to select it. Click and hold a bin to display the 
summary information.

Adjusting the bins interactively
1. Hover over the right side of the bin.

The cursor changes to ô.

Initial histogram display
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2.  Press and hold xto display the grab cursor ÷. Move the edge to 
the desired bin width and release it.
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Adjusting bins numerically

1. From the Plot Properties menu ( ), select Histogram Properties 

( ).

2. Select Bin Settings. The Histogram Properties dialog displays.

3. Type values to set width and alignment of the bins that represent 
histogram data:

• To specify bin width, type a value in Width.

• To specify bin placement, type a value in Alignment. 

The bins of the histogram are redrawn using the values set. Both the 
data represented by the bins and the value you type for the 
alignment affect the placement of bins on the scale. 

For example, when a histogram with a bin width of 1 is centered 
over the tic marks on the axis with the default alignment of 57.5, 
changing the alignment to 58 left aligns all bins on the axis scale. All 
bins are shifted right by .5; the offset for positioning bins on the axis 
is based on the starting position for the data and the value you 
specify for alignment. 

Default bin alignment
(centered on tic mark)

Bin alignment increased 
(right aligned on tic mark)
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Changing the properties of a histogram:

Use the histogram properties tools to change the data representation 
format in a histogram. The options for properties are: 

• Count - displays data based upon the number of values that occur 
within each bin (interval) on the histogram. This is the default data 
representation when you create a histogram.

• Percent - displays data in the histogram by each group’s percent 
value of the whole data set. 
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• Density - displays data based upon the density of each value within 
the variable.

• Bin Settings- displays the Bin Settings dialog box. To adjust the 
histogram, type a numeric value for the width and alignment of 
histogram bins.

Setting the bin width and alignment requires consideration of both 
the number of bins and the number of data points included in the 
range represented by a bin. Avoid misrepresentation by accepting 
the default bin width or experimenting to identify appropriate bin 
settings.
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To change the scale:

1. Create a histogram.

2. Display the context menu for the histogram:

• Move the cursor to the histogram and then press /b. 

3. Select Scale from the context menu.

4. Select Percent (2) or Density (3). The histogram is redrawn to 
the scale you select.

Note: The Count tool (1)is not available because it is the scale 
currently used in the display. 

Click on a bin to display the values that are contained in the bin.

Normal probability plots
A normal probability plot shows one set of data against the 
corresponding quartile (z) of the standard normal distribution. You can 
use normal probability plots to judge the appropriateness of the normal 
model for your data.

Creating a normal probability plot
1. Select the data you want to use for a normal probability plot. Use a 

named list from Lists & Spreadsheet or Calculator.

2. Plot the data in one of the following ways:

• Create a dot plot by selecting a column and choosing Quick 
Graph.

• Add a Data & Statistics work area and assign the data list name 
as the variable for an axis.
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3. From the Plot Types menu , select Normal Probability Plot . 

4. The data graphs in the Data & Statistics work area. 

You can examine the graph to compare the normal variable against 
the quartile. Click on a dot to display its value.

Scatter Plots
A scatter plot shows the relationship between two variables of the data 
or two sets of data.

You can plot bivariate data in either of two ways.

From the Lists & Spreadsheet work area:
1. Select two columns of data listed in Lists & Spreadsheet by clicking 

the letter above the first column and pressing Shift and using the 
arrow keys to include the adjacent column in the selection.

2. Select Quick Graph from the Data menu to automatically graph the 
selected data.

Press b35.

The data graphs on the Data & Statistics work area.
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From the Data & Statistics work area:
1. In the Data & Statistics work area, click in the horizontal axis label 

box, and select the variable that contains the data you want to see 
represented on the horizontal axis. 

2. Click the add variable region of the vertical axis and select the 
variable that contains the data you want to see represented.

The data graphs in the Data & Statistics work area.

3. Click on any point to display its value.
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X-Y line plots
An X-Y line plot is a scatter plot in which the data points are plotted and 
connected in order of appearance in the two variables. Like scatter plots, 
these plots depict the relationship between two sets of data.

By convention, the left-most column of data is represented on the 
horizontal axis. 

1. Create a scatter plot using the steps shown in the previous sections.

2. From the Plot Types menu , select the XY Line Plot tool .

Press b15.

3. The data points within each set are connected to each other by a 
line. 
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Note: The dots are connected in the order that they appear in the 
list variable on the horizontal axis. To change the order, use the sort 
tool in Lists & Spreadsheet.

Creating multiple plots
1. From a Lists & Spreadsheet work area, create a scatter plot using two 

columns of data. 

For more information, refer to the previous section,"Scatter plots."

2. From the Plot Properties menu ( ), select Add Y Variable . 

A list of the names of all variables available in the problem displays.

3. Use the arrow keys to move to and click the name of the variable 
that you want to plot in addition to the data previously plotted on 
the y-axis.
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After you select a second variable for plotting, a legend displays at 
the top of the work area. The legend shows the clear shapes and 
shaded shapes used to distinguish the multiple variables plotted on 
the y-axis. 

Click on the legend to hide it, or to remove one of the variables 
plotted on the y-axis. Click and grab the legend to move it to 
another position in the work area.

To add more variables to the y-axis, repeat steps 2 and 3. 

Categorical plot types
You can sort and group data using the categorical plot types:

• Dot Chart

• Bar Chart

• Pie Chart

The categorical plot types can be used to compare the representations of 
data across different plots. When the same variable (list) is used for a dot 
chart and a bar chart or pie chart in a problem, selecting a data point or 
segment in one of the plots selects the corresponding data point, 
segment, or bar in all other plots that include the variable.

Dot charts
Dot charts summarize data that is categorical. The default plot type for 
categorical data in Data & Statistics is the dot chart.
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When one variable is plotted, the value of each cell is represented as one 
dot, and the dots are stacked at the point on the axis that corresponds to 
the cell value. 

Creating a dot chart
1. In Lists & Spreadsheet, create a spreadsheet that includes at least one 

column of string values that can be used as categories for data.

Note: To type a string in Lists & Spreadsheet, enclose the characters 
in quotes.

2. Add a Data & Statistics page to the problem. 

Note: You can also use the Lists & Spreadsheet Quick Graph tool to 
automatically add a Data & Statistics page and plot selected columns.
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By default, the work area for the new page includes a caption and 
related data points. Data & Statistics selects a variable from a Lists & 
Spreadsheet page in the problem to use for the default caption. You 
can click the caption and click None to remove it, or click the add 
variable region of the caption to change the variable used.

3. Move near the middle of horizontal or vertical axis and click the add 
variable region to display the available variables.

4. Click the name of the variable that contains the categories you want 
to use for sorting data.
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A dot chart plots in the work area. Data & Statistics labels the axis 
with the variable name and shows a dot for each instance of each 
category, which in this case is a breed of dog.

Bar charts
Like dot charts, bar charts summarize data that is categorical. The height 
of a bar represents the number of cases in the category. 

Creating a bar chart
1. Create a dot chart on the work area.

2. Select Bar Chart on the Plot Types menu.

The dot chart changes to a bar representation of the data.
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The height of each bar represents the number of cases in the 
category. 

3. Click and hold a bar to see a category summary (the number of cases 
and percentage among all categories). 

Clicking and holding the bar for the Toy Poodle category displays the 
category summary. The summary shows that there are three cases for 
Toy Poodle and that these cases make up 20% of all cases for the 
variable, breed.

Pie charts
A pie chart represents categorical data in a circular layout and uses an 
appropriately proportioned segment for each category.

Creating a pie chart
1. Create a dot chart on the work area.

2. Select Pie Chart on the Plot Types menu.
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The dots in the dot plot move toward locations according to 
category and are replaced with the shaded segments of the pie 
chart. Variations in shading distinguish the different categories of 
data.

3. Click and hold a segment to see the summary for the category. The 
summary displays the number of cases for the category and the 
percentage among all cases. 
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Plotting data using a Categorical split
You can plot data using a categorical split to see values from a list plotted 
on an axis and sorted based on subsets of data represented on the 
second axis.

1. Open a problem that includes a Lists & Spreadsheet page, or create 
data to be plotted in Lists & Spreadsheet. 

In the example below, a spreadsheet shows a dog’s breed and walk 
duration in the columns breed and daily_walk_mins.

2. Click the column letter (B) to highlight the daily_walk_mins 
column. 

3. From the Lists & Spreadsheet Data menu , select the Quick 
Graph tool. 

Press b35.
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The Quick Graph tool adds a Data & Statistics page. Data & Statistics 
plots the selected column on the horizontal axis and uses 
daily_walk_mins (the column name) as the label for the horizontal 
axis. 

4. To sort the data using a categorical value, move near the middle of 

the vertical axis and click . 

The list of available variables displays near the axis.
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5. On the list of variables, click the name of the categorical variable to 
use for the sort. 

In this example, breed is the category for sorting. Data & Statistics 
labels the vertical axis with the breeds included in the list. 

The dots in the plot move into position on the vertical axes. The 
values in the variable daily_walk_mins are sorted by category 
(breed). The dots are positioned according to the label for the breed 
on the vertical axis. You can then change plot types to see a split box 
plot or histogram.
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Exploring data
You can manipulate and explore plotted data in the following ways:

• Select and move points or data bins

• Change the type of plot

• Rescale the graph

• Add a movable line

• Show regression lines

• Show residual squares

• Show a residual plot

Moving points or bins of data
1. Click on and hold the desired point or bin.

The cursor changes to ÷.

2. Drag the point or bar to the new location and release it.
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If you are working with data from Lists & Spreadsheet, the data that 
corresponds to the original point or bar automatically updates in the 
original column(s) in Lists & Spreadsheet as you move the point.
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You can also move points or bins by changing the numbers in Lists & 
Spreadsheet or Calculator. Data will update in all of the 
representations.

Selecting multiple points
1. Position the cursor over each point you want to select. The cursor 

changes to ø. 

2. Click to add the point to the selection.
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3. Once you have selected the desired points, hover over one of the 

points. The cursor changes to {. To move the points around in the 
work area, click and hold a point, or press Ctrl and click to grab a 
point.
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Selecting a range of points
1. Select a range of points with a click-and-drag movement to place the 

bounding outline (dotted line box) around the points you want to 
select. 

2. To move the selected points, click any point in the selection. 
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When you release the mouse button, the points are selected.

3. Once you have selected the desired points, click one of the points. 

The cursor changes to {, and you can move the group of points in 
the work area.
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Note: When a list is defined in Lists & Spreadsheet as a formula, the 
movement of points is restricted to only points that satisfy that 
formula.

Plotting a value
You can plot a value on an existing plot. It displays as a vertical line in the 
work area.

1. From the Analyze menu , select Plot Value . A data entry 
box opens in the work area. 

Press b38.
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2. Type the value you want to plot, and press ·.

In this example, the value is v1:= mean(cost). 

3. The line is drawn at that value, perpendicular to the axis. Click on the 
line to display the value. 

Note: Double-click the value line to edit it in the work area.

You can use Plot value for a single number or any expression that 
evaluates to a number. If the value is dependent on the data, like 
mean, when you drag a point or make changes in Lists & 
Spreadsheet, the line updates to reflect the change, allowing for 
investigation of the influence of points on the calculation.

Plot value 
entry box

Plot value line with value displayed
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Removing a plotted value
To remove a plotted value from the work area, click on the line to 

select it, and then select Remove Plotted Value  from the 

Actions menu .

Press b24.

Changing plot type
You can change the plot type, to view different representations of data.

Click the Plot Type menu  and select the new plot type. The data 
representation changes to the new plot format. 

Note: Options are unavailable on the menu if your data cannot be 
represented by the plot type. For example, if a scatter plot is 
displayed in the work area, you cannot create a box plot without 
first removing the Y component of the plot. 
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Rescaling a graph
You can change the scale of the axes for translation and dilation:

The cursor changes to indicate whether translation (ö) or dilation (ô) is 
available in zones on the axes.

Translation
A translation slides a set of axes a fixed distance in a given direction. The 
original axes have the same shape and size.

1. Position the cursor over a tic mark or label in the middle third of the 
axis. The cursor changes to ö.

Dilation 
region

Dilation 
region

Translation 
region

Translation 
region

Dilation 
region
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2. Click to grab. The cursor changes to ù. Drag the cursor to the 
desired position and release.
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Dilation
Dilation retains the shape of the axes, but enlarges or reduces the size.

1. Position the cursor over a tic mark or label near the ends of the axis. 
The cursor changes to ó on the vertical axis or ô on the horizontal 
axis.

2. Click to grab. The cursor changes to ÷. Drag the cursor to the 
desired position and release.
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Adding a movable line
You can add a movable line to a plot. Moving and rotating the line on 
the work area changes the function that describes it. 

Select Add Movable Line  from the Analyze menu . 

Press b32.

The movable line displays and is labeled with a function that 
describes it. For this example, Data & Statistics stores the expression 
for the movable line in the variable m1.
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Rotating a movable line
1. Click and grab on either end of the line.

The cursor changes to é.

2. Drag to rotate and change the slope of the line.
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The function m1(x) is updated for the changes in the position of the 
movable line.

Changing the intercept
1. Click in the middle of the movable line.

The cursor changes to ö.

2. Drag to change the intercept.
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The number at the end of the equation changes to show the change 
in the intercept.

Note: The movable line is stored as a function that can be used for 
prediction in the Calculator application.

Locking the intercept at zero
You can lock the intercept of the movable line at zero. 

Select Lock Intercept at Zero  from the Analyze menu . 

Press b34.

Note: This tool is only available when movable line is present in the 
work area. 

Unlocking the intercept
To unlock the intercept:

Select Unlock Movable Line Intercept  from the Analyze 

menu . 

Press b34.
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Showing regression lines
You can show a line of regression when you have a scatter plot or an X-Y 
line plot on the work area. Studying the line of regression can help you 
understand the relationship between two variables. 

1. With a scatter plot or X-Y line plot of two variables on the work 

area, select Regression from the Analyze menu . 

Press b46 and the number of the regression.

2. Click to select the type of regression line to show. For example, 
choose Show Linear (mx+b) to plot a linear regression line as shown 
in the following example. 

When the line of regression is selected, the expression for the line 
displays.
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Showing residual squares
You can display residual squares on a plot. Residual squares can help you 
assess the appropriateness of the model for your data.

Select Show Residual Squares  from the Analyze menu . 

Press b36.

Note: This tool is only available when a regression or movable line is 
present in the work area.

The sum of squares is updated as the line or data changes.

Showing a residual plot
You can show a residual plot to determine how well a line fits data. The 
work area must include a scatter plot and one or more movable lines, 
regressions, or plotted functions for Show Residual Plot to be available.

With a scatter plot, line of regression, and/or movable line in the 
work area, press b472. 
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Notes:

• With multiple regressions or functions and movable lines plotted, you 
can select each in turn to show its residual plot. 

• Click and hold a dot on the residual plot to see the residual.

• The residual plot for the selected regression or function displays in 
the work area. 

• For consistency in comparing sets of data, residual plots do not rescale 
when you move from one function or regression to another. 

• Select a function or regression before a showing residual plot. If no 
function or regression is selected and there are several plotted, Data 
& Statistics arbitrarily selects the function or regression for showing 
the residual plot.

• Axes can be adjusted by clicking and dragging.

Removing a residual plot
To remove a residual plot when it is no longer needed.

With a scatter plot, line of regression, and/or movable line in the 
work area, press b472. 
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Using Window/Zoom tools

Use the Window/Zoom tools  to redefine the graph to better view 
points of interest. The Window/Zoom tools include:

• Window Settings: displays a Window Settings dialog that lets you 
enter the x-min, x-max, y-min, and y-max values for the axes. 

• Zoom - Data : adjusts the zoom factor to display all plotted data.

• Zoom - In : lets you to define the center point of the zoom in 
location. The Zoom In factor is approximately 2.

• Zoom - Out : lets you define the center point of the zoom out 
location. The Zoom Out factor is approximately 2.

Using Window Settings

1. Click the Window/Zoom menu , and select Window Settings.

Press b41.

2. The Window Settings dialog opens. The current values for x-min, 
x-max, y-min, and y-max display in the fields. 

Note: Only the appropriate boxes are editable, depending on 
whether there are one or two axes in the work area.

3. Type the new values over the old values. 
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4. Select OK to apply the changes and redraw the plot.

Using Zoom Data

1. Click the Window/Zoom menu , and select Zoom Data . 

Press b41.

2. The work area rescales to display all plotted data.

Using Zoom In

1. Click the Window/Zoom menu , and select Zoom In . 

Press b43.

2. In the work area, click the center point of the area of interest. This 
will be the center of the zoom in action.

3. The plot redraws to focus and enlarge the portion of the plot 
centered about the point you selected in the previous step.
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Using Zoom Out

1. Click the Window/Zoom menu , and select Zoom Out . 

Press b44.

2. In the work area, click the center point of the area of interest. This 
will be the center of the zoom out action.

3. The plot redraws to display a larger portion of the plot, centered 
about the point you selected in the previous step.

Graphing Functions
You can graph functions by typing them in Data & Statistics, or you can 
graph functions defined in other applications.

From Data & Statistics: select the Plot Function tool  from the 

Analyze menu . 

Press b39.

Graphing functions using the Plot Function tool
You can use the Plot Function tool to plot functions in a work area that 
already includes a plot on the axes. Plot Function lets you specify and 
graph a function for comparison to an existing plot. 

To use the Plot Function tool:

1. Create or open a problem that includes variables (from Lists & 
Spreadsheet) that are plotted on a Data & Statistics work area. 
Ensure that your work area contains both a horizontal axis and a 
vertical axis scale.

2. From the Analyze menu , select the Plot Function tool . 

Press b39.

3. A function entry field displays in the work area.
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Note: You can edit the function’s expression typed in the entry field. 
However, the function graphed in Data & Statistics cannot be 
manipulated or moved around the work area. To do that, use Graphs 
& Geometry. 

4. Type the function in the entry field, and press Enter. 

Note: You can rename the function by typing over f1(x): with 
another name, if you choose.

5. The function graphs in the work area and is saved as a variable for 
use in other applications. 

Entering functions from other applications
You can enter a function that has been defined as a variable in another 
application, such as Lists & Spreadsheet, Graphs & Geometry or 
Calculator.

Plot 
Function 
entry field

Plot from 
variables

Function 
graph

Function 
equation

Plotted 
Variables
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1. Ensure that your work area contains both a horizontal axis and a 
vertical axis scale.

2. From the Analyze menu , select the Plot Function tool . 

Press b39.

A function entry field displays in the work area. 

3. Click  on the tool bar to open the Variables menu.

Press h.

A list of variables available in the problem displays.

4. Click to select the variable containing the function you want to plot.



302 Using Data & Statistics

In the example below, the variable a contains the function f(x)=x2.

5. Press Enter.

The function plots in the work area. 
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Editing a function 
You can edit a function and update it on the work area.

1. You can edit a function by double-clicking the equation and then 
making changes as required.

2. Press · after making all changes and the updates display in the 
work area. 

Using Data & Statistics functions in other applications
Data & Statistics functions are stored as variables, and may be used in 
other applications, in the same manner as any other variable. Support for 
all function types is included.

Note: Function numbers increment to use the next available. If you have 
defined f1(x) and f2(x) in Graphs & Geometry, the first function you 
create in Data & Statistics will be f3(x).

Using Show Normal PDF
You can approximate data plotted in the Data & Statistics work area 
against the normal probability density function. The tool overlays the 
normal probability density function using the mean and the standard 
deviation of the data in the histogram.
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To show the normal probability density function for plotted data:

1. Select plotted data in the Data & Statistics work area and display it in 
a histogram format.

2. Select Show Normal PDF ( ) on the Analyze menu ( ).

The normal PDF for the graph plots in the work area. The expression 
used to calculate the PDF displays when selected. 

Select Hide Normal PDF on the Analyze menu to remove the PDF.

Note: Show Normal PDF is available only when histogram is the 
plot type.

Using Shade Under Function
Use Shade Under Function to find the area of a selected region under a 
function graphed in the work area.

1. Select any function graphed in the Data & Statistics work area. For 
example, select a previously graphed normal PDF.

2. Select Shade Under Function ( ) on the Analyze menu ( ). 

Press b3A. 
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The cursor becomes a dotted vertical line and the boundary +/- ˆ 
displays when you position the mouse near the boundary on the left 
or right. You can click when ˆ displays to set it as a boundary.

3. Select a point on the curve and click to indicate where to start 
shading under the function. The direction in which you move next 
determines whether the region shaded is on the left, right, or center 
of the curve.

4. Select a point on the curve and click to indicate the end boundary of 
the shaded area. A region under the function is shaded based on the 
points you selected. 

You can work with Shade Under Function in the following ways: 

• Select the region to display the shaded area. 

• Select Shade Under Function again to shade multiple areas. 

• Select Remove Shaded Region on the context menu to remove 
shading.

• Use plot value to set the boundary to an exact number. When a 
boundary for shading is set to a plotted value, you can change 
the plotted value to update the shading.

• Edit a shaded region by clicking and dragging the starting or 
ending boundary.
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Using Graph Trace
Graph Trace lets you move from one point on a graph to another in order 
to analyze variations in the data. Use Graph Trace mode to explore the 
data for a Plot Function, Show Normal PDF, or a distribution curve 
(created in the Lists & Spreadsheet application).

1. On the Analyze menu , select Plot Function  to plot a graph 
in the work area.

2. From the Analyze menu , select Graph Trace  to change to 
trace mode. 

Press b4A.

Plot Function entry 
field
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The Graph Trace point displays on the graph.

3. Graph trace enables the following operation: 

• Press 7 8 to move along the function’s graph. The coordinates of 
each point display during the trace. 

• Press 9 : to move from one function graph to another or to a 
scatter plot. The point’s coordinates update to reflect the new 
location of the trace. The trace cursor is positioned on the point 
of the new graph or plot with the closest x value to the last 
point identified on the previously traced function or graph. 

• View the points of interest ("Z" for zero, "M" for local 
maximum, and "m" for local minimum) that display as you trace 
a function’s graph.

• Type a number and press · to move the trace cursor to that x 
value on the function’s graph. 

• With a point selected, press Enter to save it.

4. Use the Esc key to exit trace mode. Choosing another menu item also 
exits the trace mode.

Function graph

Graph 
Trace 
point



308 Using Data & Statistics

Using other Data & Statistics tools

Inserting text
The Insert Text tool lets you type text that describes information related 
to a plot in the work area.

1. From the Actions tool menu , select Insert Text . 

A text entry field displays. 

2. Type notes or descriptions in the text entry field.

You can customize the text in the following ways:
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– Press @@@@ to insert a new line. 

– Click outside of the text entry field to end editing.

– Move the cursor over the edges of the text box to drag the 
borders and change the width or height.

– Click and grab the text box to move it near objects that relate to 
the text.

Hiding text
To hide text on the work area:

Select the text and choose Hide Text  on the Actions  menu.

Using Sliders
Sliders let you easily change the value of a numeric value in the Graphs & 
Geometry and Data & Statistics applications. Inserting a slider lets you 
represent multiple variable values in a continuous range. In the following 
example, the slider represents the numeric variable, b in the graphed 
function. 

To insert a slider, select Insert Slider on the Actions menu. The 
slider displays on the work area. 

À

Á

Â
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À Variable statement that includes the name of a numeric variable in 
an entry field, the assignment operator ":=", and the value set for 
the numeric variable in a second entry field

Á Slider that you can move to values on the scale when the control is 
active

Â Track with labels for the minimum and maximum values on the scale 
and scale tic marks between the end values

Basic slider operation
When the slider is inserted, you can change the name by typing the name 
of the variable you want to use over the default, v1. To accept the 
default variable, press Enter. 

You can move the slider to set the variable to a value, or type a number 
in the text box after the equal sign. Press Esc or click another part of the 
work area to cancel selection of a slider. 

You can use a slider in the following ways:

• Grab the slider and drag it to set the variable to any value within its 
range. 

• Click a point near the slider track to grab the entire control for 
operations such as copying, moving, and deleting. 

• Drag the track ends to change the length of the slider scale.

• Click the text box for the slider variable name and type the name of 
the numeric variable to use. You can use an existing numeric variable 
or use the slider to create a new one.

Context menu and slider settings
To change the settings for a slider, access the slider context menu:
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Select Settings to display the Slider Settings dialog:

Specify the values to use for the slider:

Variable Sets the name of the numeric variable used with the slider. 
Type the value in the field or click the drop-down arrow to 
select a value from the list.

Initial value Sets the starting value of the variable.

Minimum Sets the lowest value in the range of values used with the 
slider. This value displays at the left end of the scale.

Maximum Sets the highest value in the range of values used with the 
slider. This value displays at the right end of the scale.

Step Size Sets the size of the increment between values. When a 
slider is active, you can use the arrow keys to move the 
slider up or down the scale by this amount.

Style Lets you choose how the slider is displayed in the work 
area. Choose horizontal for a left-to-right scale, or choose 
vertical for a top-to-bottom scale. To display a slider that 
includes the variable name, current value, and direction 
arrows only, choose minimized.

Result Lets you choose the format for the displayed value of a 
slider. Choose Auto to let slider operate in the default 
format, or choose from eight floating point formats.

Show 
variable

Shows or hides the variable.

Show scale Shows or hides the scale on the slider track.
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Animating a slider
From the slider context menu, click Animate to step through the 
variable range automatically. To stop the animation, click Stop 
Animate.

Minimizing a slider
From the slider context menu, click Minimize to show a smaller display 
that includes the variable name, the current value of the variable, and up 
and down arrows. 

Minimized
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Using Statistical Tools
Once you have plotted one or more variables in Data & Statistics, you can 
manipulate and explore the data using calculations, data fitting 
techniques, hypothesis testing tools, and distributions. These functions 
are available in the Lists & Spreadsheet application. Refer to that chapter 
for further information.
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Using Notes

Getting started with the Notes application
The Notes application provides text editing functions that allow you to 
create and share documents with others using the TI-Nspire™ handheld 
and computer software.

You can use the Notes application as a tool to create study notes to 
reinforce your understanding of classroom concepts and to review for 
exams. The Notes application allows you to assign different roles to 
individuals using your document, so that any edits appear in a different 
text format, making it easy to edit collaboratively.

À Notes tool menu – This menu is available anytime you are in the 
Notes work area. Press b to display the menu.

Á Notes work area -- The area where you enter and format text.

À

Á
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The Notes tool menu
The Notes tool menu lets you select a Notes template, format text, and 
evaluate expressions. The table below describes the menu items and their 
functions.

Menu 
Name

Menu Option Function

 Templates

 Q&A
Creates a template to enter question 
and answer text.

 Proof
Creates a template to enter statement 
and reason text.

 Default
Lets you enter freeform text.

 Insert

 Math 
Expression Box

Lets you insert a math expression.

 Shape
Marks the selected text as an angle, 
triangle, circle, line, segment, ray, or 
vector.

 Comment
Lets you enter text that is italicized and 
prefaced with Teacher or Reviewer.

 Format

 Bold
Toggles the selected text between bold 
and not bold, and removes all other 
formatting.

 Italic
Toggles the selected text between italic 
and not italic, and removes all other 
formatting.

 Underline
Toggles the selected text between 
underlined and not underlined, and 
removes all other formatting.
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Before you begin
Turn on the handheld, and add a Notes application to a document.

The Notes work area
The Notes work area is where you enter and format text.

 Subscript
Toggles the selected text between 
subscripted and not subscripted, and 
removes all other formatting.

 Superscript
Toggles the selected text between 
superscripted and not superscripted, 
and removes all other formatting.

 Actions

 Evaluate 
selection

Replaces the selected part of the 
expression with the result.

 Evaluate
Replaces the current math expression 
with the result.

 Show or Hide 
Answer

Shows or hides the answer in a Q&A 
template.
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Notes templates
The Notes application provides templates for creating three types of 
notes:

• Q&A for questions and answers, with the answer shown or hidden

• Proof for an outline structure containing statements and reasons

• Default for open-formatted text entry

Applying a Notes template

1. While in the Notes work area, press b to display the Notes menu.

2. On the Templates menu, select the specific template to apply.

Using the Q&A Template
Use the Q&A template to create questions and answers. You have the 
option to show or hide the answer, so you can create questions for 
review and hide the answers. When you use the document as a study aid, 
you can verify that your answers are correct.

Press e to move the text cursor between the Question and Answer 
areas of the template.

Using the Proof Template
The proof template provides an outline structure for statements and 
corresponding reasons.

Press e to move the text cursor between the Statements and Reasons 
areas of the template.
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Inserting comments
You can insert Teacher or Reviewer comments into a Notes application. 
Comments are easily identifiable and easy to distinguish from the 
original text.

1. While in the Notes work area, press b to display the Notes menu.

2. On the Insert menu, select Comment, and then select Teacher or 
Reviewer.

3. Enter your text.

Text that you enter appears in italics.
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Formatting Notes text
Use the formatting tools on the Text options menu to specify bold, italic, 
underlined, subscript, or superscript text.

Selecting text

1. If you are using the Q&A or Proof template, press e to place the 
cursor in the area containing the text.

2. Use the NavPad to place the cursor at the start or end of the text to 
be selected.

3. Hold down g, and use the NavPad to select the text.

Applying a text format
1. Select the text in the Notes work area.

2. Press b to display the Notes menu.

3. On the Format menu, select the name of the format to apply.

Note: You can restore the text to normal by reapplying the same 
format.

Inserting geometric shape symbols
You can use geometric shape symbols to designate selected text as 
geometric objects, such as an angle, circle, or line segment.

1. Position the cursor where you want to insert a shape symbol.

2. Press b to display the Notes menu.

3. On the Insert menu, select Shapes, and then select the shape to 
apply.
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Entering and evaluating math expressions
You can include math expressions in Notes text, using the same tools as in 
other TI-Nspire™ applications. You can also evaluate an expression and 
display the result.

Entering an expression
1. In the Notes work area, place the cursor where you want the 

expression.

2. Press b to display the Notes menu.

3. On the Insert menu, select Math Expression Box.

4. Type the expression. You can use the Catalog, if necessary, to insert a 
function, command, symbol, or expression template.

Evaluating an expression
Note: The result of the expression will replace the expression. If you 
need both the expression and its result, make a copy of the expression 
and then evaluate the copy.

1. Place the cursor anywhere in the math expression box.

2. Press b to display the Notes menu.

3. On the Actions menu, select Evaluate.

The result replaces the expression.

Evaluating part of an expression
Note: The result will replace the selected part of the expression. If you 
need both the sub-expression and its result, make a copy and then 
evaluate the copy.
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1. Select the part to evaluate, using the earlier instructions under 
"Selecting text."

2. Press b to display the Notes menu.

3. On the Actions menu, select Evaluate Selection.

The result replaces the selected part only.
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Using Question

TI-Nspire™ lets you open documents that contain question items and 
answer these questions. You can use any of the keyboard shortcuts that 
you can use in TI-Nspire™.

When you open this type of document, you will see the Question toolbar.

Understanding the Question toolbar
When you open documents containing questions, the Question toolbar 
displays, with four tools available:

Navigating in the Question application
• Use the Tab key to move between fields.

• Use the arrow keys to move the cursor within the question or answer 
text area.

Answering questions
• In open-response questions, use any combination of text and math 

expressions. You can use any keys and any characters.

• In multiple-choice questions, go to the answer you want and click 
xEnter or the space bar.

Tool name Tool function

Clear Answers Lets you clear the answers in the 
current question or in the document.

Check Answer If your document is in Self-Check 
mode, click here to view the correct 
answer. You cannot check answers to 
Exam-type questions.

Insert Lets you insert an expression box in 
your answer.

Format Click on this tool to format the 
selected text in your answer as 
subscript or superscript.
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Answering single-answer questions
Questions with a single correct answer use radio buttons. If you see radio 
(round) buttons, you can select only one answer.

Go to the correct answer and select it. To change your answer, just 
move to that answer and select it. Your first choice will be de-
selected.

Answering questions with multiple answers
If you see checkboxes in the answer area, you can select more than one 
answer. If the question asks you to "Select all that apply," for example, 
you might select more than one answer. 

Click on the checkbox next to each correct answer. To de-select an item, 
go back to that answer and use the same process as selecting.
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Working with TI-Nspire™ libraries

What is a library?
A library is a TI-Nspire™ document that contains a collection of variables, 
functions, and/or programs that have been defined as library objects. 

Unlike ordinary variables, functions, and programs, which can be used 
only within a single problem (the problem in which they are defined), 
library objects are accessible from any document. You can even create 
public library objects that appear in the TI-Nspire™ Catalog.

For example, suppose you have created library document matrix 
containing public library function diagwithtrace() and a private library 
function errmsg(). 

Function diagwithtrace() displays the diagonal of a square matrix and 
calculates the trace of the matrix. If its input is not a square matrix, the 
function calls errmsg(), which should then return an appropriate error 
string.

You could then use the following syntax to display the diagonal and 
calculate the trace of matrix m defined in the current problem: 

matrix\diagwithtrace(m)
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Creating libraries and library objects
A document is regarded as a library when it is saved or copied to the 
designated library folder, MyLib. If the folder has been inadvertently 
deleted, you must create it before attempting to use libraries.

You can define library objects using either the Program Editor or the 
Calculator application. Library objects must be defined with a Define 
command and must reside in the first problem of a library document.

Note: If you use the Program Editor to define a library function or 
program, you must store the object and also save the document. Saving 
the document does not automatically store the object. For more 
information, see the “Programming” section of the documentation.

Naming restrictions apply to library documents and library objects.

• A library document name must be a valid variable name between 1 
and 16 characters long, and it must not contain a period or begin 
with an underscore.

• A library object name must be a valid variable name between 1 and 
15 characters long. It must not contain a period and must not begin 
with an underscore.

Private and Public library objects
When you define a library object, you designate it as private (LibPriv) or 
public (LibPub).

A Private library object does not appear in the Catalog, but you can 
access it by typing its name. Private objects serve well as building blocks 
that perform basic, low-level tasks. Typically, private library objects are 
called upon by the public functions and programs.

A Public library object appears in the Catalog’s library tab  after 
you refresh the libraries. You can access a public library object through 
the Catalog or by typing its name.

Note: In library programs and functions defined as public, a comment 
line (©) immediately following the Prgm or Func line is automatically 
displayed as help in the Catalog. You could, for example, show a syntax 
reminder there.

Define a = 5 a is not a library object.

Define LibPriv b = {1,2,3} b is a private library object.

Define LibPub func1(x) = x^2 - 1 func1 is a public library object.
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Using short and long names
Anytime you are in the same problem where an object is defined, you 
can access it by entering its short name (the name given in the object’s 
Define command). This is the case for all defined objects, including 
private, public, and non-library objects.

You can access a library object from any document by typing the object’s 
long name. A long name consists of the name of the object’s library 
document followed by a backslash “\” followed by the name of the 
object. For example, the long name of the object defined as func1 in the 
library document lib1 is lib1\func1. To type the “\” character on the 
handheld, press gp.

Note: If you cannot remember the exact name or the order of arguments 
required for a private library object, you can open the library document 
or use the Program Editor to view the object. You also can use 
getVarInfo to view a list of objects in a library.

Using library objects
Before using a library variable, function, or program, make sure that 
these steps have been followed:

• The object has been defined with the Define command, and the 
command specifies either the LibPriv or LibPub attribute.

• The object resides in the first problem of a library document. The 
document must reside in the designated library folder and must 
meet the naming requirements.

• If you defined the object using the Program Editor, it has been stored 
using Check Syntax & Store from the Program Editor menu.

• The libraries have been refreshed (press /c and select Refresh 
Libraries).

Using a public library object

1. Press /c and select Refresh Libraries.

2. Open the TI-Nspire™ application in which you want to use the 
variable, function or program.

Note: All applications can evaluate functions, but only the 
Calculator application can run programs.

3. Open the Catalog and use the library tab  to find and insert 
the object.
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- or -

Type the name of the object, such as lib1\func1(). In case of a 
function or program, always follow the name with parentheses. To 
type the “\” character on the handheld, press gp.

4. If arguments are required, type them inside the parentheses.

Using a private library object

1. Press /c and select Refresh Libraries.

2. Open the TI-Nspire™ application in which you want to use the 
variable, function or program.

Note: All applications can evaluate functions, but only the 
Calculator application can run programs.

3. Type the name of the object, such as lib1\func1(). 

In case of a function or program, always follow the name with 
parentheses. To type the “\” character on the handheld, press 
gp.

4. If arguments are required, type them inside the parentheses.

Creating shortcuts to library objects
You can make the objects in a library more easily accessible by using 
libShortcut() to create shortcuts to them. This creates a variable group in 
the current problem that contains references to all the objects in the 
specified library document. You can choose to include or exclude the 
private library objects.

For example, suppose the library document linalg contains functions 
named clearmat, cofactor, gausstep, help, inversestep, kernelbasis, rank, 
and simultstep. Executing libShortcut(“linalg”,“la”) would create a 
variable group containing the following members:

la.clearmat
la.cofactor
la.gausstep
la.help
la.inversestep
la.kernelbasis
la.rank
la.simultstep

You can refer to those library objects from within the current problem by 
typing their variable names or by selecting them from the Variables 
menu (press h).
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For details and an example of using libShortcut(), refer to the Reference 
Guide.

Included libraries
To help you get started with libraries, the TI-Nspire™ CAS installation 
includes a library document with useful Linear Algebra functions. The 
library is named linalgCAS and is installed in the designated library 
folder.

Note: Updating the handheld’s operating system places the included 
libraries in the default folder, MyLib. If you have edited an object in an 
included library or replaced an included library with your own document 
of the same name, updating your handheld’s operating system will 
overwrite your changes.

Restoring an included library
If you inadvertently delete or overwrite an included library, you can 
restore it from the installation CD.

1. Open the CD, and navigate to the libs folder.

2. Identify the library file to restore, such as linalgCAS.tns for the 
linear algebra library.

3. Connect the handheld to your computer, open the TI-Nspire™ 
Computer Link Software, and copy the library file to the handheld’s 
MyLib folder.

4. On the handheld, press /c, and select Refresh Libraries to 
activate the new library objects.
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Programming

You can create user-defined functions or programs by typing definition 
statements on the Calculator entry line or by using the Program Editor. 
The Program Editor offers some advantages, and it is covered in this 
section. For information on defining programs and functions in 
Calculator, see the “Calculator” chapter.

Overview of the Program Editor
The Program Editor helps you define, edit, and manage user-defined 
functions and programs. 

• The editor has programming templates and dialog boxes to help you 
define functions and programs using correct syntax.

• The editor lets you enter multiple-line programming statements 
without requiring a special key sequence to add each line.

• You can easily create private and public library objects (variables, 
functions, and programs). For details, see the “Libraries” chapter.

• The editor is accessible from the Tools > Insert menu as well as from 
the Calculator’s Functions & Programs menu.

À Program Editor menu – This menu is available anytime you are in the 
Program Editor work area. Press b to display the menu.

À

Á

Â
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Á Program Editor work area

Â Status line shows line number information and the name of the 
function or program being edited. An asterisk (*) indicates that this 
function is “dirty,” which means that it has changed since the last 
time its syntax has been checked and it has been stored.

The Program Editor menu

Menu 
Name

Menu Option Function

 Actions

New Displays a dialog box for 
defining a new function or 
program.

Open Lets you open an existing 
library function or program for 
editing.

Import Imports a program or function 
from a library.

View Lets you view (and optionally, 
edit) an existing library 
function or program.

Create Copy Lets you copy the current 
function or program.

Rename Lets you rename the current 
function or program.

Change Library Access Lets you change the access level 
of a library object to private 
(LibPriv), public (LibPub), or 
none.

Insert Comment Inserts a comment (©) at the 
cursor position.

Find Displays a dialog box for text 
search.

Find and Replace Lets you find and, optionally, 
replace occurrences of specified 
text.
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Go to Line Moves the cursor to a specified 
line number.

Go Back Lets you easily return from the 
Program Editor to the 
Calculator or Notes application 
after a runtime error occurs.

Close Closes the current function or 
program.

 Check Syntax & Store

Check Syntax & Store Finds syntax errors and tries to 
put the cursor near the first 
error. If no errors, stores current 
function or program.

Check Syntax Finds syntax errors and tries to 
put the cursor near the first 
error.

 Define Variables

Local Inserts Local.

Define Inserts Define.

Delete Variable Inserts DelVar.

Func...EndFunc Inserts Func...EndFunc 
template.

Prgm...EndPrgm Inserts Prgm...EndPrgm 
template.

 Control

If Inserts If statement.

If...Then...EndIf Inserts If...Then...EndIf 
template.

If...Then...Else...EndIf Inserts If...Then...Else...EndIf 
template.

Menu 
Name

Menu Option Function
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ElseIf...Then Inserts ElseIf...Then template.

For...EndFor Inserts For...EndFor template.

While...EndWhile Inserts While...EndWhile

template.

Loop...EndLoop Inserts Loop...EndLoop

template.

Try...Else...EndTry Inserts Try...Else...EndTry 
template.

ClrErr Inserts ClrErr.

PassErr Inserts PassErr.

 Transfer

Return Inserts return().

Cycle Inserts Cycle.

Exit Inserts Exit.

Lbl Inserts Lbl (label).

Go to Lbl Inserts Goto.

Stop Inserts Stop.

 Input/Output

Disp Inserts the Disp (display) 
command.

 Mode

Display Digits Lets you select from several 
Float and Fix settings.

Angle Lets you select Degrees, 
Radians, or Gradians.

Exponential Format Lets you select Normal, 
Scientific, or Engineering.

Menu 
Name

Menu Option Function
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Defining a program or function

Starting a new Program Editor

1. If you are not on a Calculator page, press /c, and then select 
Insert > Program Editor > New.

- or -

If you are on a Calculator page, press b to display the Calculator 
menu, and then select Functions & Programs > Program Editor > 
New.

2. Type a name for the function or program you are defining.

3. Select the Type (Program or Function).

Real or Complex Lets you select Real, 
Rectangular, or Polar.

Auto or Approx Lets you select Auto, 
Approximate, or Exact results.

Vector Format Lets you select Rectangular, 
Cylindrical, or Spherical.

Base Lets you select Decimal, Hex, or 
Binary.

Unit System Lets you select SI or Eng/US.

GetMode Inserts getMode().

Get Language Info Inserts getLangInfo().

Menu 
Name

Menu Option Function
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4. Set the Library Access:

– If you want to use the function or program only from the 
current document and problem, select None.

– If you want the function or program to be accessible from any 
document but not visible in the Catalog, select LibPriv.

– If you want the function or program to be accessible from any 
document and also visible in the Catalog, select LibPub (Show 
in Catalog). For details, see the “Libraries” chapter.

5. Click OK.

A new instance of the Program Editor opens, with a template 
matching the selections you made.

Entering lines into a function or program
The Program Editor does not execute the commands or evaluate 
expressions as you enter them. They are executed only when you 
evaluate the function or run the program.

1. If your function or program will require the user to supply 
arguments, type parameter names in the parentheses that follow the 
name. Separate parameters with a comma.

2. Between the Func and EndFunc (or Prgm and EndPrgm) lines, enter 
the lines of statements that make up your function or program.
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– You can either type the names of functions and commands or 
insert them from the Catalog. 

– A line can be longer than the width of the screen; if so, you 
might have to scroll to view the entire statement.

– After typing each line, press ·. This inserts a new blank line 
and lets you continue entering another line. 

– Use the ¡, ¢, £, and ¤ arrow keys to scroll through the function 
or program for entering or editing commands.

Inserting comments
A comment symbol (©) lets you enter a remark. Comments can be useful 
to someone viewing or editing the program. Comments do not display 
when the program runs, and they have no effect on program flow.

À Comment showing required syntax. Because this library object is 
public and this comment is the first line in a Func or Prgm block, the 
comment displays in the Catalog as help. For details, see the 
“Libraries” chapter.

To insert a comment:

1. Position the cursor at the end of the line where you want to insert a 
comment.

2. Press b to display the Program Editor menu.

3. Select Actions, and then select Insert Comment.

Define LibPub volcyl(ht,r) =

Prgm

©volcyl(ht,r) => volume of cylinder À

Disp “Volume =”, approx(p ¦ r2 ¦ ht)

©This is another comment.



338 Programming

4. Type the text of the comment after the © symbol.

Checking syntax
The Program Editor lets you check the function or program for correct 
syntax.

1. Press b to display the Program Editor menu.

2. Select Check Syntax & Store, and then select Check Syntax.

If the syntax checker finds any syntax errors, it displays an error 
message and tries to position the cursor near the first error so you 
can correct it.

Storing the function or program
You must store your function or program to make it accessible. The 
Program Editor automatically checks the syntax before storing.

An asterisk (*) is displayed in the upper left corner of the Program Editor 
to indicate that the function or program has not been stored.

1. Press b to display the Program Editor menu.

2. Select Check Syntax & Store, and then select 
Check Syntax & Store.

– If the syntax checker finds any syntax errors, it displays an error 
message and tries to position the cursor near the first error.

– If no syntax errors are found, the message “Stored successfully“ 
is displayed in the status line at the top of the Program Editor.
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Note: If the function or program is defined as a library object, you must 
also save the document in the designated library folder and refresh 
libraries to make the object accessible to other documents. For details, 
see the “Libraries” chapter.

Viewing an existing program or function

1. Press b to display the Program Editor menu.

2. Select Actions, and then select View.

The View dialog box displays.

3. If the function or program is a library object, select its library from 
the Location list.

4. Select the function or program name from the Name list.

The function or program displays in a viewer.

5. Use the arrow keys to view the function or program.
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6. When finished viewing, select Edit (press e to highlight Edit, and 

then press ·) to open the function or program in the Program 

Editor, or press d to close the viewer.

Note: The Edit selection is available only for functions and programs 
defined in the current problem. To edit a library object, you must 
first open its library document.

Opening an existing function or program
You can open a function or program from the current problem only.

1. Press b to display the Program Editor menu.

2. Select Actions, and then select Open.

A list of available functions and programs displays.

3. Select the item to open.

Importing a program from a library
You can import a function or program defined as a library object into a 
Program Editor within the current problem.

1. Press b to display the Program Editor menu.

2. Select Actions, and then select Import.

The Import dialog box displays.

3. Select the Library Name.

4. Select the Name of the object.

5. If you want the imported object to have a different name, type the 
name under Import As.



Programming 341

Creating a copy of a function or program
When creating a new function or program, you might find it easier to 
start with a copy of the current one.

1. Press b to display the Program Editor menu.

2. Select Actions, and then select Create Copy.

The Create Copy dialog box displays.

3. Type a new name, or click OK to accept the proposed name.

4. If you want to change the access level, select Library Access, and 
select a new level.

Renaming a program or function
You can rename and (optionally) change the access level of the current 
function or program.

1. Press b to display the Program Editor menu.

2. Select Actions, and then select Rename.

A dialog box displays, with a proposed name.

3. Type a new name, or click OK to accept the proposed name.

4. If you want to change the access level, select Library Access, and 
select a new level.

Changing the library access level

1. Press b to display the Program Editor menu.

2. Select Actions, and then select Change Library Access.
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3. Select the Library Access:

– If you want to use the function or program only from the 
current Calculator problem, select None.

– If you want the function or program to be accessible from any 
document but not visible in the Catalog, select LibPriv.

– If you want the function or program to be accessible from any 
document and also visible in the Catalog, select LibPub.

Finding text

1. Press b to display the Program Editor menu.

2. Select Actions, and then select Find.

3. Type the text that you want to find, and click OK.

– If the text is found, it is highlighted in the program.

– If the text is not found, a notification message displays.

Finding and replacing text

1. Press b to display the Program Editor menu.

2. Select Actions, and then select Find and Replace.
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3. Type the text that you want to find.

4. Type the replacement text.

5. Click Replace to replace the first occurrence after the cursor position, 
or click Replace All to replace every occurrence.

Closing the current function or program

1. Press b to display the Program Editor menu.

2. Select Actions, and then select Close.

3. If the function or program has unstored changes, you are prompted 
to check syntax and store before closing.

Running programs and evaluating functions
After defining and storing a function or program, you can use it from an 
application. All the applications can evaluate functions, but only the 
Calculator application can run programs.

The program statements are executed in sequential order (although 
some commands alter the program flow). The output, if any, is displayed 
in the application’s work area.

• Program execution continues until it reaches the last statement or a 
Stop command.

• Function execution continues until it reaches a Return command.

• To stop a program or function manually, hold down the w key for 
several seconds.
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Using short and long names
Anytime you are in the same problem where an object is defined, you 
can access it by entering its short name (the name given in the object’s 
Define command). This is the case for all defined objects, including 
private, public, and non-library objects.

You can access a library object from any document by typing the object’s 
long name. A long name consists of the name of the object’s library 
document followed by a backslash “\” followed by the name of the 
object. For example, the long name of the object defined as func1 in the 
library document lib1 is lib1\func1. To type the “\” character on the 
handheld, press gp.

Note: If you cannot remember the exact name or the order of arguments 
required for a private library object, you can open the library document 
or use the Program Editor to view the object. You also can use 
getVarInfo to view a list of objects in a library.

Using a Public library function or program
1. Make sure you have defined the object in the document’s first 

problem, stored the object, saved the library document in the MyLib 
folder, and refreshed the libraries.

2. Open the TI-Nspire™ application in which you want to use the 
function or program.

Note: All applications can evaluate functions, but only the 
Calculator application can run programs.

3. Open the Catalog and use the library tab  to find and insert 
the object.

- or -

Type the name of the object. In the case of a function or program, 
always follow the name with parentheses. 

4. If the program requires you to supply one or more arguments, type 
the values or variable names inside the parentheses.

5. Press ·.

libs2\func1()

libs2\func1(34,power)
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Using a Private library function or program
To use a Private library object, you must know its long name. For 
example, the long name of the object defined as func1 in the library 
document lib1 is lib1\func1.

Note: If you cannot remember the exact name or the order of arguments 
required for a private library object, you can open the library document 
or use the Program Editor to view the object.

1. Make sure you have defined the object in the document’s first 
problem, stored the object, saved the library document in the MyLib 
folder, and refreshed the libraries.

2. Open the TI-Nspire™ application in which you want to use the 
function or program.

Note: All applications can evaluate functions, but only the 
Calculator application can run programs.

3. Type the name of the object. In the case of a function or program, 
always follow the name with parentheses.

4. If the object requires you to supply one or more arguments, type the 
values or variable names inside the parentheses.

5. Press ·.

Running a non-library program or function
1. Make sure you are in the same problem in which the function or 

program is defined.

2. Type the name of the function or program on the entry line, or press 
h to select the name from a list.

You must always include a set of parentheses after the name.

If the function or program requires you to supply one or more 
arguments, type the values or variable names inside the parentheses.

3. Press ·.

libs2\func1()

libs2\func1(34,power)

prog1()

prog1(34,power)
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Interrupting a running program

While a function or program is running, the busy pointer } displays.

Press and hold w for several seconds to stop program 
execution. 

A message displays.

– To edit the function or program in the Program Editor, select 
Go To. The cursor appears at the command where the break 
occurred.

– To close the message box, press d.

Getting values into a program
To input values into a function or program, you can:

• Require users to store values to specific variables beforehand. The 
object can then refer to these variables.

• Embed the values directly in the object itself.

• Use parameters in the definition. This lets users pass one or more 
values as arguments to the object when they use it.

Define calculatearea()=

Prgm

 area:=wt*ht

EndPrgm

Define calculatearea()=

Prgm

 wt:=3

 ht:=23

 area:=wt*ht

EndPrgm

Define calculatearea(wt,ht)=

Prgm

  area:=wt*ht

EndPrgm
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Example of passing values to a program
The following program, volcyl, calculates the volume of a cylinder. Two 
values must be passed to the program. The first value must be the height, 
and the second value must be the radius.

When you define the program in the Program Editor, you specify in 
parentheses the parameters that will be used to store the passed values. 
The parameters are placeholders, so their order is important. The names 
you choose should be names that remind you which information to 
supply.

1. Define the volcyl program.

2. Run the program to display the volume of a cylinder with a height of 
34 mm and a radius of 5 mm.

Note: You do not have to use the parameter names when you run the 
volcyl program, but you must supply two arguments (as values, variables, 
or expressions). The first must represent the height, and the second must 
represent the radius.

Displaying information
A running function or program does not display intermediate calculated 
results unless you include a Disp command. This is an important 
difference between performing a calculation on the entry line and 
performing it in a function or program.

These calculations do not display a result in a function or program 
(although they do from the entry line).

Disp displays calculation result or text in a function or program.

Define volcyl(height,radius) =
Prgm

Disp “Volume =”, approx(p ¦ radius2 ¦ 
height)
EndPrgm

volcyl(34,5) Volume = 534.071

12¦6

cos(p/4)

Disp 12¦6

Disp “Result:”,cos(p/4)
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Displaying a result does not store that result. If you expect to refer later 
to a result calculated in a program, store the result to a global variable.

Using local variables
A local variable is a temporary variable that exists only while a user-
defined function is being evaluated or a user-defined program is 
running.

Example of a local variable
The following program segment shows a For...EndFor loop (which is 
discussed later in this module). The variable i is the loop counter. In most 
cases, the variable i is used only while the program is running.

À Declares variable i as local.

Note: When possible, declare as local any variable that is used only 
within the program and does not need to be available after the program 
stops.

What causes an undefined variable error message?
An Undefined variable error message displays when you evaluate a user-
defined function or run a user-defined program that references a local 
variable that is not initialized (assigned a value). 

For example:

À Local variable m is not assigned an initial value.

cos(p/4)&maximum

Disp maximum

Local i À

For i,0,5,1

Disp i

EndFor

Define fact(n)=Func

Local m À

While n>1

n†m&m: n–1&n

EndWhile
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You must initialize local variables
All local variables must be assigned an initial value before they are 
referenced.

À 1 is stored as the initial value for m.

Note: Functions and programs cannot use a local variable to perform 
symbolic calculations.

Performing symbolic calculations
If you want a function or program to perform symbolic calculations, you 
must use a global variable instead of a local. However, you must be 
certain that the global variable does not already exist outside of the 
program. The following methods can help.

• Refer to a global variable name, typically with two or more 
characters, that is not likely to exist outside of the function or 
program.

• Include DelVar within a program to delete the global variable, if it 
exists, before referring to it. (DelVar does not delete locked or linked 
variables.)

Differences between functions and programs
A function defined in the Program Editor is very similar to the functions 
built into the TI-Nspire™ CAS handheld.

• Functions must return a result, which can be graphed or entered in a 
table. Programs cannot return a result.

• You can use a function (but not a program) within an expression. For 
example: 3 ¦ func1(3) is valid, but not 3 ¦ prog1(3).

• You can run programs from Calculator only. However, you can 
evaluate functions in Calculator, Notes, Lists & Spreadsheet, Graphs & 
Geometry, and Data & Statistics.

Define fact(n)=Func

Local m: 1&m À

While n>1

n†m&m: n–1&n

EndWhile
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• A function can refer to any variable; however, it can store a value to 
a local variable only. Programs can store to local and global variables.

Note: Arguments used to pass values to a function are treated as 
local variables automatically. If you want to store to any other 
variables, you must declare them as Local from within the function.

• A function cannot call a program as a subroutine, but it can call 
another user-defined function.

• You cannot define a program within a function.

• A function cannot define a global function, but it can define a local 
function.

Calling one program from another
One program can call another program as a subroutine. The subroutine 
can be external (a separate program) or internal (included in the main 
program). Subroutines are useful when a program needs to repeat the 
same group of commands at several different places.

Calling a separate program
To call a separate program, use the same syntax that you use to run the 
program from the entry line.

Defining and calling an internal subroutine
To define an internal subroutine, use the Define command with 
Prgm...EndPrgm. Because a subroutine must be defined before it can be 
called, it is a good practice to define subroutines at the beginning of the 
main program.

An internal subroutine is called and executed in the same way as a 
separate program.

Define subtest1()=

Prgm

For i,1,4,1

subtest2(i,i¦1000)

EndFor

Define subtest2(x,y)=

Prgm

Disp x,y

EndPrgm 
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À Declares the subroutine as a local variable.

Á Defines the subroutine.

Â Calls the subroutine.

Note: Use the Program Editor’s Var menu to enter the Define and 
Prgm...EndPrgm commands.

Notes about using subroutines
At the end of a subroutine, execution returns to the calling program. To 
exit a subroutine at any other time, use Return with no argument.

A subroutine cannot access local variables declared in the calling 
program. Likewise, the calling program cannot access local variables 
declared in a subroutine.

Lbl commands are local to the programs in which they are located. 
Therefore, a Goto command in the calling program cannot branch to a 
label in a subroutine or vice versa.

Avoiding circular-definition errors
When evaluating a user-defined function or running a program, you can 
specify an argument that includes the same variable that was used to 
define the function or create the program. However, to avoid circular-
definition errors, you must assign a value for variables that are used in 
evaluating the function or running the program. For example:

– or –

Define subtest1()=

Prgm

local subtest2 À

Define subtest2(x,y)= Á

Prgm

Disp x,y

EndPrgm

©Beginning of main program

For i,1,4,1

subtest2(i,I*1000) Â

x+1&x À
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À Causes a Circular definition error message if x or i does not have a 
value. The error does not occur if x or i has already been assigned a 
value.

Controlling the flow of a function or program
When you run a program or evaluate a function, the program lines are 
executed in sequential order. However, some commands alter the 
program flow. For example:

• Control structures such as If...EndIf commands use a conditional test 
to decide which part of a program to execute.

• Loop commands such as For...EndFor repeat a group of commands.

Using If, Lbl, and Goto to control program flow
The If command and several If...EndIf structures let you execute a 
statement or block of statements conditionally, that is, based on the 
result of a test (such as x>5). Lbl (label) and Goto commands let you 
branch, or jump, from one place to another in a function or program.

The If command and several If...EndIf structures reside on the Program 
Editor’s Control menu.

When you insert a structure such as If...Then...EndIf, a template is 
inserted at the cursor location. The cursor is positioned so that you can 
enter a conditional test.

If command
To execute a single command when a conditional test is true, use the 
general form:

À Executed only if x>5; otherwise, skipped.

Á Always displays the value of x.

For i,i,10,1

Disp i À

EndFor

If x>5

Disp "x is greater than 5" À

Disp x Á
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In this example, you must store a value to x before executing the 
If command.

If...Then...EndIf structures
To execute one group of commands if a conditional test is true, use the 
structure:

À Executed only if x>5. 

Á Displays the value of:
2x if x>5
x if x{5

Note: EndIf marks the end of the Then block that is executed if the 
condition is true.

If...Then...Else... EndIf structures
To execute one group of commands if a conditional test is true and a 
different group if the condition is false, use this structure:

À Executed only if x>5.

Á Executed only if x{5.

Â Displays value of:
2x if x>5 
5x if x{5

If x>5 Then

Disp "x is greater than 5" À

2†x&x À

EndIf

Disp x Á

If x>5 Then

Disp "x is greater than 5" À

2†x&x À

Else

Disp "x is less than or equal to 5" Á

5†x&x Á

EndIf

Disp x Â
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If...Then...ElseIf... EndIf structures
A more complex form of the If command lets you test for multiple 
conditions. Suppose you want a program to test a user-supplied 
argument that signifies one of four options. 

To test for each option (If Choice=1, If Choice=2, and so on), use the 
If...Then...ElseIf...EndIf structure.

Lbl and Goto commands
You can also control the flow by using Lbl (label) and Goto commands. 
These commands reside on the Program Editor’s Transfers menu.

Use the Lbl command to label (assign a name to) a particular location in 
the function or program.

You can then use the Goto command at any point in the function or 
program to branch to the location that corresponds to the specified 
label.

Because a Goto command is unconditional (it always branches to the 
specified label), it is often used with an If command so that you can 
specify a conditional test. For example:

À If x>5, branches directly to label GT5. 

Á For this example, the program must include commands (such as 
Stop) that prevent Lbl GT5 from being executed if x{5.

Lbl  labelName
name to assign to this location (use the same naming 
convention as a variable name)

Goto labelName
specifies which Lbl command to branch to

If x>5

Goto GT5 À

Disp x

--------

-------- Á

Lbl GT5

Disp “The number was > 5”
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Using loops to repeat a group of commands
To repeat the same group of commands successively, use one of the loop 
structures. Several types of loops are available. Each type gives you a 
different way to exit the loop, based on a conditional test.

Loop and loop-related commands reside on the Program Editor’s Control 
and Transfers menus.

When you insert one of the loop structures, its template is inserted at the 
cursor location. You can then begin entering the commands that will be 
executed within the loop.

For...EndFor loops
A For...EndFor loop uses a counter to control the number of times the 
loop is repeated. The syntax of the For command is: 

Note: The ending value can be less than the beginning value, provided 
the increment is negative.

For variable, begin, end [, increment]

À Variable used as a counter

Á Counter value used the first time For is executed

Â Exits the loop when variable exceeds this value

Ã Added to the counter each subsequent time For is executed (If this 
optional value is omitted, the increment is 1.)

When For is executed, the variable value is compared to the end value. If 
variable does not exceed end, the loop is executed; otherwise, control 
jumps to the command following EndFor.

Note: The For command automatically increments the counter variable 
so that the function or program can exit the loop after a certain number 
of repetitions.

At the end of the loop (EndFor), control jumps back to the For command, 
where the variable is incremented and compared to end.

For example:

À Á Â Ã

i > 5

i { 5 For i,0,5,1
--------
--------
EndFor
--------
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À Displays 0, 1, 2, 3, 4, and 5.

Á Displays 6. When variable increments to 6, the loop is not executed.

Note: You can declare the counter variable as local if it does not need to 
be saved after the function or program stops.

While...EndWhile loops
A While...EndWhile loop repeats a block of commands as long as a 
specified condition is true. The syntax of the While command is: 

While condition

When While is executed, condition is evaluated. If condition is true, the 
loop is executed; otherwise, control jumps to the command following 
EndWhile.

Note: The While command does not automatically change the condition. 
You must include commands that allow the function or program to exit 
the loop.

At the end of the loop (EndWhile), control jumps back to the While 
command, where condition is re-evaluated.

To execute the loop the first time, the condition must initially be true.

• Any variables referenced in the condition must be set before the 
While command. (You can build the values into the function or 
program, or you can prompt the user to enter the values.)

• The loop must contain commands that change the values in the 
condition, eventually causing it to be false. Otherwise, the condition 
is always true and the function or program cannot exit the loop 
(called an infinite loop).

For example:

For i,0,5,1

Disp i À

EndFor

Disp i Á

x | 5

x < 5 While x<5
--------
--------
EndWhile
--------
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À Initially sets x.

Á Displays 0, 1, 2, 3, and 4.

Â Increments x.

Ã Displays 5. When x increments to 5, the loop is not executed.

Loop...EndLoop loops
A Loop...EndLoop creates an infinite loop, which is repeated endlessly. 
The Loop command does not have any arguments.

Typically, you insert commands in the loop that let the program exit from 
the loop. Commonly used commands are: If, Exit, Goto, and Lbl (label). 
For example:

À An If command checks the condition.

Á Exits the loop and jumps to here when x increments to 6.

Note: The Exit command exits from the current loop.

0&x À

While x<5

Disp x Á

x+1&x Â

EndWhile

Disp x Ã

Loop
--------
--------
EndLoop
--------

0&x

Loop

Disp x

x+1&x

If x>5 À

Exit

EndLoop

Disp x Á
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In this example, the If command can be anywhere in the loop.

The If command could also use a Goto command to transfer program 
control to a specified Lbl (label) command.

Repeating a loop immediately
The Cycle command immediately transfers program control to the next 
iteration of a loop (before the current iteration is complete). This 
command works with For...EndFor, While...EndWhile, and 
Loop...EndLoop.

Lbl and Goto loops
Although the Lbl (label) and Goto commands are not strictly loop 
commands, they can be used to create an infinite loop. For example:

As with Loop...EndLoop, the loop should contain commands that let the 
function or program exit from the loop.

Changing mode settings
Functions and programs can use the setMode() function to temporarily 
set specific calculation or result modes. The Program Editor’s Mode menu 
makes it easy to enter the correct syntax without requiring you to 
memorize numeric codes.

Note: Mode changes made within a function or program definition do 
not persist outside the function or program.

Setting a mode
1. Position the cursor where you want to insert the setMode function.

2. Press b to display the Program Editor menu.

3. On the Mode menu, select the mode to display a menu of its valid 
settings.

When the If command is: The loop is:

At the beginning of the loop Executed only if the condition is true.

At the end of the loop Executed at least once and repeated 
only if the condition is true.

Lbl START
--------
--------
Goto START
--------
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4. Select a setting.

The correct syntax is inserted at the cursor location. For example:

Debugging programs and handling errors
After you write a function or program, you can use several techniques to 
find and correct errors. You can also build an error-handling command 
into the function or program itself.

If your function or program allows the user to select from several 
options, be sure to run it and test each option.

Techniques for debugging
Run-time error messages can locate syntax errors but not errors in 
program logic. The following techniques may be useful.

• Temporarily insert Disp commands to display the values of critical 
variables.

• To confirm that a loop is executed the correct number of times, use 
Disp to display the counter variable or the values in the conditional 
test.

• To confirm that a subroutine is executed, use Disp to display 
messages such as “Entering subroutine” and “Exiting subroutine” at 
the beginning and end of the subroutine.

• To stop a program or function manually, hold down the w key for 
several seconds.

Error-handling commands

Command Description

Try...EndTry Defines a block that lets a function or program execute 
a command and, if necessary, recover from an error 
generated by that command.

ClrErr Clears the error status and sets the error number in 
system variable Errornum to zero.

PassErr Passes an error to the next level of the Try...EndTry 
block.
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Data Collection

The Data Collection Console enables you to collect experimental data 
from a sensor and automatically display it in a list and/or graph for 
analysis. Data Collection works with the Lists & Spreadsheet, Data & 
Statistics, and Graphs & Geometry applications. Refer to the chapters for 
these applications to learn about analyzing collected data.

Compatible sensor interfaces
The Data Collection Console interacts with the following USB sensor 
interfaces:

• Vernier EasyTemp® USB Temperature Sensor

• Texas Instruments CBR2™ Motion Detector

• Vernier Go!®Motion Motion Detector

• Vernier Go!®Temp USB Temperature Sensor

• Vernier Go!®Link (with associated sensors)

• Vernier EasyLink® (with associated sensors)

Analyzing experimental data
The Data Collection Console lets you monitor and control data collection 
while using a TI-Nspireé handheld or a computer running TI-Nspireé 
computer software. Data collection configuration settings such as 
number of samples, units of measurement, and sampling rate are 
preconfigured to work with the sensors. You can also modify the data 
collection settings from the Data Collection Console. 

Open the Data Collection Console to control data collection during 
experiments that monitor distance, temperature, motion, pressure, or 
other types of data supported by the compatible sensor interfaces. As 
you collect experimental data, you can navigate between the console 
and Lists & Spreadsheet, Data & Statistics, and Graphs & Geometry 
applications. The applications that support Data Collection Console use 
show data collected in real-time. For example, temperatures measured 
display in the associated List & Spreadsheet cells as the temperature 
sensor measures them. 
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Note: Real-time display of data collection is supported for sampling rates 
of 20 samples per second, or lower. For higher sampling rates, data 
collected data displays at the end of the run (after data collection stops). 
For example, when a sensor samples at a rate of 30 samples per second, a 
Graphs & Geometry plot that reflects the sensor’s measurements displays 
after the run ends (not while the data is being collected).

Launching the Data Collection Console
The Data Collection Console launches automatically when a sensor is 
connected, or you can launch it manually from the Insert menu. 

Note: If you open a TI-Nspireé document (.tns file) with data collection 
pages created using a TI-Nspireé operating system earlier than Version 
1.4, data is preserved, but experiment-related settings are not.

Using Auto Launch 
Auto Launch occurs when you attach a supported USB sensor or interface 
to a TI-Nspireé handheld or to a computer running the TI-Nspireé 
computer software for math and science. 

1. Connect a supported USB sensor or interface to either a TI-Nspireé 
handheld or to a computer running the TI-Nspireé computer 
software.

The Auto Launch dialog displays:

If more than one document is open (on a computer), you are asked 
to select which document to use.

2. Select Data & Statistics, Lists & Spreadsheet, or Graphs & Geometry as 
the application to use with the Data Collection Console and click OK. 

The Data Collection Console displays. If you selected an application 
on the Auto Launch dialog, that application displays. 
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The following example shows a Lists & Spreadsheet application 
added to the page after the Data Collection Console Auto Launches. 

Data Collection Console ready for temperature versus time experiment

The Data Collection Console determines the type of sensor 
connected and operates according to the default configuration.

Manually starting the Data Collection Console
You need to start the Data Collection Console from the Insert menu 
when the console is closed and the following conditions exist:

• A sensor from a previous data collection run is still attached and you 
need to start data collection again.

• A new problem requires data collection.

• An experiment requires sensor-dependent data collection changes.

To manually start data collection:

1. Attach a compatible USB sensor to the TI-Nspireé handheld or to the 
computer with the TI-Nspireé computer software for math and 
science running. 

2. Press /D.
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The Data Collection Console opens. If the attached sensor measures 
conditions that are present, the console displays the values 
measured. The values displayed are not represented in applications 
until you set the data collection operation mode and start data 
collection.

3. To enable a supported application to respond to the sensor, select 
Display Data In > App(s) on Current Page from the Experiment 
menu . This option allows supported applications to display data 
collection details (variable name labels, values in a spreadsheet, and 
points in a plot):

• A graphing application (Graphs & Geometry or Data & Statistics) 
on the page adds the data collection variables as labels on the 
appropriate axes. 

• Lists & Spreadsheet adds the names of the variables for data 
collection to column headings.

4. Choose Set Up Collection to set an operation mode for use with 
data collection:

– Choose Time Graph to use the time-controlled operation for a 
run:

When you choose Time Graph mode, type the number of 
seconds to wait between samples and the number of seconds for 
the duration of the experiment on the Configure Time Based 
Data Collection dialog. 

The preceding Configure Time Based Data Collection dialog 
is from a temperature sensor. For this example, the default 
settings collect a measurement each second and continue to 
collect data for 180 seconds. You can modify the default settings 
for a sensor; the settings available differ based on the sensor 
type. 

– Choose Events with Entry to specify samples manually for a set 
of events that you define. Each time you press Keep, the Events 
with Entry dialog displays to let you enter a value for the 
dependent variable. For example, to examine the relationship 
between pressure and volume, you can manually sample a 
pressure reading on a pressure sensor. The sample pressure 
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reading you type in the Enter Value is the corresponding value 
for the volume of a liquid in a container. 

– Choose Selected Events to collect a displayed measurement 
and use an automatically assigned sequential event number 
each time you press Keep during data collection.

5. Press  on the Data Collection Console to start collecting data.

The Data Collection Console detects the sensor settings specified in 
Steps 4 and 5. 

The following examples illustrate how the Data Collection Console 
and the Data & Statistics application appear when data collection is 
in progress.

Note: The Data Collection Console is active for one problem at a 
time. If you leave the problem while data collection is active, the 
Data Collection Console displays a confirmation dialog and data 
collection ends.

6. For an event-based data collection mode (Selected Events or Events 

with Entry), you must press Keep  to collect and store the sensor 
data. 
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7. Press  to stop data collection at any time. With the Time Graph 
operation mode, data collection stops automatically after the 
specified duration for the experiment is reached. 

Getting started with the Data Collection Console
After you insert a Data Collection Console, the meter displays in the work 
area. 

À Data collection variables added to column headings in a 
Lists & Spreadsheet application 

Á Data Collection Console with measurement display and buttons 
(meter for temperature Sensor shown)

Using the Data Collection Console
You can navigate and use the buttons on the Data Collection Console in 
the following ways:

• Move to the Data Collection Console to make its buttons available 
.When you are using a TI-Nspireé application and not collecting 
data, the Data Collection Console becomes inactive and appears 
dimmed (transparent).

• The Data Collection Console buttons are available only when a 
sensor is attached.

À Á
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• With the Data Collection Console is active, press e to move 
among the buttons; click with the NavPad to use buttons.

• Click and drag the Data Collection Console to the location of your 
choice in the work area. Use grab or /+Click to move and position 
the Data Collection Console when you need to view the work space 
for an application.

• Click the View button to switch between the large and small views 
of the Data Collection Console. 

• Navigate between TI-Nspireé applications and the Data Collection 
Console by pressing /e. 

Accessing the context menu
The Sensor-specific options on the Data Collection Consoles’s context 
menu are available when the console is active. In the following example, 
the context menu for a temperature sensor includes options for setting 
the Sensor to zero, reversing the calibration coefficient, and changing 
the units to Celsius, Fahrenheit, or Kelvin:

Data Collection Console buttons
When the Data Collection Console is active, you can click the following 
buttons on the console to change operation:

Button  Action Description

Start Data 
Collection

Begins data collection.

Stop Data 
Collection

Stops data collection. The graph of existing data 
points is shown. For motion experiments, velocity 
and acceleration data for the points are also 
available.
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Keep Displays the measurement that is currently on the 
Data Collection Console in supported 
TI-Nspireéapplications on the current page. This 
button displays on the Data Collection Console’s 
meter only when Events with Entry or Selected 
Events is the operation mode.

Close Closes the Data Collection Console. Pressing this 
button while data collection is in progress ends 
data collection. Pressing the button while data 
collection is in progress displays a dialog that lets 
you stop data collection or cancel closing. If you 
close the console, the points or values for data 
collected remain.

Note: During motion experiments, closing the 
console prevents Data Collection from providing 
velocity and acceleration data.

Change 
View

Changes the size of the Data Collection Console 
to Large or Small.

Button  Action Description
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Data Collection Console menus

Icon Menu Option Description

1:Experiment 1:Start 
Collection

Starts the collection of data from a 
connected Sensor.

2:Keep Keeps the data currently being 
measured. This option is available 
when Events with Entry or 
Selected Events is specified for the 
Set Up Collection option. Press 
Keep to indicate that you want to 
capture the data displayed on the 
console. For Events with Entry, you 
must assign the x value for the 
dependent variable.

3:Set Up 
Collection

Lets you select a data collection:

• Time Graph: Capture data with 
respect to time.

• Events with Entry: Capture data 
and manually provide the x-value 
for the dependent variable.

• Selected Events: Capture data 
based on the number of times 
Keep is pressed, using an 
automatically assigned, 
sequential independent y value 
for the independent variable.

4:New 
Experiment

Delete all previously collected data 
from the data collection variables and 
use the default sensor configuration 
settings to start a new experiment.
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5:Display 
Data In

Lets you choose where the data 
collected is displayed:

• App(s) on Current page: 
Modifies the supported 
applications on the current page 
to display data that a sensor 
collects. This option is grayed out 
if the current page contains no 
application for displaying data.

• New Data & Statistics: Opens a 
new Data & Statistics page to 
display the data collected.

• New Graphs & Geometry: Opens 
a new Graphs & Geometry page 
to display the data collected.

• New Lists & Spreadsheet: Opens 
a new Lists & Spreadsheet page 
to display the data collected.

6:Set Up 
Launch

Specifies the application to be added 
when the Data Collection Console 
launches:

• Data & Statistics: Auto Launch 
the Data Collection Console with 
a new Data & Statistics 
application.

• Lists & Spreadsheet: Auto 
Launch the Data Collection 
Console with a new Lists & 
Spreadsheet application.

• Graphs & Geometry: Auto 
Launch the Data Collection 
Console with a new Graphs & 
Geometry application.

• None (Meter Only): Auto 
Launch the Data Collection 
Console without adding an 
application.

• Ask Me: With each Auto Launch 
of the Data Collection Console, 
ask which application to add.

Icon Menu Option Description
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2:Sensors Zero Sets a zero reference based current 
experimental conditions. Setting Zero 
affects all data collection.

Reverse Reverses the calibration coefficient. 
This changes a positive measurement 
to negative.

Change 
Units

Sets one of the supported units for 
the sensor. 

3:Data 1:Store Run Saves the data for experiments using 
the default variable names. Data 
collection names variables using the 
format: DC01.sensor1 or DC01.time. 
In the default variable names:

• DC01 is the group designator for 
Data Collection.

• Sensor1 is the member 
designator that indicates the 
type of data being collected 
(such as time or force.)

• Time is a member designator that 
indicates the time at which the 
sample was collected, in seconds.

Note: If you are using Selected 
Events or Events with Entry as 
the Set Up Collection setting, 
the Time variable contains either 
manually-created or sequential 
data. See Set Up Collection for 
more information.

2:Clear All 
Data

Clears all of the data collection 
variables, including those saved using 
the Store Run option. Clear All Data 
keeps all of the data collection and 
sensor settings for another run. 

4:View 1:Large Changes the size of the Data 
Collection Console to Large.

2:Small Changes the size of the Data 
Collection Console to Small.

Icon Menu Option Description
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Running an experiment and collecting data
1. Prepare for data collection by attaching a supported USB sensor in 

one of the following ways:

• Attach the sensor to the computer with the TI-Nspireé software 
open 

• Attach the sensor to the TI-Nspireé handheld

If the Sensor launches automatically, choose the application that you 
want to use for data collection, or close the Auto Launch dialog and 
set up the page manually as described in the next step.

2. Set up a page to include the application you want to use to display 
sensor data during collection.

3. Press / D to launch a Data Collection Console. 

The Data Collection Console displays in the work area. In the 
following example, a temperature sensor is displaying a 
measurement, but data is not being collected.

4. To make the applications on the page respond to data collection, 
choose Display Data In > App(s) on Current Page on the 
Experiment menu. 

5. To make the applications on the page respond to data collection, 
press b  to access the context menu for data collection. Press 1  5  
1 to choose Display Data In from the Experiment menu and select 
App(s) on Current Page to make the applications respond to data 
collection. 

In the following example, the application has been modified to 
respond to data collected by a temperature sensor:
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Note: Press / + e�to move from the Data Collection Console to 
the other applications on the page.

The Lists & Spreadsheet application and the Data & Statistics 
applications are labeled with the variable names for data collection. 
Variable names are used as column headings in Lists & Spreadsheet 
used for the axis labels in Data & Statistics.

6. To select Set Up Collection on the Experiment menu and choose 
Selected Events as the operating mode for data collection:

Press 1  3  3. 

For this example, Selected Events is the operating mode. This mode 
requires you to press Keep each time a measurement you want to 
include in the run is displayed on the Data Collection Console.

7.  With the Data Collection Console active, press e to move to the 
Start button  and click the NavPad.

8. Press Keep  on the Data Collection Console to collect a sample. 
An automatically assigned sequential event number displays and 
applications will populate a row in a spreadsheet or plot the 
corresponding data point on the axes of supported graphing 
applications.
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9. Repeat Step 9 until you have collected data for each the sample that 
you want to use in the experiment.

After the value for each data point collected is added to a cell in the 
appropriate column for the variable and each corresponding data 
point is plotted on the axes, the page looks like the following 
example.

Note: The graphed data and collected values from a sensor are not 
editable. For example, if you attempt to edit a temperature 
measurement in a Lists & Spreadsheet cell, an error message displays. 
Press Esc to exit edit mode and clear the message.

You can press Stop  to stop the collection of data at any time 
during the experiment. With the Time Graph operating mode, the 
experiment ends after the duration set for the experiment is 
reached; data collection ends automatically. 

10. To rerun the experiment without retaining the current data, press 
Start ( ). The data displayed is erased when the new experiment is 
started. 

Note: When you press Start, an Overwrite Data message displays, 
warning you that the existing data will be lost. 

• Select Discard to clear the latest run and start the new run.

• Select Store to store the latest run and start the new run.
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Data Collection variable names
You can save the data collected for an experiment by storing the run or 
by saving the document that contains the problem. Data is stored in a 
variable and is accessible whenever you work on the problem that 
contains the Data Collection variables. 

The naming system for Data Collection data includes a group designator 
and a member designator (group.member). For example, in a 
temperature versus time experiment, the data is named DC01.temp1 and 
DC01.time. Remember that TI-Nspireé computer software is not case 
sensitive: DC01.TEMP1 and dc01.temp1 reference the same set of data. 

Storing collected data
Store the data collected during a run to mark the completion of part of 
an experiment. To save the current data before starting another run, 
perform the following steps. 

1. With the Data Collection Console selected, press Menu to access the 
Data Collection menus.

2. Click Store Run on the Data menu to save the collected data. 

Note: Press e to move among the controls on the Data Collection 

Console. Press / e if you need to move from an application to 
the Data Collection Console.

You can also clear the data for a run, or access the variables that 
store data: 

– To remove all data for experiments and start over, select New 
Experiment or use a new problem. The Data Collection Console 
settings and previously collected data remain accessible when 
you use a new problem. Although other problems contain data 
from previous runs, only the current problem communicates 
with the sensor during data collection.

– To access variables that hold the data collected during a run 
from other applications, choose the variable name from the 
VarLink menu. For example, to access the values in dc01.temp, 
press / L and select the variable from the menu.

Retrieving stored experimental results
To review stored experimental data, open the document that contains 
the data. Refer to the chapters for Lists & Spreadsheet, Graphs & 
Geometry, or Data & Statistics for more information about using those 
applications with data collected.
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Troubleshooting the Data Collection Console
Following are some of the most common situations you might experience 
along with guidelines for correcting them. 

Sensor was not detected by TI-Nspireé software when connected 
to a TI-Nspireé handheld or computer.

• Check that the sensor connectors are completely inserted into 
the handheld/computer. 

• Unplug the sensor then reconnect it. This should restart the 
communication link. 

Low batteries

This message displays when the batteries in your Vernier Go!®Motion or 
CBR2™ unit are low. Replace the batteries at the next convenient 
opportunity.

Note: If you connect these sensors to your computer, batteries are not 
required. The sensors will obtain their power from the computer by way 
of the USB port.

Bad batteries: <hardware name>

This message displays when the batteries in your Vernier Go!®Motion, 
CBR2™, or TI-Nspireé handheld are too low to continue data collection. 
Consult the Battery Information section of this manual or your sensor’s 
manual to replace them. 

Communication Failure

This message displays when communication is disrupted between the TI-
Nspireé handheld or TI-Nspireé computer software and the connected 
data collection device. Check all connections and power, then restart the 
Data Collection Console. 

Data Collection Conflict.

This message displays when another computer application is managing 
data collection. To collect data using TI-Nspireé computer software, close 
the other data collection application and restart the TI-Nspire™ 
software.

Unsaved Data. 

This message displays when you start a Data Collection experiment and 
you already have data present from a previous run. To save the existing 
data, click Store on the Unsaved Data dialog. To delete the data 
collected in the previous run, click Discard.
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Device not found.

The expected data collection device was not found. This message displays 
when you open a document that had a Data Collection Console open, 
and either no sensor is connected or the wrong sensor is connected. To 
correct the error situation, check that the sensor is properly connected to 
the device or handheld. If the appropriate sensor is firmly attached, close 
the document and then reopen it.

Error. 

This message displays when an unexpected error occurs that in some way 
interferes with the Data Collection Console. Data Collection is 
terminated. Verify that all connections and batteries are good, then retry 
the experiment. 
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Appendix: Service and Support

Texas Instruments Support and Service

For general information 
For more information about TI products and services, contact TI by e-mail 
or visit the TI Internet address.

Service and warranty information
For information about the length and terms of the warranty or about 
product service, refer to the warranty statement enclosed with this 
product or contact your local Texas Instruments retailer/distributor.

Service
Refer Servicing to Qualified Service Personnel under the Conditions 
Listed Below:

• If liquid has been spilled or objects have fallen into the product.

• If the product has been exposed to rain or water.

• If the product does not operate normally as per the operating 
instructions.

• If the product has been dropped or the case has been damaged.

Battery Precautions 
Take these precautions when replacing batteries. 

• Do not leave batteries within the reach of children. 

• Do not mix new and used batteries. Do not mix brands (or types 
within brands) of batteries.

• Do not mix rechargeable and non-rechargeable batteries. 

• Install batteries according to polarity (+ and - ) diagrams. 

• Do not place non-rechargeable batteries in a battery recharger. 

• Properly dispose of used batteries immediately. 

• Do not incinerate or dismantle batteries.

E-mail inquiries:  ti-cares@ti.com

Home Page: education.ti.com

mailto:ti-cares@ti.com
http://education.ti.com
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Disposing of Batteries
• Do not mutilate, puncture, or dispose of batteries in fire. The 

batteries can burst or explode, releasing hazardous chemicals. 
Discard used batteries according to local regulations.
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E
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ElseIf, else if 353
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loop, EndLoop 357
try, EndTry 359
while, EndWhile 356

EndFor, end for 352, 355
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EndLoop, end loop 357
EndTry, end try 359
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pass error, PassErr 359
programs 359
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execute program, Prgm 350
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361
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240
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216

L
label, Lbl 351, 354, 358
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Tool 103
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using 37
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Console 362
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labeling 128
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finding the slope of 132
Line tool 105
lines

changing style 83
changing thickness 83
creating 100
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getting started with 159
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creating 150
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loop, Loop 357
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entering in a table 167
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with multiple statements 36
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using 27, 169
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multiple cells
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getting started with 315
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application 163
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pass error, PassErr 359
pasting

table data 231
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Perpendicular (Line) tool 110
Perpendicular Bisector tool 145, 146, 

147
piecewise functions

creating 32
plot

a value on existing plot 283
plot mean (Data & Statistics) 240
plot standard deviation (Data & 

Statistics) 240
plot type

changing 285
Plot types menu (Data & Statitics) 

235
plot value tool (Data & Statistics) 240
plotting

table data 193
Point On tool 101
Point tool 101
points

creating 100, 101
identifying 103
labeling 103
redefining 104

Points and Lines Menu tools (Graphs 
& Geometry) 56

points of interest, finding 136
points on

creating 101
polygon

creating 120
finding perimeter of 130
finding the area of 129
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pooled option 228
precision of results 26
Program Editor

overview 331
programs

creating 38
programs and programming

arguments 347
branching 352, 354
calling another program 350
clear error, ClrErr 359
comment, © 337
debugging 359
Disp 347
else if, ElseIf 353
else, Else 353
end for, EndFor 352, 355
end if, EndIf 352, 353
end loop, EndLoop 357
end try, EndTry 359
end while, EndWhile 356
for, For 352, 355
functions 349
go to, Goto 351, 354, 358
if, If 352, 353
label, Lbl 351, 354, 358
local, Local 348
loop, Loop 357
looping 352, 355, 356
pass error, PassErr 359
passing values 347
return, Return 351
running 343
stopping 346
subroutines 350
Then, Then 353
try, Try 359
while, While 356

Proof template
using 318

Q
Q & A template

using 318
Quick Graph, using 193

R
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finding the slope 132
Ray tool 106
rays

creating 106
recalling

a function definition 43
receiving

documents from another user 5
rectangle

creating a 118
finding perimeter of 130
finding the area of 129

Rectangle tool 118
Redefine tool 104
redefining a point 104
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Reflection tool 141
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showing lines of 293
regression line

requirements for 293
regression tools (Data & Statistics) 

239
Regular Polygon tool 121
regular polygon, creating 121
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renaming functions 89
replacing

text in Program Editor 342
repositioning a measured value 132
rescaling a graph
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reshaping
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residuals tools (Data & Statistics) 240
resizing

table rows and columns 176
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resizing the work area 71
results

approximating 26
deferring in Calculator 33
reusing in Calculator 46
using last answer 37
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copying in a table 178
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deleting from a table 177
inserting in a table 176
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Scatter Plot tool 155
scatter plots

creating 155
scrolling
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bisecting 145, 146, 147
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service and support 379
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table column as a list 189
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240
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conflicts 175
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T
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sorting 181
table of function values 198
tables

capturing Graphs & Geometry 
data 195

copying a row or column 178
deleting contents of cells 171
deleting list elements in 193
deleting rows and columns 177
generating column data 185
getting started with 159
inserting a row or column 176
inserting list elements 192
linking a column to a list 192
methods for entering data 166
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navigating in 163
selecting a row or column 176
sharing a column as a list 189
working with cells 167
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templates

Proof 318
Q & A 318
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adding to a Graphs & Geometry 

page 133
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320
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231
tool menu (Graphs & Geometry) 234
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234
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Notes 315
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toolbars
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Angle Bisector 148, 149
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Circle 113
circle arc, creating 122
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Hide/Show Axes 68
Hide/Show Grid 69
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Intersection Point 102
Length 128, 130
Line 105
Locus 150, 151
Measurement Transfer 124
Midpoint 107
Parallel 109
Perpendicular 110
Perpendicular Bisector 145, 146, 

147
Point 101
Point On 101
Polygon 120
Ray 106
Rectangle 118
Redefine 104
Reflection 141
Regular Polygon 121
Rotation 143
Scatter Plot 155
Segment 107
Slope 132, 139
Symmetry 140
Tangent 112, 138
Text 87, 133
Trace 93, 94
Translate 142
Triangle 117
Vector 111
Zoom 71

trace distribution curve (Data & 
Statistics) 240
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trace plotted function (Data & 
Statistics) 240

trace regression (Data & Statistics) 
240

Trace tool 92, 93, 94
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transferring

documents to another handheld 
4

files to another handheld 4
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transferring files
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transferring measurements (Graphs 
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transferring numerical text entries 

to an axis 125
transfers
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Translate tool 142
translating an object 141
triangle
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finding the area of 129
moving 118
reshaping 118

Triangle tool 117
triangle, creating 117
troubleshooting (Data Collection) 

376
try, Try 359

U
Undo 74
Upgrading the OS 9
user-defined functions 349

V
variables 33

checking in Calculator 34
creating from table cells 174
delete, DelVar 349
linking table column to a list 192
linking to 174

local, Local 348
methods for storing in Calculator 

34
preventing naming conflicts 175
rules for naming 36
sharing table column as a list 189
storing, example 33
substituting a value for 38
types of 35
updating in Calculator 35
using in a calculation 34

vector
finding the slope of 132
moving 112
resizing 112

Vector tool 111
View Menu tools (Graphs & 

Geometry) 52
viewing

values in a list 192

W
while, While 356
Window Menu tools (Graphs & 

Geometry) 54
wizard

entering expressions with 30, 204
work area

Graphs & Geometry 60
panning 69

working with functions (Graphs & 
Geometry) 84

X
x-min, x-max, y-min, y-max 68

Y
y= functions, graphing 87

Z
zeroes

finding 136
Zoom tool 71

Default Zoom 72
Fit 73, 74
Stat 73
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Trig 73
User 72
Zoom - Box 71
Zoom - In 71
Zoom - Out 71
Zoom - Quadrant 1 72

zoom, adjusting (Data & Statistics) 
241
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